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Maintenance Courseware
Descriptions
Basic Skills Curriculum (17 Training Hours)
Includes:
• Gaging & Measurement 2-Part Series
• Mechanical Print Reading 4-Part Series
• Rigging 2-Part Series
• Workplace Mathematics 4-Part Series
• Workplace Reading 5-Part Series

GAGING & MEASUREMENT 2-PART SERIES
GAM001

GAGING & MEASUREMENT: TYPES & FUNDAMENTALS

This course introduces the process of gaging, which is used in industry to control the quality of manufactured
products.
Course objectives include:
► Describe the two systems of measure used in gaging
► Define the basic terms needed for the gaging process
► Describe the basic number system
► Perform basic mathematical operations using whole numbers and decimals
► Describe the basic components of the unit systems used in gaging
► Describe the relationship between statistical process control and the gaging process
► Identify and describe the various types of plant documents used in the gaging process
► Classify gages into the four basic families of gages
► Describe the limitations of each gage
► Interpret gage readings and determine whether a part is in tolerance
► Explain the importance of the proper care and handling of gaging instruments.
Course menu:
► Introduction to Gaging
• History of Gaging
• Gaging Terminology
► Fundamental Concepts
• History of Measurement
• Decimal Concepts
• Unit Systems
► Industrial Documentation
• Blueprint Reading
• Geometric Tolerancing
• Relation of Gaging to SPC
• Plant Documents
► The Gaging Process
• Gaging Types
• Interpreting Gages
• Care and Handling of Gages

2

Maintenance Courseware
Descriptions
GAM002

GAGING & MEASUREMENT: PROCEDURES & OPERATION

Course objectives include:
► Define diameter, depth, thickness, profile, alignment, roundness, thread pitch, surface finish, hardness,
torque, and angle
► Identify the types of gages used to measure each dimension or property listed above
► Describe the proper operating procedure for each gage
► Describe the types of physical dimensions that each gage is capable of measuring
► Interpret the reading of each gage.
Course menu:
► Diameter, Depth, and Thickness Gages
• Cylindrical Plug Gages
• Snap Gages
• Flush Pin Gages
• Pneumatic Gages
• Dial Bore Gages
• Dial Calipers
• Micrometers
► Roundness and Thread Pitch Gages
• Thread Plug Gages
• Thread Ring Gages
• Indicator Fixture Gages
► Profile and Angle Gages
• Templates
• Sight Gages
► Location Gages and Torque Wrenches
• Location Gages
• Torque Wrenches
► Hardness and Surface Finish Gages
• Rockwell Hardness Gages
• Surface Analyzers

Mechanical Print Reading 4-Part Series
PTR001

MECHANICAL PRINT READING: ORTHOGRAPHIC PROJECTION

Knowledge of engineering drawings is essential for serving the complex needs of our mechanical society. This
program focuses on the six principle views of a blueprint, the types of lines used in the drawings and sectional
views, and the differences between first and third angle projections.
Course objectives include:
►
►
►
►

Identify
Identify
Identify
Identify

the principle views used in orthographic projections
the types of lines used in projection drawings and the purpose of each
auxiliary and sectional views
the differences between first and third angle projections.
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Course menu:
► The History of Mechanical Prints
► Principal Views
• Front, Top, and Bottom
• Right, Left, and Rear
► Types of Lines
• Visible and Hidden
• Center, Phantom, and Break
► Additional Views
• Auxiliary View
• Sectional Views - Part 1
• Sectional Views - Part 2
► Third Angle and First Angle
• How They’re Used

PTR002

MECHANICAL PRINT READING: DRAWING FORMAT & DIMENSIONING

Specifications that are captured on engineering drawings are critical to the production of a part or object.
This course identifies the graphic description of an object, differences between metric and English sheet sizes,
and explains the fields of an engineering drawing and how data is specified within those areas. In addition, the
concept of dimensioning is explained.
Course objectives include:
► Identify characteristics of standard sheet sizes
► Identify features of engineering drawings
► Explain how an object’s features are defined and located using dimensions
► Explain tolerance dimensioning.
Course menu:
► Drawing Format
• Sheet Sizes and Zoning
• Title Block
• Revision Block and Drawing Field
• Reference Data, Feature Control, Notes
► Dimensioning
• Measuring an Object’s Dimensions
• Defining an Object’s Components
• Tolerance Dimensions

PTR003

MECHANICAL PRINT READING: DRAWING TYPES & SYMBOLS

This course covers various types of mechanical drawings, including layout, detail, prefix, and assembly
drawings, and explains general identification and revision symbols. It also covers surface texture symbols,
welding and rivet symbols, as well as datum and miscellaneous markings.
Course objectives include:
► Identify the differences between layout, detail, prefix, and assembly drawings
► Recognize general identification and revision notes and symbols
► Identify special markings, including surface texture, welds, rivets, and datums.
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Course menu:
► Types of Drawings
• Layout, Detail, and Prefix Drawings
• Assembly Drawings
► Drawing Symbols
• General Identification and Revision
• Surface Texture
• Weld and Rivet
• Datums and Miscellaneous Markings

PTR004

MECHANICAL PRINT READING: THREAD SPECIFICATIONS

This course explains thread features, forms, and specification notes used in mechanical prints.
Course objectives include:
► Identify thread features
► Describe the most common thread forms and their characteristics
► Recognize the differences between English and metric thread notes.
Course menu:
► Thread Features and Forms
• Typical Features
• Standard Thread Forms
► Thread Specification Notes
• English Thread Notes
• Metric Thread Notes

Rigging 2-Part Series
RIG001

RIGGING EQUIPMENT BASICS

In this course, students will learn the basics of rigging a lift and the equipment used, including wire ropes,
splices, and end fittings. Students will also learn how to analyze the requirements of the wire rope, fiber rope,
and synthetic webbing, as well as the different attachments and connectors that can be used for the lift
process.
Course objectives include:
►
►
►
►
►

Identify the pertinent terminology used to describe the rigging process
Identify basic rigging concepts, such as moving a load and the types of hoisting equipment
Describe the components of the complete rigging assembly
Explain the purpose of the five steps of the rigging process and how each step affects a successful lift
Describe the characteristics, purpose, and OSHA requirements for using wire ropes and their
associated components
► Describe the characteristics, purpose, and OSHA requirements for using fiber ropes and webbing and
their associated components
► Identify the different types of rigging attachments and how to safely use each attachment for a lift.
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Course menu:
► Introduction to Rigging
• Rigging Basics
• Rigging Equipment
• The Rigging Process
► Wire Ropes
• Wire Rope Basics
• Wire Rope Design and Construction
• Wire Rope Splices and End Fittings
► Webbing
• Synthetic Web Slings
► Connectors and Attachments
• Types of Attachments
• Hooks and Shackles
• Eyebolts and Turnbuckles

RIG002

RIGGING OPERATIONS

In this course, students will learn how to plan a lift, what to inspect prior to and during a lift, and the factors
to analyze while performing a lift — such as how the center of gravity affects a lift, the affect the working load
limit has on the sling assembly, and how environmental factors can affect the rigging plan. In addition, there
are general inspection requirements to adhere to as well as maintenance and storage protocols that must
be addressed.
Course objectives include:
► Describe the factors to consider for planning a safe lift — such as load characteristics, equipment
requirements, and environmental factors influencing a lift
► Identify general inspection requirements for rigging gear
► Describe the differences between the requirements for using wire rope, fiber rope, and synthetic webbing
► Identify inspection requirements for hardware attachments and assembled rigging
► Recognize the procedures for successfully performing a lift
► Explain how to care for and store slings, wire ropes, fiber ropes, and synthetic webbing.
Course menu:
► Planning the Lift
• The Rigging Plan
• Load Characteristics
• Equipment Requirements
• Environmental Factors
► Inspection
• Inspection Requirements
• Inspecting Wire Rope
• Inspecting Synthetic Webbing
• Inspecting Hardware Attachments
• Inspecting Assembled Rigging
► Performing the Lift
• Lift Preparation
• Lifting the Load
• Lift Safety
► Gear Maintenance and Storage
• Sling Care and Use
• Wire Rope and Synthetic Webbing
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Workplace Mathematics 4-Part Series
MAT001

WORKPLACE MATHEMATICS: WHOLE NUMBERS

Course objectives include:
► Learn to recognize and use symbols of arithmetic
► Learn the place value of numbers
► Learn to add whole numbers
► Learn to subtract whole numbers
► Learn to solve arithmetic problems
► Learn to multiply whole numbers
► Learn to divide whole numbers.
Course menu:
► The Language of Numbers
• Decimal System
• Symbols and Formats for Representation
• Types of Numbers
► Adding and Subtracting Whole Numbers
• Addition
• Subtraction
• Solving Arithmetic Problems
► Multiplying and Dividing Whole Numbers
• Multiplication
• Division

MAT002

WORKPLACE MATHEMATICS: FRACTIONS

Course objectives include:
►
►
►
►
►

Learn
Learn
Learn
Learn
Learn

the parts of a fraction
to determine fractional parts of quantities
to add fractions
to divide fractions
basic arithmetic functions using fractions and mixed numbers.

Course menu:
► Understanding Fractions
• Basic Knowledge of Fractions
► Adding and Subtracting Fractions
• Addition
• Subtraction
► Multiplying and Dividing Fractions
• Multiplication
• Division
► Fractions and Mixed Numbers
• Mixed Numbers
• Addition
• Subtraction
• Multiplication
• Division
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MAT003

WORKPLACE MATHEMATICS: DECIMALS

Course objectives include:
► Learn about the use of decimals
► Learn the value of zeros in decimals
► Learn to round off decimals
► Learn to identify repeating decimals
► Learn to add, subtract, multiply, and divide decimals
► Learn to calculate percents.
Course menu:
► Understanding Decimals
• Basics of Decimals
► Working with Decimals
• Place Values
• Rounding Off Decimals
► Adding and Subtracting Decimals
• Addition
• Subtraction
► Multiplying and Dividing Decimals
• Multiplication
• Division
► Percentages
• Basics of Percentages
• Conversions

MAT004

WORKPLACE MATHEMATICS: INTRODUCTION TO ALGEBRA

Course objectives include:
► Learn about signed numbers and how they are represented on a number line
► Learn to subtract, multiply, and divide signed numbers
► Learn to use variables in solving equations
► Learn to determine the value of square roots
► Learn to use numbers with exponents and powers of 10
► Learn to simplify algebraic expressions by removing grouping symbols
► Learn to perform operations in their proper sequence
► Learn to solve equations that have one unknown.
Course menu:
► Signed Numbers
• Basics of Signed Numbers
• Addition
• Subtraction
• Multiplication
• Division
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► Algebraic Representation and Terms
• Variables and Solutions
• Properties and Principles
► Powers and Exponents
• Basics of Power and Exponents
• Multiplication of Terms with Exponents
• Division of Terms with Exponents
• Exponent Terms Raised to Powers
• Roots
• Operations with Radicals
► Logarithms
• Logarithms and Antilogarithms
• Decibel
• Current and Voltage Ratios
► Order of Operations
• Grouping Symbols and Operations
• Order of Operations
► Operations with Equations
• Basics of Equations
• Solving Equations

Workplace Reading 5-Part Series
REA001

WORKPLACE READING: BASIC SKILLS

Course objectives include:
► Understand the importance of reading in a work environment
► Locate words and interpret symbols in the dictionary
► Use context to find the meaning of an unknown word
► Recognize the parts of a word: the prefix, the root, and the suffix
► Learn to read illustrations.
Course menu:
► Dictionary Skills
• Dictionary Parts
• Dictionary Entries
► Context Clues
• Types of Context Clues
► Prefix, Root, and Suffix
• Parts of a Word
► Reading Charts and Diagrams
• Reading Illustrations

REA002

WORKPLACE READING: LITERAL COMPREHENSION – MAIN IDEA

Course objectives include:
► Learn about paragraphs, topics, and topic sentences
► Find and understand the main idea in definition paragraphs
► Find and understand the main ideas in description and explanation paragraphs
► Find and understand the main ideas in introduction and summary paragraphs
► Use visual cues to find main ideas.
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Course menu:
► Paragraphs and Topics
• Paragraphs, Topics, and Topic Sentences
► Definition Paragraph
• Main Idea
• Printing Clues, Signal Words, and Illustrations
► Description and Explanation Paragraphs
• Description Paragraphs
• Explanation Paragraphs
► Introduction and Summary Paragraphs
• Introduction Paragraphs
• Summary Paragraphs
► Visual Clues
• Titles, Headings, and Special Print Words

REA003

WORKPLACE READING: LITERAL COMPREHENSION – RELATIONSHIPS

Course objectives include:
► Recognize and use classification
► Use comparison
► Identify an extended analogy
► Arrange the steps in a procedure in their proper sequence
► Recognize cause and effect relationships.
Course menu:
► Classification
• Classification as a Learning Technique
► Compare and Contrast
• Comparison Helps to Organize Objects
► Analogy and Extended Analogy
• Interpreting Analogies
► Sequence and Procedure
• Is it a Sequence or a Procedure?
• What is a Procedure?
► Cause and Effect
• Cause-Effect Relationships

REA004

WORKPLACE READING: INFERENCE

Course objectives include:
► Understand inference
► Infer the main idea from a paragraph
► Infer relationships based on information in a paragraph
► Draw logical conclusions based on information in a paragraph
► Make judgments based on information in a paragraph.
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Course menu:
► The Process of Inference
• Reading Inference
► Analyzing the Topic and Main Idea
• Parts of the Paragraph
• Examining the Paragraph
► Inference Relationships
• Inferring Meaning to the Stated Word
► Drawing Conclusions and Making Judgments
• Drawing Conclusions
• Making Judgments

REA005

WORKPLACE READING: STUDY SKILLS

Course objectives include:
► Construct spoken and numbered outlines
► Summarize a paragraph
► Know the three types of reading: study reading, skimming, and scanning
► Apply study skills to mathematics
► Know a series of steps to solve problems.
Course menu:
► Outlining Techniques
• Creating the Outline
► Summarizing Techniques
• Writing the Summary
► Study Techniques
• Reading Types
• Scanning Techniques
• Skimming Techniques
► Study Skills in Mathematics
• Special Words and Symbols
• Special Figures in Geometry
• Reading Skills and Word Problems
► Problem Solving
• Identifying Problem-Solving Steps
• Application of Problem-Solving Steps
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Electrical Maintenance Curriculum (70 Training Hours)
Includes:

• AC/DC Theory 14-Part Series
• Applied DC Fundamentals 4-Part Series
• Basic Electronic Components & Their Measurement 3-Part Series
• ControlLogix 6-Part Series
• Electronic Circuits 3-Part Series
• Industrial Electricity 7-Part Series
• Mechanical Electrical Control Systems 7-Part Series
• Motor Drives 6-Part Series
• DC Motor Controllers 2-Part Series
• DC Motors 2-Part Series
• Motor Controls 8-Part Series
• Programmable Logic Controllers 5-Part Series
• Using RSLogix™ 3-Part Series

AC/DC Theory 14-Part Series
ACD001

AC/DC THEORY: CURRENT

This course identifies the characteristics of current flow and how to measure current flow.
Course objectives include:
► Identify the electronic charge of the atom, electron, proton, neutron, nucleus, and ion
► Describe Coulomb’s Law
► Define terms associated with current
► Measure current with an ammeter.
Course menu:
► The Atom
• Bohr’s Atom Model
• Charges
► Interaction of Charges
• Coulomb’s Law
• Ion Formation and Charge Transfer
• Arrangement of Electrons
► Current Flow
• Types of Materials and Current Flow
• Components Needed in an Electrical Circuit
• Unit of Electrical Charge and Current
► Current Flow Measurement
• Ammeter
• Procedure for Using Ammeter
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ACD002

AC/DC THEORY: VOLTAGE

Electronic circuits need current to flow so they can operate as designed. The current flow is caused by emf or
electromotive-force. This course teaches students how to measure emf or voltage.
Course objectives include:
► Explain how connecting batteries in series or in parallel will affect voltage and current capability
► Differentiate between voltage drop and rise
► Explain ground, negative, and positive voltage
► Measure voltage with a voltmeter.
Course menu:
► Electromotive Force
• Creating Electromotive Force
• Potential Difference
► Generating Electromotive Force
• Magnetism and Friction
• Solar Cells and Heat
• Pressurizing Quartz Crystals
• Chemical Reaction
► Circuit Operation
• Battery and Load
• Ground
► Voltage Measurement
• Voltmeter
• Safety Precautions

ACD003

AC/DC THEORY: RESISTANCE

This course explains how to place resistance in a circuit and how that resistance affects the circuit.
Course objectives include:
► Differentiate between conductors and insulators and describe the characteristics that affect them
► Interpret resistor color codes
► Describe various types of resistors
► Describe how resistors can be connected to achieve different amounts of total resistance.
Course menu:
► About Resistance
• Characteristics of Resistance
• Unit of Resistance and Resistivity
• Factors Affecting Resistance
► Resistor
• Function and Construction
• Tolerance, Color Bands, and Power Rating
• Variable Resistors
► Resistors’ Arrangement in a Circuit
• Resistors in Series
• Resistors in Parallel
• Resistors in Series and Parallel
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ACD004

AC/DC THEORY: OHM’S LAW

This course will bring an understanding of Ohm’s Law formulas. Students will learn to calculate voltage,
current, and resistance in almost any part of any electronic circuit without having to use voltmeters, ammeters,
or ohmmeters to measure each quantity.
Course objectives include:
► Write Ohm’s Law in three different forms
► Select the proper equation to calculate voltage, current, and resistance
► Calculate the amount of power in a circuit.
Course menu:
► Equations Derived Using Ohm’s Law
• Current Determination
• Voltage Determination
• Resistance Determination
► Equations Derived Using Watt’s Law
• Determining Power, Voltage, and Current
• Determining Power Absorbed by Resistors
• Equations Derived from the Power Formula

ACD005

AC/DC THEORY: MAGNETISM

This course identifies basic principles of magnetism and describes methods of producing magnetic forces.
Course objectives include:
► Define electromagnetic terms
► Explain basic electromagnetic rules and principles
► Describe the operation of generators and motors.
Course menu:
► Magnets and Flux
• Characteristics
► Current Flow and Magnetic Field
• Relationship
• Magnetic Flux and Magnetomotive Force
► Magnetic Circuits
• Ohm’s Law
► AC/DC Generator
• Converting AC to DC Generator

ACD006

AC/DC THEORY: ELECTRICAL MEASUREMENT

This course identifies characteristics of test equipment used to measure voltage, amperage, and resistance. It
also demonstrates proper usage of test instruments.
Course objectives include:
► Explain how the VOM works and should be connected to a circuit
► Calculate the value of shunt required to increase the current capability
► Calculate the series dropping resistance required to increase the voltage capability
► Define voltmeter loading.
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Course menu:
► Volt-Ohm-Milliammeter
• Meter Movements
• Ammeters
• Voltmeters
• Ohmmeters
• Other Devices
ACD007

AC/DC THEORY: DC CIRCUITS

This course shows how to use the basic formulas to simplify the evaluation of electric circuits.
Course objectives include:
► Explain how a voltage divider works
► Describe an application for a bridge circuit
► Describe Kirchhoff’s Law
► Explain the superposition theorem, Thevenin’s Theorem, and Norton’s Theorem.
Course menu:
► DC Circuits
• Voltage Divider
• Bridge Circuit
► Network Theorems
• Kirchhoff’s Law
• Superposition Theorem
• Thevenin’s Theorem
• Norton’s Theorem

ACD008

AC/DC THEORY: INDUCTANCE & CAPACITANCE

This course focuses on the ways in which capacitors affect current and is designed to help students
understand how these components help form practical operational circuits.
Course objectives include:
► Define the terms, units, and symbols related to inductance and capacitance
► Explain inductance and capacitance
► Calculate total capacitance and solve time constant problems.
Course menu:
► Introduction to Inductance
• Transient Conditions
• Inductance and Inductors
► Introduction to Capacitance
• Capacitors
• Capacitance
• Combining Capacitors
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ACD009

AC/DC THEORY: ALTERNATING CURRENT

This course describes the characteristics of alternating current with special emphasis on the characteristics of
appearance, amplitude, and frequency of its wave form.
Course objectives include:
► Describe the advantages and applications of AC electronics
► Explain electromagnetic induction
► Describe the components of a sine wave
► Describe AC waveforms.
Course menu:
► About Alternating Current
• Characteristics
• Generation
• Waveform Created by Rotating Armature
• Types of Waveforms

ACD010

AC/DC THEORY: AC MEASUREMENT

This course introduces students to the proper selection of test equipment as well as the basic interpretation of
test equipment readings.
Course objectives include:
Explain the operation of AC meters and the oscilloscope
Measure alternating current, AC voltage, amplitude, period, and frequency
Analyze phase relationships of AC waveform.
Course menu:
► AC Meters
• Moving Coil Meter
• Thermocouple Meter and Clamp-On Meter
• Meter Types
► Oscilloscopes
• Oscilloscope Construction and Operation
• Oscilloscope Measurements
• Phase Relationships of Waveforms
ACD011

AC/DC THEORY: CAPACITIVE CIRCUITS

This course will help students differentiate between true defects in the circuits and the effects caused by
capacitors.
Course objectives include:
► Describe commonly used capacitors
► Calculate total capacitance for capacitors in series and parallel
► Describe the phase relationships between current and voltage in different types of capacitor circuits
► Calculate impedance in series and parallel RC circuits.
Course menu:
► Capacitors
• Types of Capacitors
• Capacitance Calculation
► Capacitive Circuits
• Capacitors in DC Circuits
• Capacitors in AC Circuits
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► RC (Resistor Capacitor) Circuits
• Series RC Circuit
• Impedance and Phase Relationships
• Parallel RC Circuit
ACD012

AC/DC THEORY: INDUCTIVE CIRCUITS

This course teaches the effects of inductors within electronic circuits to better perform troubleshooting and
repair of electronic equipment.
Course objectives include:
Explain how inductors operate and which features affect them
Explain mutual inductance
Describe the phase relationship between current and voltage
Compute inductive reactance.
Course menu:
► Inductance
• Inductor Operation
• Factors that Affect Inductance
• Types of Inductors
► Effect of Inductance in Circuits
• Inductance in DC Circuits
• Inductance in AC Circuits
► Mutual Inductance
• Process and Effect of Coupling
► RL (Resistor Inductor) Circuits
• Phase Shift and Impedance
• Power Dissipation

ACD013

AC/DC THEORY: TRANSFORMERS

This course describes the purpose, operation, and effects of transformers in electronic circuits to quickly and
accurately troubleshoot circuits.
Course objectives include:
► Describe the construction and operation of transformers
► Describe sources of loss in transformers
► Solve problems dealing with turns ratio, voltage ratio, current ratio, and impedance
► Describe how the autotransformer and isolation transformer work.
Course menu:
► Concepts of Mutual Inductance
• Basic Process
• Coefficient of Coupling
• Inductance and Mutual Inductance
► Transformers
• Transformer Operation
• Voltage and Current Relationship
► Transformer Efficiency
• Efficiency and Transformer Losses
► Transformer Uses and Types
• Use of Transformers
• Other Transformer Types
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ACD014

AC/DC THEORY: TUNED CIRCUITS

This course explains common applications of tuned circuits and how they are used to establish frequencies
for oscillators and to filter unwanted noise and signals. It also shows how improperly tuned circuits can
cause other parts of circuitry to operate incorrectly.
Course objectives include:
► Calculate impedance, current, voltage, power factor, and phase angle in RLC circuits
► Calculate resonant frequency, capacitance value, or inductance value in RLC circuits
► Describe series and parallel resonant circuits
► Explain the relationship between bandwidth and Q
► Describe four basic types of filters.
Course menu:
► Tuned Circuits
• RLC Circuits
• Series RLC Circuit
• Parallel RLC and Sample Circuits
► Resonant Circuits and Filters
• Series Resonant Circuit (SRC)
• Calculating Bandwidth and Q Factor for SRC
• Parallel Resonant Circuit (PRC)
• Calculating Bandwidth and Q Factor for PRC
• Types of Filters

Applied DC Fundamentals 4-Part Series
ADC001

APPLIED DC FUNDAMENTALS: VOLTAGE, RESISTANCE & CURRENT

Course objectives include:
► Describe the basic parts of an atom and how they relate to electric charge
► Explain the nature of electric charge and potential
► Explain the cause and effect of voltage, current, and resistance
► Explain the units and typical notation for voltage, current, and resistance
► Identify complete, open, and shorted circuits
► Identify various types of fixed resistors and their marking systems
► Understand how a potentiometer and a rheostat differ and their applications
► Define the steps for measuring current, voltage, and resistance.
Course menu:
► Nature of Electricity
• What is Electricity?
• Charge and Potential
• Voltage and EMF Current
• Resistance
• Units and Notation
► DC Voltage, Resistance, and Current
• Complete Circuits
• Resistor Types
• Potentiometers and Rheostats
• Measuring Current
• Measuring Voltage
• Measuring Resistance
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ADC002

APPLIED DC FUNDAMENTALS: OHM’S LAW & DC CIRCUITS

Course objectives include:
► Understand the various Ohm’s law relationships
► Understand known and unknown values and how to use the proper Ohm’s law relationships to solve for
the unknown values
► Calculate the total equivalent resistance of series, parallel, and series-parallel resistive currents
► Calculate currents and voltages in series and parallel circuits
► Understand the proper formula for calculating DC-circuit power
► Explain simple rules and formulas for calculating circuit values
► Calculate voltages and currents for circuits consisting of both series- and parallel-connected resistors
► Determine resistance values for multi-range voltmeter and ammeter circuits
► Calculate the power dissipated by each resistor in a series DC circuit
► Calculate the power dissipated by each resistor in DC circuits consisting of both parallel- and
series-parallel-connected resistors.
Course menu:
► Ohm’s Law
• Introduction to Ohm’s Law
• Using Ohm’s Law
• Series Circuits
• Parallel Circuits
• Series-Parallel Circuits
• DC Power
► Series and Parallel DC Circuits
• Series Circuits: Equal Resistances
• Series Circuits: Unequal Resistances
• Parallel Circuits: Equal Resistances
• Parallel Circuits: Unequal Resistances
• Power in Series DC Circuits
• Power in Parallel DC Circuits

ADC003

APPLIED DC FUNDAMENTALS: ELECTRONIC COMPONENTS &
MAGNETISM

Course objectives include:
► Select the proper wire gage and insulation for a specific application
► Explain hole and electron flow in N-type and P-type semiconductor materials
► Understand the operation and function of a diode
► Describe LED and LCD indicators and displays and their advantages and disadvantages
► Understand the operation of bipolar PNP and NPN transistors in switching and amplifier circuits
► Understand passive components such as capacitors, inductors, and resistors
► Identify the different types of magnets and their operating principles
► Explain how a magnetic field can induce current in a conductor
► Identify different types of relays and their applications
► Describe the operation of analog meter movements
► Understand the operation and characteristics of DC motors
► Explain how magnetism deflects the electron beam in a cathode-ray tube (CRT).
Course menu:
► Electronic Components
• Conductors and Insulators
• Semiconductors
• Diodes
• Electronic Indicators
• Transistors
• Passive Components
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► Magnetism and Its Applications
• Magnetic Fields
• Magnetism and Electricity
• Relays
• Meter Movements
• Electric Motors
• CRT Beam Deflection

ADC004

APPLIED DC FUNDAMENTALS: ELECTRONIC SCHEMATICS &
CIRCUIT ANALYSIS

Course objectives include:
► Identify the electronic circuit symbols for conductors, connectors, batteries, capacitors, inductors, and
various grounded and undergrounded tie points
► Identify the electronic circuit schematic symbols for solid-state devices and other miscellaneous devices
► Identify various types of electronic system documentation and how they are used
► Apply Kirchhoff’s current and voltage laws to determine circuit values
► Determine unknown component values in circuits with more than one voltage source
► Calculate simple voltage divider output voltages and currents
► Determine the voltage divider components required to provide specific outputs
► Analyze voltage divider circuits for simple problems, such as component shorts and opens
► Describe the effects of fluctuations in load resistance on voltage divider outputs.
Course menu:
► Electronic Schematics
• Basic Component Symbols, Part I
• Basic Component Symbols, Part II
• Circuit Tracing
► DC Circuit Analysis
• Kirchhoff’s Laws
• Voltage Dividers
• Applied Circuit Analysis
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Basic Electronic Components & Their Measurement 3-Part Series
BEC001

BASIC ELECTRONIC COMPONENTS & THEIR MEASUREMENT:
TYPES & DIAGRAMS

Course objectives include:
► Become familiar with various types of electronic diagrams
► Become familiar with interconnection diagrams
► Read linear and nonlinear scale meters
► Calculate circuit values
► Understand analog and digital multimeters
► List sources of measurement error with VOMs
► Define the procedures for measuring voltage and current with an electronic VOM
► Define the procedures for measuring resistance with a VOM
► Explain the operation of bridge instruments.
Course menu:
► Electronic Quantities and Testing Principles
• Electronic Diagrams
• Interconnection Diagrams
• Reading Linear Scale Meters
• Reading Nonlinear Scale Meters
• The Parallax Effect
• Calculating Circuit Values
► Multimeter Types and Selection
• Analog Multimeters
• Digital Multimeters (DMMs)
• Multimeter Selection
► VOM Measurements and Maintenance
• Sources of Measurement Error with VOMs
• Voltage Measurement with an Electronic VOM
• Current Measurement with an Electrical VOM
• Resistance Measurement with a VOM
• Maintenance of VOMs
► Bridge-Type Instruments and Measurements
• Using a Resistance Bridge
• Principles of Bridge Instrument Operation
• Using an Impedance Bridge
• Potentiometers and Voltage Standards

BEC002

BASIC ELECTRONIC COMPONENTS & THEIR MEASUREMENT:
CONTROLS & APPLICATIONS

Course objectives include:
► Identify the basic parts and controls of an oscilloscope and explain how they work
► Identify and use the vertical deflection, horizontal deflection, and triggering controls
► Check vertical and horizontal calibration
► List the steps necessary to align and measure sine wave voltages, frequencies, and DC offset voltages
► Identify Lissajous figures
► Determine an amplifier’s response to a square wave input by identifying the output waveforms.
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Course menu:
► Oscilloscope - Operations and CRT Manipulations
• Introduction to Oscilloscopes
• Oscilloscope Operating Principles
• Adjusting CRT Controls
► CRT Scope Patterns
• Vertical Deflection
• Horizontal Deflection
• Sweep Triggering
• Vertical Calibration
• Horizontal Calibration
► CRT Measurements and Amplifier Testing
• Measuring Square Wave Voltages
• Aligning Sine Wave Traces
• Measuring DC Offset Voltage
• Measuring Frequency
• Lissajous Figures
• Wideband Amplifier Testing

BEC003

BASIC ELECTRONIC COMPONENTS & THEIR MEASUREMENT:
OPERATION & TROUBLESHOOTING

Course objectives include:
► Operate RF generators, function and pulse generators, and counter-timers for appropriate
signal-testing operations
► Identify the steps for troubleshooting a circuit using signal tracking and signal injection
► Test the functioning of capacitors and inductors
► Test a transformer and calculate transformer power losses
► Perform function and specification tests on diodes
► Use an ohmmeter to determine transistor types, identify transistor terminals, and test transistors
► Use an ohmmeter to test silicon-controlled rectifiers and triacs
► Describe the function of semiconductor testers.
Course menu:
► Signal Generators
• Introduction to Signal Generators
• Function Generators and Pulse Generators
• Counter-Timers
• Signal Tracing and Signal Injection
► Component Testing for Capacitor and Inductor
• Introduction to Component Testing
• Capacitor Functional Testing
• Inductor Functional Testing
• Impedance Bridges and Capacitor Testers
► Transformer and Semiconductor Testing
• Transformer Testing
• Introduction to Semiconductor Testing
• Diode Testing
• Silicon-Controlled Rectifier Testing
• Triac Testing
• Semiconductor Testers
► Transistor Testing and Classification Practices
• Introduction to Bipolar Transistor Testing
• Bipolar Transistor Testing
• Transistor Testing Practice
• Transistor Classification Practice
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ControlLogix 6-Part Series
CLX001

CONTROLLOGIX: INTRODUCTION TO THE CONTROLLOGIX
PLC FAMILY

Programmable logic controllers can control simple machines to complex industrial processes. They can be
used to help debug and troubleshoot systems and make the overall manufacturing process more efficient.
This course introduces the ControlLogix PLC family, including system components, controllers, network
communications, local input and output modules, and basic hardware components.
Course objectives include:
► Understand how ControlLogix PLCs can share data with other devices in a plant
► Identify the basic hardware components of a ControlLogix system and describe their functions, including
the chassis, power supply, controller, communication modules, I/O modules, and status indicators
► Configure, install, and remove modules.
Course menu:
► PLC System
• ControlLogix System
• ControlLogix Controller
• Communication Network
• Local Input/Output Modules
► Introduction to the ControlLogix Hardware
• Basic Hardware Components
• Working with Modules

CLX002

CONTROLLOGIX: INTRODUCTION TO RSLOGIX 5000 SOFTWARE

Rockwell Automation’s RSLogix 5000 software is used to create programs or projects for ControlLogix PLCs.
This course identifies RSLinx as the communication link between RSLogix 5000 and PLC controllers and
introduces basic project structure.
Course objectives include:
► Understand how RSLinx enables RSLogix 5000 software to communicate with PLC controllers
► Configure RSLinx drivers
► Create a project
► Identify and work with project elements, including the controller folder, tasks, and the I/O configuration
folder
► Download a project to a controller.
Course menu:
► Introduction to RSLinx
• RSLinx
• RSLinx Driver Configuration
► Uploading, Downloading & Going Online
• Creating a Project
• Downloading a Project
► Understanding the Project Structure
• Basic Elements of a Project
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CLX003

CONTROLLOGIX: CREATING & USING TAGS & THE PROGRAM
EDITOR

Tags identify areas in the controller’s memory where data is stored. This course gives a detailed explanation
of tags, including how they are created, monitored, and edited. The RSLogix Program Editor is also covered.
Students will learn about program logic and the three-step scan cycle, input and output instructions, series and
parallel instructions, and adding ladder logic to a program.
Course objectives include:
► Identify the types of tags
► Explain how base, alias, consumed, and produced tags are used
► Create, monitor, and edit tags
► Use the RSLogix Program Editor
► Add ladder logic elements or instructions to a program.
Course menu:
► Creating and Using Tags
• Types of Tags
• How to Create a New Controller Tag
• Monitoring and Editing Tags
► Using the RSLogix Program Editor
• Understanding the Program Editor
• Input and Output Instructions
► Adding Ladder Logic to the Program
• Adding Instructions

CLX004

CONTROLLOGIX: BASIC INSTRUCTIONS

This course introduces and explains the purpose of Bit, Timer/Counter, Compare, Move/Logical, and Math
Conversion basic ControlLogix instructions.
Course objectives include:
► Understand the possible positions for Bit instructions
► Understand and use Timer instructions TON, TOF, and RTO
► Understand and use Counter instructions CTU, CTD, and RES
► Examine Compare instructions EQU, NEQ, LES, LEQ, GRT, GEQ, and LIM
► Understand the value of Move/Logical instructions MOV and CLR
► Understand Math Conversion instructions TOD and FRD.
Course menu:
► Bit Instructions
• Basic Explanations of Bit Instructions
► Timer/Counter Instructions
• Timer Instructions
• Counter Instructions
► Compare Instructions
• Basic Explanation of Compare Instructions
► Move/Logical Instructions
• Explanation of Move/Logical Instructions
► Math Conversion Instructions
• Explanation of Math Conversion Instructions
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CLX005

CONTROLLOGIX: ADVANCED PROGRAMMING & ANALOG DEVICES

This course introduces advanced programming techniques using program control instructions. It also covers
analog devices and analog module configuration.
Course objectives include:
► Use the JMP and LBL instructions
► Modify an existing program to create two routines
► Modify the subroutines
► Create a subroutine that cycles from bottom to top
► Understand how analog devices differ from discrete modules
► Configure analog modules
► Control output channel behavior with the output state tab
► Set alarms for input and output modules
► Calibrate input and output modules.
Course menu:
► Program Control Instructions
• Basic Explanations of Program Control Instructions
• Using Program Control Instructions
► Analog Devices
• Basic Explanations of Analog Devices
• Analog Module Configuration
• Output State
• Setting Alarms
• Analog Module Calibration

CLX006

CONTROLLOGIX: PLC TROUBLESHOOTING

This course introduces ControlLogix troubleshooting and the tools that are used to troubleshoot controller
faults and I/O modules. Students will learn to find and clear faults both manually and through the controller.
Course objectives include:
► Identify and clear controller faults
► Differentiate between minor and major faults and know the different troubleshooting steps for each
► Locate project elements by searching and cross-referencing projects
► Use ControlLogix Help
► Force a tag
► Troubleshoot I/O modules.
Course menu:
► Finding and Clearing Faults
• Identifying Controller Faults
► Searching and Cross-Referencing Projects
• Search
• Cross-Referencing
► Using RSLogix 5000 Help
• Help Menu
► Using Forces in Troubleshooting
• Force
► Troubleshooting I/O Modules
• Hardware Module Status LED’s
► Indicators in the Software
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Electronic Circuits 3-Part Series
ECI001

ELECTRONIC CIRCUITS: BASIC PRINCIPLES

Course objectives include:
► Define voltage, current, and resistance in operational terms
► Calculate voltage, current, and resistance drops in series and parallel circuits
► Identify the operation of capacitors in series and parallel circuits and calculate related circuit values
► Describe the action of magnetic fields in inductors and how to calculate the inductance of series and
parallel circuits
► Calculate sine wave values
► Describe the relationship between current and voltage in resistive, capacitive, and inductive circuits.
Course menu:
► Basic Quantities of Electrical Circuits
• Voltage, Current, and Resistance
• Ohm’s Law
► Series and Parallel Circuits
• Series Circuits
• Parallel Circuits
► Capacitance
• Operating Principles
• Calculating Capacitance
► Electromagnetism and Inductance
• Electromagnetism
• Inductance

ECI002

ELECTRONIC CIRCUITS: CHARACTERISTICS & OPERATION

Course objectives include:
► Identify circuit configurations of half-wave and full-wave rectifiers and how to compute output voltages
from rectifiers
► Describe the functions of power supply components and voltage multipliers and how to compute power
supply ripple and regulation percent
► Describe how to bias transistors and calculate amplifier gains
► Identify the circuit configurations and characteristics of basic operational amplifiers
► Identify the sequence of events in a tank circuit
► Describe the operation and the resonant frequency of a Hartley oscillator
► Describe the operation and the resonant frequency of a lag-lead network used in RC oscillators
► Describe and determine the characteristics of a pulse waveform, including rise time, pulse width, period,
pulse repetition rate, and duty cycle
► Identify clipper and clamper circuits
► Identify RC and RL differentiating and integrating circuits
► Describe the operation of multivibrator and Schmitt-trigger pulse-generation circuits.
Course menu:
► Rectifiers
• Have-Wave Rectifier
• Full-Wave Rectifier
• Full-Wave Bridge Rectifier
► Power Supplies
• Typical Power Supply
• Voltage Regulation
• Voltage Multipliers
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► Amplifiers
• Transistor Action
• Amplifier Circuit Configuration
• Class of Operation
• Types of Amplifiers
► Pulse Generating Devices
• Oscillator Fundamentals
• LC Oscillators
• RC Oscillators
• Relaxation Oscillators
• Differentiating and Integrating Circuits
• Multivibrator

ELECTRONIC CIRCUITS: LOGIC FUNDAMENTALS, TYPES &
APPLICATION
ECI003

Course objectives include:
► Identify relay circuits arranged to perform AND, OR, and inversion functions
► Create truth tables for the inverter and for the AND and OR functions
► Count in the binary number system and add and subtract binary numbers
► Count in the hexadecimal number system and add and subtract hexadecimal numbers
► Count in the octal number system and add and subtract octal numbers
► Convert binary, hexadecimal, and octal numbers to decimal equivalents
► Identify logic symbols and truth tables for NAND and NOR gates
► Identify S-R and J-K flip-flop outputs resulting from different inputs
► Describe the uses and functions of shift registers, counters, half adders, and full adders
► Identify whether a flip-flop is triggered by a positive or a negative edge of the clock pulse
► Describe the operation of bilateral switches and divide-by-N counters
► Describe how the modulus of a counter can be changed to some other modulus.
Course menu:
► Basic Logical Circuits
• General Principles of Logic
• Expressions of Logic
• Relay Logic Fundamentals
► Number Systems
• Binary: Base 2
• Hexadecimal: Base 16
• Octal: Base 8
• Conversion to Decimal
► Boolean and Arithmetic Logic Concepts
• Boolean Logic
• Logic and Karnaugh Map
• De Morgan Theorem and Truth Patterns
• Arithmetic Logic
► Sequential Logic and Circuit Applications
• Sequential Logic
• J-K Flip-Flop
• Registers
• Counters and Decoders
► Digital Types of Integrated Circuits
• Clock-Edge Transitions
• Bilateral Switches
• Divide-by-N Counters
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Industrial Electricity 7-Part Series
ELS001

INDUSTRIAL ELECTRICITY: BASIC PRINCIPLES

This course introduces information and provides examples needed to help students understand basic
electrical theory.
Course objectives include:
► Identify the parts of an atom
► Understand how electrons move and react
► Define terms associated with electricity, static electricity, and magnetism
► Discuss how current flows through basic electrical circuits.
Course menu:
► Electrical Principles
• Atoms and Electrons
• Magnetism
• Electrical Circuits
• Ohm’s Law
► Basic Electrical Circuits
• Circuits and Current
• Types of Circuits
► Shorts and Grounding
• Short Circuits
• Grounding
► Other Electric Components
• Switches in Series and in Parallel
• Battery Basics

ELS002

INDUSTRIAL ELECTRICITY: ALTERNATING CURRENT

This course will help students understand the principles of alternating current.
Course objectives include:
► Understand the differences between alternating and direct current
► Describe how alternating current is generated
► Learn the difference between single- and three-phase alternating current systems
► Understand inductance and capacitance
► Explain how transformers work.
Course menu:
► Alternating Current Circuits
• Current Flow
• Types of AC Current
► AC Generators
• EMF and Generator Types
• Generator Functions
• Frequency
► Inductance and Capacitance
• Inductance Principles
• Conductors
• Capacitors
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► Transformers
• Transformer Functions
• Voltage

ELS003

INDUSTRIAL ELECTRICITY: CONDUCTORS

This course teaches conductivity and conductors, resistance, wire identification, and circuit protection.
Course objectives include:
► Explain the basic principles of conductivity and conductors
► Understand the principles of circuit protection, including fuses and circuit breakers
► Discuss the reasons for grounding electrical components and systems.
Course menu:
► Conductor Properties
• Types of Materials
• Wire
• Conductor Measurement
• Conductor Characteristics
► Circuit Protectors
• Fuse Functions
• Fuse Types
• Circuit Breakers
► Grounding and Bonding
• Grounding Basics
• Bonding and Grounding Guidelines

ELS004

INDUSTRIAL ELECTRICITY: WIRING

This course explains basic wiring terminology and methods as prescribed by the National Electrical Code.
Course objectives include:
► Identify the different types of cable trays and conduit systems
► Understand the uses and techniques of wiring splices and connections
► Explain basic soldering tools and techniques
► Identify the different types of wiring diagrams.
Course menu:
► Wiring Methods
• Raceways
• Cable Trays
• Color Coding
► Wiring Techniques
• Preparations
• Soldering
• Soldering Irons and Guns
• Soldering Tips
• Solderless Connections
► Wiring Diagrams
• Wiring Diagrams
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ELS005

INDUSTRIAL ELECTRICITY: INSTALLATION, DISTRIBUTION
& LIGHTING

The course introduces information and examples needed to help students understand basic industrial
electricity and systems.
Course objectives include:
► Discuss how power is distributed throughout an industrial plant
► Understand how plant lighting systems are designed, installed, and maintained.
Course menu:
► Power Transformation and Routing
• Unit Substation
• Switchgear and MCCs
► Distribution Systems
• Feeder Systems
• Underground Systems
► Plant Lighting
• Functions and Principles
• Lighting Systems
• System Maintenance

ELS006

INDUSTRIAL ELECTRICITY: GENERATORS & MOTORS

This course introduces and discusses some of the different types of direct and alternating current generators
and motors used in the industrial plant setting.
Course objectives include:
► Explain the basic differences between motors and generators
► Discuss how motors and generators function and are controlled
► Understand basic maintenance and troubleshooting techniques.
Course menu:
► Generators
• Principles of Operation
• DC Generators
► Motors
• DC Motors
• Three-Phase AC Motors
• Single-Phase AC Motors
• Common Motor Problems

ELS007

INDUSTRIAL ELECTRICITY: AC MOTOR CONTROL & CURRENT
MEASUREMENT

This course introduces the operation and function of AC motor controls and describes current
measuring devices.
Course objectives include:
► Describe motor control devices and methods
► Describe different types of motor overload protection devices
► Troubleshoot common motor control problems
► Determine how to effectively use voltage and current measuring devices.
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Course menu:
► AC Motor Controls
• Basic Operation
• Overload Protection and Motor Problems
► Electrical Measurement Devices
• Current and Volt Meters
• Ohm, Watt, and Multimeters
• Meter Use and Maintenance

Mechanical Electrical Control Systems 7-Part Series
MEC001

MECHANICAL ELECTRICAL CONTROL SYSTEMS: INTRODUCTION
TO CONTROL SCHEMATICS

The course introduces the fundamentals of working with schematics for control systems. It provides students
with a basic understanding of schematic symbols.
Course objectives include:
► Understand how a schematic differs from a wiring diagram or component arrangement
► Understand the advantages of using a schematic for design and troubleshooting
► Recognize symbols commonly used in control system schematics.
Course menu:
► Understanding Schematics
• What is a Schematic?
• Rules for Reading Schematics
• Rules 1 to 7
► Symbols Used in Schematics
• Switch Types
• Load Types

MEC002

MECHANICAL ELECTRICAL CONTROL SYSTEMS: CREATING
SCHEMATICS

This course demonstrates the method for creating a simplified schematic from a complex wiring diagram or
component arrangement.
Course objectives include:
► Use available information to draw a schematic
► Understand the difference between branching circuits and return legs
► Use the schematic to understand the workings of an unfamiliar system.
Course menu:
► Creating a Schematic
• Advantages of Schematics
• Converting a Wiring Diagram to a Schematic
• Schematic for the Compressor Motor Circuit
• Reading the Schematic
► Advanced Schematics - Manual/Auto Cooling Systems
• Beginning the Control Schematic
• Completing the Control Schematic
• Reading the Schematic
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MEC003

MECHANICAL ELECTRICAL CONTROL SYSTEMS:
ELECTRICAL LOCKOUT

This course uses schematics to show how electrical lockout protects mechanical systems at the controls level.
Course objectives include:
► Recognize electrical lockout circuits in a schematic
► Understand how the lockout circuit protects a particular system
► Understand the difference between automatic rest and manual rest, and appropriate uses of each.
Course menu:
► Lockouts
• Electrical and Manual Lockouts
• Short Cycle Delay
► Relays
• Holding Relays
• Reset Relays

MEC004

MECHANICAL ELECTRICAL CONTROL SYSTEMS: DESIGN &
TROUBLESHOOTING

This course shows how schematics are used to design a system according to a set of specifications and how
to troubleshoot a design.
Course objectives include:
• Determine specifications for a control system and use those specifications to design a schematic
• Identify various methods of meeting a set of specifications and using a schematic to troubleshoot a
controlsystem design.
Course menu:
► Controls Design
• Design Elements
• Compressor Schematic Example
► Safety Requirements
• Controlling High Bearing and Discharge Air Temperature
• Controlling Restart and High Discharge Air Pressure
• Controlling High Motor Temperature and Vibration
► Troubleshooting
• Sample Condenser Unit
• Sample Heat Pump

MEC005

MECHANICAL ELECTRICAL CONTROL SYSTEMS:
ENERGY MANAGEMENT

The course introduces the concept of energy management and describes its importance in commercial
and industrial control systems. It describes energy management as a function of the control system and
demonstrates different types of energy management principles and controls.
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Course objectives include:
► Understand the importance of energy management in an electrical control system
► Explain basic energy management principles
► Incorporate energy management functions in a control system design.
Course menu:
► Energy Efficiency
• Energy Costs and Demand
► Timer Control
• Purpose of Timer Control
• Simplified Water Pumping System Schematic
► De-Energized Circuits
• Air Conditioning Control System

MEC006

MECHANICAL ELECTRICAL CONTROL SYSTEMS:
ELECTRONIC CONTROLS

This course shows how complex systems such as two-stage heating/two-stage cooling may be understood
through schematics. It introduces the use of electronics, including “black boxes” or logic controls as part of the
control system.
Course objectives include:
► Learn to use schematics to understand more intricate control systems
► Diagnose computer control problems using flow charts.
Course menu:
► Complex Schematics
• Startup and Controls
• Safety Controls
• Heating Control Settings
► Troubleshooting
• Flow Chart
• Basic Troubleshooting Steps
• Self-Diagnostic Routines

MEC007

MECHANICAL ELECTRICAL CONTROL SYSTEMS:
RESPONSIVE SYSTEMS

This course describes mechanical control systems which respond to activities in and around a building.
These systems may control environmental functions such as lighting and climate control or specific tasks
including security, conveniences, or access.
Course objectives include:
► Identify various “response” situations and controls needed in commercial and industrial buildings
► Determine the specific requirements of a building or area and how to use schematic designs to fulfill
those requirements through control systems.
Course menu:
► Multiple Switch Circuits
• Types of Switches
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► Time Delay Devices
• Types of Time Delay Devices
• Time Delay Relays
• Delay on Make
• Rotated Start Sequencing
• Delayed Cutoff
• Delay on Break

Motor Drives 6-Part Series
MTD001

MOTOR DRIVES: MOTOR DRIVE IDENTIFICATION

This course introduces the information and examples needed to understand basic motor drive operation.
Course objectives include:
► Identify regenerative and nonregenerative DC drives
► Identify voltage source and current source inverters
► Understand and identify pulse width modulated inverters
► Identify vector control drives.
Course menu:
► Direct Current Drives
• Regenerative Drives
• Nonregenerative Drives
► Alternating Current Drives - Part 1
• AC Drive Basics
• Voltage Source and Current Source Inverters
• Pulse Width Modulation
► Alternating Current Drives - Part 2
• Pulse Width Modulation with IGBT
• Vector Control Basics

MTD002

MOTOR DRIVES: OPEN & CLOSED LOOP SYSTEMS

This course introduces the concepts used in feedback loop systems.
Course objectives include:
► Understand the concept of feedback
► Identify open and closed loop systems
► Identify direct and inverse feedback
► Identify tachometers and understand their use
► Identify encoders and understand their use.
Course menu:
► Loop System Fundamentals
• Feedback Loops
• Types of Feedback Control
• Controlling Feedback with Tachometers and Encoders
► Types of Encoders
• Optical Encoders
• Magnetic Encoders
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MTD003

MOTOR DRIVES: VARIABLE SPEED AC DRIVES

This course explains the construction and operation of variable speed AC drives.
Course objectives include:
► Understand voltage rectification
► Identify controlled and uncontrolled rectifiers
► Identify silicon controlled rectifiers
► Identify and understand the operation of the DC bus
► Identify and understand the operation of the inverter section
► Describe the operation of pulse width modulated drives
► Describe the operation of vector control in AC drives.
Course menu:
► Voltage Rectification
• Changing AC to DC Voltage
• Uncontrolled Full Wave Rectifiers
• Controlled Full Wave Rectifiers
► DC Buses and Inverters
• DC Buses
• Inverters
• BJT and MOS-FET
• IGBT
► Variable Speed Drives
• Pulse Width Modulation Drives
• Vector Control
• Sensorless Vector Control

MTD004

MOTOR DRIVES: SERVE & STEPPER MOTORS

This course explains the construction and operation of servo and stepper motors.
Course objectives include:
► Identify servo motors and their uses
► Understand stepper motor operation
► Identify and understand the types of stepper motors and stepper motor controls.
Course menu:
► Servomotors
• Servomotor Fundamentals
• Brushed and Brushless Servomotors
• Selecting Servomotors and Couplings
► Stepper Motors
• Variable Reluctance Motor
• Permanent Magnet and Hybrid Motors
• Stepping
• Unipolar and Bipolar Motors
• Current Application Methods
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MTD005

MOTOR DRIVES: AC MOTOR OPERATION

This course explains in detail the operation of a three-phase induction motor.
Course objectives include:
► Understand how a rotating magnetic field is created
► Understand how voltage is induced in a rotor
► Understand and calculate slip
► Understand and calculate torque and horsepower
► Understand and calculate power factor.
Course menu:
► Stator and Rotor
• Stator
• Rotor
• Rotary Circuit Theory
► Torque and Horsepower
• Torque
• Horsepower

MTD006

MOTOR DRIVES: AC DRIVE SELECTION & SETUP

This course describes the requirements for setting up most common AC variable speed drives.
Course objectives include:
► Determine drive requirements based on motor application
► Set up a drive for basic control requirements
► Determine run, protection, and stop parameters for common applications.
Course menu:
► Drive Specifications
• Available Power
• Motor Size
• Application to be Performed
• Environmental Conditions
► Drive Setup and Control
• Programming Basics
• Start/Stop Modes
• Reversing
• Motor Control Sources
• Frequency Command or Reference
► Programmable Parameters
• Purpose and Types
• Operating Parameters
• Protecting Parameters
• Stop Parameters
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DC Motor Controllers 2-Part Series
DCC001

DC MOTOR CONTROLLERS: CONTROLLER FUNCTION
& OPERATION

This course familiarizes students with the typical applications for DC motor speed control systems. The terms
that are commonly used in DC motor control systems are defined and how DC motors are controlled with a
rheostat is explained.
Course objectives include:
► Explain basic controller functions
► Identify the three types of speed controllers and describe their operation
► Describe typical applications for DC motor speed control systems
► Define commonly used terms in DC motor control systems
► Describe how to control motor speed using a rheostat in the shunt field of a DC motor
► Explain how a rheostat in the armature of a DC motor can be used to control the motor’s torque
► Explain how variable voltage controllers operate
► Describe how a chopper controller works
► Explain the operation of a single-phase motor controller
► Describe the operation of a three-phase motor controller
► Identify a Ward/Leonard motor controller and describe its operation.
Course menu:
► Controller Basics
• Functions
• Types of Controllers
• Applications
• Definition of Terms
► DC Source Controllers
• Shunt-Field Control
• Armature Resistance
• Variable Voltage Control
• Choppers
► AC Source Controllers
• Single-Phase Controllers
• Three-Phase Controllers
• Ward/Leonard Controllers

DCC002

DC MOTOR CONTROLLERS: MAINTENANCE PROCEDURES
& APPLICATIONS

This course explains typical inspection procedures, testing and cleaning procedures, and troubleshooting
techniques for DC motor controllers.
Course objectives include:
► Identify each type of maintenance and when it is applicable
► List typical inspection procedures to use for DC motor control systems
► Identify proper testing procedures for DC motor controllers
► Describe proper cleaning procedures for DC motor controllers
► Describe the correct troubleshooting technique for a specific problem
► Isolate a problem in a DC motor controller.
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Course menu:
► Maintenance
• Types
• Inspection
• Testing
• Cleaning
• Repair/Replacement
► Troubleshooting
• Measurements
• Procedures

DC Motors 2-Part Series
DCM001

DC MOTORS: BASICS & INTERNAL PARTS

This course familiarizes students with the internal parts of the DC motor, how they fit together, and the
applications for these motors. Students learn about several types of DC motors and how they work and
examine the field construction of a DC motor, the armature, and commutator.
Course objectives include:
► Identify and locate the basic parts of a DC motor
► Describe the effects magnetic fields have on the armature of a motor
► Define the right-hand rule
► Describe the effects of force and motion on a motor
► Explain the physical differences between the various DC motors
► Select the proper DC motor for a specific task
► Describe the internal construction of a field coil
► Locate the poles in a DC motor field
► Explain the function of an interpole
► Describe the types of windings used in the armature coil
► Describe the interaction between coils and other parts of the DC motor
► Identify the types of armature construction
► Identify the elements of the commutator segment
► Describe how connections are made to other parts of the motor
► List the types of insulation material used in commutators
► Describe how brushes interact with the commutator.
Course menu:
► Motor Basics
• Parts of a Motor
• Motor Applications
► Motor Principles
• Magnetic Field
• Force and Motion
► Motor Types
• Permanent Magnet
• Series
• Shunt
• Compound
► Field Construction
• Coils
• Poles and Interpoles
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► Armature Construction
• Coils
• Armature Cores
► Commutator Construction
• Segments
• Brushes

DCM002

DC MOTORS: MAINTENANCE & TROUBLESHOOTING

This course explains the fundamentals of DC motor maintenance, including proper lubrication, brush
replacement, and inspection, along with the correct troubleshooting techniques.
Course objectives include:
► Read and understand motor wiring diagrams
► Connect a motor properly and identify connection errors
► Select the proper terminal identifiers
► Locate the lubrication ports on a DC motor
► Designate the proper lubricant for the DC motor
► Identify a bad brush and how to replace it
► Detect problems within a DC motor using the correct inspection methods.
Course menu:
► Motor Wiring
• Diagrams
• Connections
• Terminal Identifiers
► Maintenance
• Lubrication
• Brush Replacement
• Inspection
► Troubleshooting
• Measurements
• Procedures

Motor Controls 8-Part Series
MTR001

MOTOR CONTROLS: BASIC MOTOR CONTROLS & RELAYS

This course introduces basic motor controls and relays. Controls systems are designed to regulate the speed,
direction, starting, and stopping of electrically operated machinery. They can sense overload conditions and
stop the machinery if a dangerous situation should develop.
Course objectives include:
► Describe the three basic types of control systems
► Discuss the operation of magnetic relays
► Draw schematic symbols for normally open and closed contacts
► Draw the standard symbol for a coil
► Discuss the operation of solid state relays.
Course menu:
► Types of Control Systems
• Features and Functions
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► Magnetic Relays
• How Relays Work
• Contactors
► Solid-State Relays
• How Solid-State Relays Work

MTR002

MOTOR CONTROLS: OVERLOAD RELAYS

This course introduces the different types of overload relays, how they work, and why they are used.
Course objectives include:
► Discuss the difference between overloads and fuses
► List the major types of overload relays
► Differentiate between the major types of thermal overload relays
► Describe the operation of a dashpot timer
► List the ways of changing the time setting of a dashpot timer.
Course menu:
► Overload Device Construction
• Dual-Element Fuses
• Current Sensing and Contact Sections
► Thermal Overload Relays
• Solder Melting Type
• Bimetal Strip Type
• Heaters
► Magnetic Overload Relays
• Basic Operation
• Dashpot Timers
► Solid State Overload Relays
• Basic Operation

MTR003

MOTOR CONTROLS: TIME DELAY RELAYS

This course introduces time delay relays. An integral part of an industrial control system, they are used to
provide time delays which permit the operations of a machine to occur in the proper sequence and order.
Timers are often used to control the starting sequence of large motors that must be step-started or to control
the starting of several motors which cannot be permitted to start simultaneously.
Course objectives include:
► Describe the operation of an ON delay timer
► Describe the operation of an OFF delay timer
► Draw the standard NEMA schematic symbols for ON and OFF delay timers.
Course menu:
► Types of Timers
• On-Delay Timers
• Off-Delay Timers
► Time Delay Circuits
• On-Delay Timer Circuits
• Off-Delay Timer Circuits
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► Methods for Time Delay
• Pneumatic Timers
• Clock Timers
• Prog. Motor Controllers and Solid-State Timers

MTR004

MOTOR CONTROLS: SCHEMATIC SYMBOLS

This course discusses schematic symbols. Students will be introduced to the differences between symbols
used to represent electrical and control components. The manner in which symbols are drawn and interpreted
will be discussed.
Course objectives include:
► Recognize the symbols used in schematic diagrams
► Determine when a contact should be connected normally open or normally closed
► Draw schematic diagrams using the proper NEMA symbols.
Course menu:
► Standard Switches
• Open and Closed Switches
• Additional Switches
► Relay Contacts, Push Buttons, Coils, and Wires
• Relay Contacts and Push Buttons
• Coil, Wire, and Ground Symbols
► Resistors, Transformers, Motors, and Circuit Breakers
• Resistors, Capacitors, and Transformers
• Motors and Protective Devices

MTR005

MOTOR CONTROLS: SCHEMATICS & WIRING DIAGRAMS

Schematics and wiring diagrams are the written language of control circuits. Before a technician can become
proficient in troubleshooting control circuits, he must learn how to read and interpret schematic and wiring
diagrams.
Course objectives include:
► Describe the differences between schematics and wiring diagrams
► Determine the logic of a control circuit by reading a schematic diagram
► Read a wiring diagram
► Convert a schematic diagram into a wiring diagram.
Course menu:
► Schematic and Wiring Diagram Basics
• Start/Stop Schematic Control Logic
• Start/Stop Wiring Control Logic
• Forward/Reverse Schematic Control Logic
► Converting Schematics into Wiring Diagrams
• Numbering the Schematic
• Creating a Pictorial Representation
• Adding Numbers to the Pictorial Representation
• Wiring Control Circuits
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MTR006

MOTOR CONTROLS: STARTING METHODS FOR SQUIRREL
CAGE MOTORS

In this course, different methods will be discussed for the starting of squirrel cage induction motors. Different
types of loads and power requirements can greatly affect the way large AC motors are started.
Course objectives include:
► Discuss across the line starting
► Explain resistor starting
► Describe reactor staring
► Discuss auto-transformer starting.
Course menu:
► Across the Line and Resistance Starting
• Across the Line Starting
• Resistance Starting
► Reactor Starting
• Description and Operation
► Autotransformer Starting
• Single-Step Wye Connection Starting
• Multiple-Step Wye Connection Starting
• Single-Step Open Delta Connection Starting

MTR007

MOTOR CONTROLS: WYE-DELTA, SYNCHRONOUS & WOUND
ROTOR CONTROLS

This course discusses the starting of wye-delta, synchronous motors, and wound rotor motors.
Course objectives include:
► Understand the operation of a wye-delta motor
► Properly connect a wye-delta motor
► Understand the operation of a synchronous motor
► Understand the operation of a wound rotor motor.
Course menu:
► Wye-Delta Motor Controls
• Types of Three-Phase Connections
• Operation of a Wye-Delta Motor
• Connecting a Motor for Wye-Delta Starting
► Synchronous Motor Controls
• Components and Component Functions
• Synchronous Motor Circuit Diagram
► Wound Rotor Motor Controls
• How Wound Rotor Motors Differ
• Wound Rotor Motor Circuit Diagram
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MTR008

MOTOR CONTROLS: INSTALLING & TROUBLESHOOTING
CONTROL SYSTEMS

This course demonstrates the installation and maintenance of control systems. The manner in which a control
system is installed can have great bearing on the ease or difficulty encountered when it becomes necessary to
troubleshoot the system.
Course objectives include:
► Explain the different methods of installing control systems
► Describe the steps required to install a control system using terminal strips and identifying wires with
numbers
► Troubleshoot a control system from a properly installed control cabinet.
Course menu:
► Installing Control Systems
• Defining the System
► Numbering and Wiring the Control System
• Establishing the Numbering System
• Connecting Wiring Points
► Troubleshooting
• Troubleshooting Prerequisites
• Troubleshooting Examples

Programmable Logic Controllers 5-Part Series
PLC001

PLCS: FUNDAMENTALS

This course introduces the fundamentals common to all PLCs. It provides students with knowledge that is
required for learning how to program a PLC.
Course objectives include:
► Understand how the components of the PLC interact with each other
► Discuss the different types of ladder logic
► Explain AND, OR, and NOT functions with PLC ladder logic and Boolean identities
► Explain the difference between decimal, BCD, binary, hexadecimal, and octal numbering systems
► Complete simple conversions.
Course menu:
► PLC Components
• General Construction and Operation
• Processor and Memory
• Inputs and Outputs
► Programming Concepts
• Relay and Ladder Logic
• Normally Open and Normally Closed Contacts
• Creating Logic
► Numbering Systems
• Binary, Octal, Binary Coded Decimal, and Hexadecimal
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PLC002

PLCS: PROGRAMMING

This course explains the proper techniques and procedures used in programming PLCs.
Course objectives include:
► Use programming codes for normally open and normally closed contacts
► Program AND, OR, and NOT logic functions with mnemonic codes or ladder logic
► Interpret addressing schemes
► Properly document a PLC program.
Course menu:
► Elementary Programming
• Programming Methods
• Programming a Simple Rung
• AND, OR, and Latch Logic Functions
► Intermediate Programming
• Memory Stack
• Complex Rung
• Timers and Counters
• Internal Relay Coils
• Addressing
• Program Documentation

PLC003

PLCS: INPUTS & OUTPUTS

This course introduces the different types of input and output devices and modules. Also discussed are wiring
techniques and programming functions for manipulating analog data.
Course objectives include:
► Discuss the different types of discrete and analog inputs/outputs
► Understand how to use the MOVE and COMPARE functions to handle analog derived inputs
► Understand multiplexing wiring schemes.
Course menu:
► Discrete Inputs
• Low Voltage Input Modules
• High Voltage Input Modules
► Analog Inputs
• Analog Input Basics
• Converting Analog Values to Digital Values
• Programming Analog Inputs
► Outputs and Wiring
• Output Modules
• Wiring Considerations
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PLC004

PLCS: TROUBLESHOOTING

This course explains the functions and devices available for safely troubleshooting a PLC system.
Course objectives include:
► Understand how to use the troubleshooting devices and functions common to most PLCs
► Troubleshoot a PLC system for a problem.
Course menu:
► Troubleshooting Devices and Functions
• Safety
• Indicator Lights
• Program Monitoring and Forcing
• Analog and Fault Register
► Troubleshooting Scenario
• Input Device and Module
• Output Module and Output Device
• Internal PLC Error

PLC005

LCS: COMMUNICATIONS & ADVANCED PROGRAMMING

This course explains the types of communication PLC systems use to interface peripheral devices or other
PLCs. Also, advanced programming functions such as the R-S, D, and T Flip-Flops, and commands such as
ADD, MULTIPLY, SKIP, JUMP, Sub-routines, and Sequencers are explained to help maximize
programming efficiency.
Course objectives include:
► Discuss PLC communications
► Program the Add, Subtract, Multiply, and Divide math functions
► Program the One Shot, R-S, D, and T Flip-Flops
► Use the Sub-routine commands JUMP, SKIP, and MCR
► Understand how to use the Sequencer function.
Course menu:
► Math Operations
• Transitional Functions
• ADD and SUBTRACT Functions
• MULTIPLY Function
• DIVIDE Function
► Advanced Logic Functions
• “One-Shot” and “R-S Flip Flop”
• “D” and “T” Flip Flop
► Advanced Commands and Communications
• JUMP Command
• SKIP and MCR Commands
• Sequencer Function
• Peripherals, Networking
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Using RSLogix™ 3-Part Series
RSX001

USING RSLOGIX™: CONFIGURING HARDWARE & SOFTWARE

This course includes the details of configuring hardware components necessary for communications as well as
essential steps to going online to the PLC processor.
Course objectives include:
► Identify the hardware necessary for communicating with the PLC
► Create and configure drivers
► Access the software and select drivers
► Go online to the PLC and access essential help functions.
Course menu:
► Getting Started
• Hardware
• Creating the Driver
• Configuring the Driver
► Starting RSLogix™
• Selecting the Driver
• Going Online to a PLC Processor
► Help Functions
• Accessing Help
• Contextual and Instruction Set Help

RSX002

USING RSLOGIX™: PROGRAMMING & EDITING

This course describes the functions of programming and editing within the RSLogix™ software as well as
downloading and editing new or existing programming for online communication.
Course objectives include:
► Open a new file, add rungs and instructions, edit and address, and add comments and symbols
► Verify, save, and download files
► Edit online and access program files.
Course menu:
► Programming and Editing Functions
• Opening a New File
• Adding Rungs and Instructions
• Editing and Addressing
• Adding Comments and Symbols
► Downloading and Online Editing
• Verifying Files, Saving, and Downloading
• Online Editing
• Program Files
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RSX003

USING RSLOGIX™: TESTING & TROUBLESHOOTING

This course describes advanced programming functions of the RSLogix™ software, including forcing,
histograms, and configuring intelligent modules.
Course objectives include:
► Apply forcing in RSLogix™
► Understand forcing conventions, inputs, and outputs
► Understand data monitors and searches, including histograms
► Discuss advanced tools such as configuring intelligent modules and trending.
Course menu:
► Forcing Inputs and Outputs
• Forcing Conventions
• Forcing in RSLogix™
► Data Monitors and Searches
• Histograms
• Custom Data Monitors
• Searching
► Advanced Tasks
• Configuring Intelligent Modules
• Trending

Fieldbus Process Control Curriculum (14 Training Hours)
Includes:
• Fieldbus Process Control 14-Part Series

Fieldbus Process Control 14-Part Series
FLD001

FIELDBUS: FIELDBUS CURRICULUM OVERVIEW

This course provides an overview of the Fieldbus Process Control curriculum. It introduces the basics of
fieldbus technology and illustrates a simple application of a fieldbus segment.
Course objectives include:
► Recognize the Fieldbus Center as the original course creator
► Define basic fieldbus terms and concepts
► Identify components and applications of fieldbus technology
► Describe how a simple fieldbus segment is designed and operates.
Course menu:
► Fieldbus Introduction
• What is Fieldbus?
• Evolution of Fieldbus
► Fieldbus Components
• Fieldbus Components
• Device Firmware
• Host System
► Fieldbus Application
• A Fieldbus Segment
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FLD002

FIELDBUS: THE ROAD TO FIELDBUS

This course explains the history of fieldbus instrumentation — beginning with instrument signal history and
leading to fieldbus, the benefits of fieldbus systems, and the costs and roadblocks involved with fieldbus. It
also introduces the various fieldbus protocols then compares and contrasts their features and uses.
Course objectives include:
► Identify the signal history for different types of instrumentation systems
► Recognize the roadblocks affecting fieldbus implementation
► Relate fieldbus advantages and cost savings to applications in the field
► Differentiate between fieldbus protocols
► Identify HART, PROFIBUS, and FOUNDATION™ fieldbus devices
► Access support sites and maintenance documents on the web.
Course menu:
► Evolution of Instrumentation
• Instrumentation History
• History of Fieldbus
• Benefits of Fieldbus
• Roadblocks / Superhighways
► Digital Instrument Signals
• Fieldbus Protocols and Standards
• HART
• PROFIBUS PA
• FOUNDATION Fieldbus™
► Accessing Support Documentation
• Web Basics
• Web References

FLD003

FIELDBUS: FIELDBUS WIRING

This course introduces simple bus wiring — including wire types, components, installation, and limitations.
It explains how to calculate the wiring requirements for a basic fieldbus system and install a simple fieldbus
segment. Field illustrations demonstrate how wires are connected and components are added to the segment.
Finally, students learn how fieldbus segments are designed to meet intrinsic safety requirements in classified
areas and how to calculate the wiring and device configuration for a safe installation.
Course objectives include:
► Identify the types of wire and components needed for a fieldbus installation
► Calculate the wiring requirements for a fieldbus system
► Describe the limitations that can affect how a system is installed
► Identify good wiring practices
► Compare and contrast different wiring systems
► Wire and test a simple fieldbus segment
► Identify the advantages of fieldbus intrinsic safety installations
► Identify an intrinsically safe fieldbus segment.
Course menu:
► Wiring Segments
• Types of Wire
• Segment Components
• Topologies
• Bus Limitations
► Wiring Practices
• Wiring and Shielding
• Segment Testing
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► Intrinsic Safety
• Hazardous Environments
• Fieldbus Devices
• FISCO/FNICO

FLD004

FIELDBUS: FIELDBUS DEVICES

This course explores the various types of devices that can be used in fieldbus systems. It explains how these
devices are identified, function, and communicate across the network. Finally, it demonstrates the installation
steps and testing of a fieldbus device.
Course objectives include:
► Recognize how fieldbus devices are deployed, identified, and function across a fieldbus network
► Identify the characteristics of fieldbus devices
► Compare and contrast fieldbus devices
► Identify the correct procedures for installing fieldbus devices
► Set a tag and assign a permanent address for a device
► Recognize when a device is connected properly.
Course menu:
► Devices
• Device Types
• Device Identification
• Firmware and Drivers
► Signal Converters
• Fieldbus to/from Current
• Valve Positioners
• Fieldbus to/from Discrete
► Installation Procedures
• Device Installation

FLD005

FIELDBUS: INTRODUCTION TO CONFIGURATION

This course begins with an overview of configuration and continues with concepts such as device description,
virtual field device, and others that help explain how devices communicate. It examines a procedure for
configuring a simple device and setting basic parameters. Finally, additional configuration tools that can be
used to set up fieldbus systems are introduced.
Course objectives include:
► Identify the different types of configuration required in fieldbus
► Define the basic parameters for resource, transducer, and function blocks (AI, AO, and PID)
► Identify how function blocks are linked in a control situation
► Perform a simple configuration
► Recognize how to launch the programs and set up projects for different configuration tools
► Identify the procedures to assign tags and permanent network addresses
► Set parameters and control strategies
► Associate commands, icons, menus, and screen designs for different software packages
► Document “As Is” data in an engineering database.
Course menu:
► Configuration Overview
• What is Configuration?
• Device Configuration
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► Configuring Fieldbus Devices
• Configuration Procedure
• Configuring the Resource Block
• Configuring the Transducer Block
• Configuring the Function Blocks
• Configuring a Control Loop
► Host Systems
• System Features

FLD006

Fieldbus: Introduction To Control Strategy

This course looks at control options then configures a strategy for basic automatic control. It introduces new
types of function blocks and new parameters within the function blocks so that the system can maintain
proper control.
Course objectives include:
► Identify the components of control loops
► Recognize the communication, scheduling, and function block assignments that enable configuration
► Recognize how function blocks are arranged for different control objectives
► Define and set the control strategy parameters in the AI, AO, and PID blocks
► Perform a control strategy configuration for a control loop.
Course menu:
► Configuring Fieldbus Devices
• Device Configuration
• Control Loop Configuration
• Testing the Loop
► Configuration Exercise
• Adding Blocks
• Simulation

FLD007

FIELDBUS: CONTROL STRATEGY

In this course, cascade control is added to the loop and an alarm block that uses discrete (on-off) control is
configured. The lesson explains the procedure and provides a simulation for students to configure the strategy.
Course objectives include:
► Configure a cascade control loop
► Configure an alarm with a discrete output
► Add signal selectors, alarms, and arithmetic blocks.
Course menu:
► Control Strategies
• Cascade Control Loops
• Alarms and Alerts
• Discrete Operations
► Advanced Control Strategies
• Signal Selectors
• Signal Splitters
• Arithmetic Blocks

50

Maintenance Courseware
Descriptions
FLD008

FIELDBUS: DATA FLOW & COMMUNICATIONS

This course covers the three different types of data communications — Publisher-Subscriber, Source-Sink,
and Client-Server. It also takes a closer look at the role the Link Active Scheduler (LAS) plays in scheduling
communications across the bus and how the entire system works together at the millisecond level to achieve
fully distributed fieldbus control.
Course objectives include:
► Recognize the three fieldbus data communications models
► Specify the applications of each communication method
► Describe the role of the Link Active Scheduler in the communication process
► Identify how time is scheduled at the macro cycle level.
Course menu:
► Network Communications
• The OSI Model
• The Fieldbus Model
► Communication Types
• Client-Server
• Report Distribution
• Publisher-Subscriber
► Scheduling Communications
• Link Active Scheduler
• Macrocycle Scheduling

FLD009

FIELDBUS: CALIBRATION

This course reviews the basics of calibrating instruments and explains how this information is entered into the
transducer block for a particular device.
Course objectives include:
► Recognize the correct procedures for calibrating fieldbus devices
► Identify the function block parameters used in fieldbus calibration
► Calibrate fieldbus valves and transmitters.
Course menu:
► Calibration Basics
• Terminology
• Techniques
► Calibrating Fieldbus Devices
• Transmitters
• Valves

FLD010

FIELDBUS: OPC

This course explains what Object Linking and Embedding for Process Control (OPC) is and why it is important
to fieldbus. Additionally, it demonstrates how to check tag attributes using the tagname dictionary and the
configuration tool.
Course objectives include:
► Identify the role of OPC in fieldbus
► Recognize the characteristics of OPC technology
► Use the tagname dictionary to check tag attributes
► Understand how HMI screens and other applications use OPC.
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Course menu:
► OPC Communications
• OPC Fundamentals
► OPC Operations
• OPC in the Plant
• Data Access Types
► OPC Project
• Setting up an OPC Application

FLD011

FIELDBUS: INTRODUCTION TO TROUBLESHOOTING

Fieldbus systems are prone to many of the same problems that occur in traditional systems — including broken
wires, loose connections, and failed devices. With fieldbus, however, many of these problems can be detected
and diagnosed from the workstation as opposed to the field.
Course objectives include:
► Recognize the advantages of troubleshooting in fieldbus
► Identify the tools used for troubleshooting fieldbus systems
► Identify typical system failures for troubleshooting.
Course menu:
► Troubleshooting Communication Problems
• Types of Communication Problems
► Troubleshooting Hardware/Software Problems
• Types of Hardware/Software Problems
► Troubleshooting Configuration Problems
• Types of Configuration Problems
► Troubleshooting Tools
• Segment and Device Tools

FLD012

FIELDBUS: TROUBLESHOOTING

The course, while by no means encompassing all the possible problems, gives valuable experience on how to
approach and analyze faults in the field. It illustrates typical communication, device, function block, and control
strategy problems. This lesson involves the HMI and the configuration tool.
Course objectives include:
► Follow a systematic troubleshooting plan to identify why the system is not functioning properly
► Identify the parameters in fieldbus that can help troubleshoot device problems
► Use fieldbus test equipment to troubleshoot the system
► Identify the procedures for troubleshooting power and communication (live list) problems
► Describe the typical control strategy problems in fieldbus.
Course menu:
► The Troubleshooting Process
• Preparation and Planning
► Troubleshooting Scenarios
• Microplant 200 Problem
• Microplant 300 Problem
• Microplant 400 Problem

52

Maintenance Courseware
Descriptions
FLD013

FIELDBUS: FIELDBUS MAINTENANCE

This course provides a broad overview of instrument system maintenance, including how maintenance is
planned and performed in fieldbus systems and why fieldbus technology can improve the efficiency of
maintenance operations.
Course objectives include:
► Recognize the different models that can be used to schedule maintenance activities
► Identify the key features of preventive and proactive maintenance
► Describe how fieldbus maintenance can reduce costs and improve efficiencies
► Recognize how information from fieldbus devices is used by the asset reliability management system.
Course menu:
► Maintenance Models
• Types of Maintenance
► Asset Management and Fieldbus
• The Role of Maintenance
• Asset Management Programs
► Fieldbus Valves
• Valve Problems, Tests, and Alerts

FLD014

FIELDBUS: MAINTENANCE EXERCISES

This course focuses on real life maintenance chores that may be encountered in the field. To make things
interesting, the new transmitter will come from a different manufacturer.
Course objectives include:
► Replace a defective fieldbus transmitter
► Build a new function block hierarchy
► Copy and paste fieldbus data from one transmitter to another
► Tag the new transmitter and download the configuration to this device.
Course menu:
► Fieldbus Maintenance I
• Transmitter Exercise
► Fieldbus Maintenance II
• Solenoid Valve Exercise
► Fieldbus Maintenance III
• Link Active Scheduler Exercise

Instrumentation & Control Curriculum (47 Training Hours)
Includes:
• Basic Process Control 9-Part Series
• Calibration & Test Equipment 6-Part Series
• Continuous Process Control 4-Part Series
• Control Valves & Actuators 4-Part Series
• Electronic Maintenance 12-Part Series
• Process Measurement 8-Part Series
• Smart Digital Instrumentation 4-Part Series

53

Maintenance Courseware
Descriptions
Basic Process Control 9-Part Series
BPR001

BASIC PROCESS CONTROL: FEEDBACK CONTROL

Produced in conjunction with ISA — The Instrumentation, Systems, and Automation Society (ISA™) — this
course covers the function of instrument control systems and explains the basic steps in a control process.
Topics covered include:
► Manual and automatic control
► Variables used in process control
► Components and functions of a feedback control loop
► Common types of control elements.
Course menu:
► Process Control
• Process Variables
• Feedback Control Loops
► Sensors, Transmitters, and Final Control Elements
• Sensors
• Transmitters
• Final Control Elements
► Advanced Control
• Types of Advanced Control

BPR002

BASIC PROCESS CONTROL: PROCESS CONTROL MODES

Produced in conjunction with ISA — The Instrumentation, Systems, and Automation Society (ISA™) — this
course is designed to teach workers the function of a controller in a process loop and explain the four modes
of control.
Topics covered include:
► Two-position control
► Proportional control
► Integral control
► Derivative control.
Course menu:
► Process Control
• Typical Application
• Effects on System Response
► Proportional Control
• When It Is Used
• How It Works
► Integral and Derivative Controls
• Integral Control
• Derivative Control

54

Maintenance Courseware
Descriptions
BPR003

BASIC PROCESS CONTROL: PROCESS CHARACTERISTICS

Produced in conjunction with ISA — The Instrumentation, Systems, and Automation Society (ISA™) — this
course teaches process variables such as pressure, temperature, flow, and level.
Topics covered include:
► Characteristics of open and closed systems
► Heat, mass, and pressure
► Fahrenheit and Celsius temperature scales
► Rankine and Kelvin temperature scales
► Heat and heat transfer.
Course menu:
► Process and System Characteristics
• Process Characteristics
• System Characteristics
► Process Energy
• What is Energy?
• Potential, Kinetic, and Internal Energy
► Temperature and Measurement
• Temperature Scales
► Heat and Heat Transfer
• Heat Transfer Methods
• Heat Transfer and Phase Change

BPR004

BASIC PROCESS CONTROL: PROCESS VARIABLES

Produced in conjunction with ISA — The Instrumentation, Systems, and Automation Society (ISA™) — this
course teaches the relationship among force, area, and pressure and the difference between atmosphere, gage,
and absolute pressure.
Topics covered include:
► Converting between gage pressure and absolute pressure
► Pressure measurement and height of liquid
► Converting between psi, inches of water, and inches of mercury, volume, density, and specific gravity
► Flow rate, mass flow rate, and volumetric flow rate
► Methods of measuring temperature.
Course menu:
► Pressure
• Pressure Characteristics
• Measuring Pressure
• Methods for Calculating Pressure
► Level
• Level Characteristics
• Measuring Level
► Temperature
• Temperature Characteristics
• Temperature Measurement
• Operation of a Temperature Loop
► Flow
• Flow Characteristics
• Methods for Measuring Flow
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BPR005

BASIC PROCESS CONTROL: INSTRUMENTATION SYMBOLS

Produced in conjunction with ISA — The Instrumentation, Systems, and Automation Society (ISA™) — this
course will enable students to identify different instrumentation symbols.
Topics covered include:
► Balloon symbols
► Loop identification numbers and loop indicator suffixes
► Line symbols
► Valve and actuator symbols
► Reading a simple loop.
Course menu:
► Symbols and Tag Numbers
• Symbols
• Tag Numbers
► Line Symbols
• Process Lines
• Signal Lines
► Valves and Actuators
• Valves
• Actuators
► Reading a Simple Loop
• Interpreting the P & ID

BPR006

BASIC PROCESS CONTROL: INSTRUMENT LOOP DIAGRAMS

Produced in conjunction with ISA — The Instrumentation, Systems, and Automation Society (ISA™) — this
course discusses the sections on a loop diagram.
Topics covered include:
► Instrument ports and connections
► Junction boxes and identifiers
► Operating range and set point for an instrument
► Symbols and reference
► Electronic loops
► Pneumatic loops.
Course menu:
► Sections
• Loop Diagrams
• Organization of the Diagram
► Symbols and References
• Symbols
• References
► Electronic Loops
• Reading from Left to Right
• Reading from Right to Left
► Pneumatic Loops
• Reading from Left to Right
• Reading from Right to Left
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BPR007

BASIC PROCESS CONTROL: PIPING INSTRUMENTATION DRAWING

Produced in conjunction with ISA — The Instrumentation, Systems, and Automation Society (ISA™) — this
course teaches students how to interpret instrument symbols used on instrumentation diagrams as well as
identify the types of instrumentation diagrams.
Topics covered include:
► ISA Standard 5.1
► Control concepts
► Symbols and identifiers
► Interpreting diagrams.
Course menu:
► Digital Control Concepts
• Standards, Symbols, and Identifiers
• Characteristics
► Symbols and Designations
• Symbols on an Instrumentation Diagram
• Line Symbols
► Interpreting Diagrams
• Simplified Diagrams
• Conceptual Diagrams
• Detailed Diagrams

BPR008

BASIC PROCESS CONTROL: MECHANICAL CONNECTIONS

Produced in conjunction with ISA — The Instrumentation, Systems, and Automation Society (ISA™) — this
course focuses on mechanical components such as gaskets and o-rings and how tubing is applied in
instrument systems.
Topics covered include:
► Tubing materials and applications
► Calculating tubing gain
► Fittings and plastic tubing
► Cleaning, tubing, and fittings for silver soldering.
Course menu:
► Gaskets and O-Rings
• Gaskets
• O-Rings
► Tubing
• Applications
• Installation of Tubing
• Tubing Benders
► Fittings and Plastic Tubing
• Compression Fittings
• Flared Fittings
• Plastic Tubing
► Silver Soldering
• Preparation
• Soldering Steps
► Work Practices
• Mechanical Connections
• Practices to Follow
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BPR009

BASIC PROCESS CONTROL: ELECTRICAL CONNECTIONS

Produced in conjunction with ISA — The Instrumentation, Systems, and Automation Society (ISA™) — this
course teaches students to identify the different types of wires and differentiate between crimped splice and
in-line splices.
Topics covered include:
► Coaxial cable connections and conductors to terminal
► Grounds and shields
► Electrical noise and signal distortion
► General safety and intrinsic safety
► Signal tracing in an electrical circuit.
Course menu:
► Process Control Connections
• Conductors, Splices, and Cables
• Methods for Making Connections
• Attaching Conductors to Terminals
► Grounds and Shields
• Equipment Grounds
• Shielded Cables
• Procedures for Making Cable Connections
► Troubleshooting an Instrument Loop System
• Signal Tracing
► General Safety
• Classifications of Hazards
• Ways to Minimize Explosions

Calibration & Test Equipment 6-Part Series
CTE001

CALIBRATION & TEST EQUIPMENT: PRIMARY CALIBRATION
STANDARDS

Produced in conjunction with ISA — The Instrumentation, Systems, and Automation Society (ISA™) — this
course teaches the primary and secondary calibration standards.
Topics covered include:
► Manometers
► Hydraulic deadweight testers
► Pneumatic deadweight testers.
Course menu:
► Standards
• Understanding Standards
► Manometers
• Types of Manometers
• Manometer Fluid
• Setup and Use of a Manometer
► Deadweight Testers
• Characteristics of Deadweight Testers
• Hydraulic Deadweight Testers
• Pneumatic Deadweight Testers
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CTE002

CALIBRATION & TEST EQUIPMENT: PNEUMATIC TEST EQUIPMENT

Produced in conjunction with ISA — The Instrumentation, Systems, and Automation Society (ISA™) — this
course details the operation and application of pneumatic test equipment.
Topics covered include:
► Test gages
► Deadweight testers as calibration pressure sources
► Digital-display pneumatic instruments.
Course menu:
► Test Gages
• Design
• Using Test Gages
► Deadweight Testers
• Deadweight Tester Design
► Analog-Display Pneumatic Calibrators
• Design
• Using the Calibrator
► Digital Display Pneumatic Calibrators
• Design
• Calibration
CTE003

CALIBRATION & TEST EQUIPMENT: ELECTRONIC TEST EQUIPMENT

Produced in conjunction with ISA — The Instrumentation, Systems, and Automation Society (ISA™) — this
course reviews the operation and application of electronic test equipment.
Topics covered include:
► Multimeters
► Multifunction calibrators, parts I and II
► Function generators and frequency counters.
Course menu:
► Electronic Test Equipment
• Basic Considerations
► Multimeters
• Operating Characteristics
► Multifunction Calibrators
• Operating Characteristics
• Determining Input
• Determining Output
► Generators and Counters
• Function Generators
• Frequency Counters
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CTE004

CALIBRATION & TEST EQUIPMENT: OSCILLOSCOPES

Produced in conjunction with ISA — The Instrumentation, Systems, and Automation Society (ISA™) — this
course teaches students how to use an oscilloscope.
Topics covered include:
► Introduction to functions and features
► Using the oscilloscope
► Advanced measurements and applications.
Course menu:
► Oscilloscope Controls
• Display, Vertical, and Horizontal Controls
• Trigger Controls and Probe
► Using the Oscilloscope
• Start-up and Initialization
• Measuring Period and Frequency
► Advanced Measurement Applications
• Single Shot Events
• Differential Measurements

CTE005

CALIBRATION & TEST EQUIPMENT: INSTRUMENTATION ERRORS

Produced in conjunction with ISA — The Instrumentation, Systems, and Automation Society (ISA™) — this
course reviews span errors, combination errors, installation errors, inclination errors, and position errors.
Topics covered include:
► Characteristics of measuring instruments
► Analysis of instrumentation errors
► Installation and interpretive errors.
Course menu:
► Instrumentation Errors
• Recognizing Instrumentation Errors
• Instrumentation Accuracy
► Analysis and Interpretation
• Analysis of Instrumentation Errors
• Determining Effects of Instrumentation Errors
• Installation and Interpretive Errors
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CTE006

CALIBRATION & TEST EQUIPMENT: INSTRUMENT CALIBRATION

Produced in conjunction with ISA — The Instrumentation, Systems, and Automation Society (ISA™) — this
course teaches students how to calibrate pneumatic and electronic instruments.
Topics covered include:
► Introduction to instrument calibration
► Calibration preparation and pneumatic instrument calibration
► Electronic instrument calibration.
Course menu:
► Instrument Calibration
• Principles of Instrument Calibration
► Calibration Preparation
• Calibration Connections
• Identification of Test Points
• Calculating Input/Output Values
► Calibrating a Pneumatic Instrument
• Calibration Considerations and Procedures
► Calibrating an Electronic Instrument
• Calibration Considerations and Procedures

Continuous Process Control 4-Part Series
CPC001

CONTINUOUS PROCESS CONTROL: PRINCIPLES OF
CONTINUOUS CONTROL

Produced in conjunction with ISA — The Instrumentation, Systems, and Automation Society (ISA™) — this
course teaches students the characteristics of continuous processes as well as the requirements for control
and the control strategies and instrumentation associated with this type of process.
Course objectives include:
► Define continuous process and the control requirements of a continuous process
► Identify the four fundamental variables for most continuous processes
► Describe the types of instrumentation used
► Describe the additional variables associated with a specific product, for example, product composition,
product-to-energy ratios, and product economy
► Explain the function of a final control element in a continuous process
► Explain how signal transmission is used to communicate to all the elements in a continuous process
► Describe the characteristics and applications of a closed loop system to include the feedback control
loop, the cascade control loop, and the feed forward control loop.
Course menu:
► Characteristics of Continuous Processes
• Introduction to Continuous Processes
• Four Fundamental Variables
• Other Important Variables
► Control of Continuous Processes
• Final Control Element
• Control Algorithms
► Importance of Signal Transmission
• Signal Transmission in Continuous Processes
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► Control Strategies for Continuous Processes
• Feedback Control
• Cascade Control
• Feedforward Control

CPC002

CONTINUOUS PROCESS CONTROL: APPLICATIONS OF HEAT
EXCHANGER CONTROL

Produced in conjunction with ISA — The Instrumentation, Systems, and Automation Society (ISA™) — this
course discusses the basic operation of a liquid-to-liquid exchanger. Students will learn about controlled versus
manipulated variables and the features, application, and changes of cascade control and feed forward control.
In addition, students will look at the effects a modified heat exchanger system has on a continuous process.
Course objectives include:
► Define the basic function of a heat exchanger system
► Identify the characteristics of a common heat exchanger system
► Describe the two types of variables needed for the heat exchanger to function properly
► Explain how the heat exchanger controls product flow and product temperature
► Describe how the heat exchanger functions with changes in product temperature
► Describe how the heat exchanger operates in a cascade control loop
► Describe how the heat exchanger operates in a feed forward control loop
► Describe the effect on the process control system when a second heat exchanger is added.
Course menu:
► Operation of Heat Exchanger System
• Basic Functions and Types of Variables
• Product Flow
• Product Temperature
• Changes in Product Temperature
► Cascade and Feedforward Control
• System Features of Cascade Control
• Cascade Control Changes
• Features of Feedforward Control
• Feedforward Control Changes
► Modified Heat Exchanger System
• Features
• Design of Split Range Valves
• Controlling Heating Medium

CPC003

CONTINUOUS PROCESS CONTROL: APPLICATIONS OF
DISTILLATION CONTROL

Produced in conjunction with ISA — The Instrumentation, Systems, and Automation Society (ISA™) — this
course identifies the process components of distillation control and examines some of the theories of
operation.
Course objectives include:
► Identify the process components of a distillation control system
► Describe the basic operation of the components of a distillation control system
► Explain why maintaining a good produce composition is an important function of the distillation column
► Describe the variables that affect distillation and produce composition
► Explain why control of the reflux system is a function of the distillation column
► Identify the impact of maintaining a proper phase relationship of the column contents
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► Describe the process for controlling heat in the system to include temperature and pressure control as
well as column feed, column bottoms, and column temperature control
► Describe how the process for transporting condensate from the column to the accumulator is controlled.
Course menu:
► Basic Operation in Distillation
• Functions of Components
• Maintaining Product Composition
• Vapor Pressure in Components
• Controlling Pressure and Temperature
► Reflux Stream
• Features of Reflux Stream
• Controlling Reflux Stream and Bottoms
► Controlling Heat in System
• Temperature Control in Reboiler
• Pressure Control
• Working of Column Feed Control
• Control of Column Bottoms
• Control of Column Temperature
► Controlling Transport of Condensate
• Flow of Condensate
• Control of Reflux Rate
CPC004

CONTINUOUS PROCESS CONTROL: APPLICATIONS OF
PH CONTROL

Produced in conjunction with ISA — The Instrumentation, Systems, and Automation Society (ISA™) — this
course teaches the basics of pH and how the efficiency of a process is influenced by this factor. pH is one of
the most difficult process variables to control, so an understanding of the chemistry and characteristics of pH
is important. In addition, students will examine the equipment used in a pH control system and some of the
factors that must be considered in the selection and utilization of various types of equipment.
Course objectives include:
► Define pH
► Describe the basic characteristics of pH and how these factors can influence pH control
► Define the chemical breakdown of pH and how the pH scale should be interpreted
► Describe the factors affecting pH control, such as rangeability, nonlinearity, and sensitivity of pH
► Describe how equipment and hardware can affect pH measurements in a pH control system
► Recognize the conditions of the pH adjustment process and the outcome of this process.
Course menu:
► pH Control
• Importance of pH Control
• What is pH?
• Factors Affecting pH Control
► pH System Hardware
• Hardware Selection for pH System
► pH Control Strategies
• pH Control Schemes
• Example of a pH Control System
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Control Valves & Actuators 4-Part Series
CVA001

CONTROL VALVES & ACTUATORS: BASICS & FUNCTION

Produced in conjunction with ISA — The Instrumentation, Systems, and Automation Society (ISA™) — this course
teaches the basics of a control valve, a rotary valve, and an actuator as well as other components associated with
the function and operation of these control elements. Students will also learn how to identify the factors that
affect the selection of the type of actuator needed.
Course objectives include:
► Identify the characteristics, function, and application of the control valve
► Describe the factors that must be considered when selecting the proper control valve
► Describe the functions of a valve actuator and a control valve positioner and how these work within a control
system.
Course menu:
► Basic Tasks of a Control Valve
• Dispensing, Dissipating, and Distributing
► Control Valve Selection
• Importance of Proper Valve Selection
► Functions of Control Valves
• Dependent on Different Design Requirements
CVA002

CONTROL VALVES & ACTUATORS: TYPES & DESIGN

Produced in conjunction with ISA — The Instrumentation, Systems, and Automation Society (ISA™) — this course
teaches students how to determine which type of control valve is needed. Control valves come in limitless types,
sizes, designs, and materials but basically fall in two distinct categories: linear motion and rotary motion. This
course will help students evaluate the factors that determine which type of linear motion control valve to use
and which type of rotary motion control valve to use.
Course objectives include:
► Describe the functions, applications, and differences of linear motion control valves and rotary motion
control valves
► Describe the functions, applications, and differences of pneumatically operated actuators, electrically
operated actuators, and rotary motion actuators
► Describe the basic operation and function of the components of the control valve
► Identify factors that affect control valve safety.
Course menu:
► Various Valve Designs
• Linear Motion Control Valves
• Rotary Motion Control Valves
► Types of Control Valve Actuators
• Pneumatically Operated Actuator
• Electrically Operated Actuator
• Vane-Type Actuator
► Parts of a Control Valve
• Primary Valve Trim
• Secondary Valve Trim
► Control Valve Safety
• Safety Considerations
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CVA003

CONTROL VALVES & ACTUATORS: FUNDAMENTALS & SELECTION

Produced in conjunction with ISA — The Instrumentation, Systems, and Automation Society (ISA™) — this
course teaches students how to select the proper control valve by considering many factors, including flow
characteristics, environmental conditions, and safety issues. Students will be exposed to the formulas and
calculations that are needed in the selection process. In addition, students will learn the general criteria that
must be followed when selecting an actuator and associated
auxiliary devices.
Course objectives include:
► Describe the different types of fluid flow
► Identify the factors that affect fluid flow
► Explain the formulas used for determining valve selection
► Describe the conditions of fluid flowing through a restriction such as a Herschel venture, a concentric
orifice,
and Vena Contracta
► Explain cavitation, flashing, and fluid flow
► Explain the considerations for selecting a control valve
► Describe the preliminary criteria for selecting the proper actuator and auxiliary devices.
Course menu:
► Fluid Flow Fundamentals
• Laminar and Turbulent Flow
• Cavitation and Flashing
► Control Valve Selection
• Steps for Selecting a Control Valve
► Actuator Selection
• Criteria for Proper Actuator Selection

CVA004

CONTROL VALVES & ACTUATORS: SIZING & INSTALLATION

Produced in conjunction with ISA — The Instrumentation, Systems, and Automation Society (ISA™) — this
course teaches students the steps needed for determining control valve sizing and the various factors involved
in actuator sizing. Students will also learn how to install and maintain control valves and how to verify that the
selected actuator is appropriate for specific industrial needs.
Course objectives include:
► Describe the factors to consider for correctly sizing a valve
► Recognize what items are needed to determine proper valve sizing
► Determine the proper control valve to be used for a liquid, gas, and vapor application
► Describe the factors involved with actuator sizing, such as static force, valve leakage classification, and
dynamic forces
► Recognize the proper installation and maintenance procedures of a control valve.
Course menu:
► Control Valve Sizing
• Steps for Determining Valve Sizing
• Valve Sizing for Liquid Applications
• Valve Sizing for Gas and Vapor Applications
► Actuator Sizing
• Factors Involved in Actuator Sizing
► Valve Installation and Maintenance
• Planning Valve Installation and Maintenance
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Electronic Maintenance 12-Part Series
EMS001

ELECTRONIC MAINTENANCE: SOLID STATE DEVICES

Produced in conjunction with ISA — The Instrumentation, Systems, and Automation Society (ISA™) — this
course covers:
► PN junction transistors
► Bipolar junction transistors
► Semiconductor devices
► Amplifiers.
Course menu:
► PN Junction Diodes
• Introduction to Solid-State Devices
• PN Junction Diode Operation
• Zener Diode
► Bipolar Junction Transistors
• Introduction to Bipolar Junction Transistors
• PNP and NPN Transistors
► Other Semiconductor Devices
• FETs and JFETs
• MOSFETs and UJTs
• SCRs and TRIACs
► Amplifiers
• Transistor Configurations
• Methods to Connect Transistors

EMS002

ELECTRONIC MAINTENANCE: INTEGRATED CIRCUITS & OP AMPS

Produced in conjunction with ISA — The Instrumentation, Systems, and Automation Society (ISA™) — this
course covers:
► Integrated circuits and operational amplifiers
► Negative feedback
► Amplifying circuits
► Op amp configurations.
Course menu:
► Integrated Circuits
• Introduction to Integrated Circuits
• Typical Analog IC Applications
► Operational Amplifiers
• Characteristics of Operational Amplifiers
• Operation of Op Amps and Package Diagram
► Negative Feedback
• Introduction to Negative Feedback
• Inverting and Noninverting Op Amps
• Principle of Virtual Ground
► Amplifying Circuits
• Operation of Amplifying Circuits
► Op Amp Configurations
• Summing Circuits
• Functional Circuits
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EMS003

ELECTRONIC MAINTENANCE: SENSOR & TRANSDUCER PRINCIPLES

Produced in conjunction with ISA — The Instrumentation, Systems, and Automation Society (ISA™) — this
course covers:
► Temperature, pressure, level flow, and weight sensors
► Current-to-pneumatic (I/P) transducers
► Electronic transducers
► A/D and D/A converters
► Fiber optics.
Course menu:
► Sensors
• Introduction to Sensors
• Temperature Sensors
• Pressure Sensors
• Level Sensors
• Flow Sensors
• Weight Sensors
► Transducers
• Introduction to Transducers
• I/P Transducers
• Electronic Transducers
• A/D and D/A Converters
• Fiber Optics

EMS004

ELECTRONIC MAINTENANCE: TRANSMITTERS

Produced in conjunction with ISA — The Instrumentation, Systems, and Automation Society (ISA™) — this
course covers:
► Transmitter operation
► Pressure transmitter troubleshooting
► RTD transmitter operation and calibration
► Vortex shedding flow meter operation
► Capacitance level transmitters.
Course menu:
► Introduction to Transmitters
• Transmitter Operation
• Advantages of Transmitters
► Pressure Transmitters
• Differential Pressure Transmitter
• Troubleshooting Tests
• Transmitter Operation Testing
• Pressure Transmitter Troubleshooting
► Temperature Transmitters
• Temperature Transmitter
• RTD Transmitter Operation
• RTD Transmitter Calibration
• Thermocouple
► Flow Transmitters
• Vortex Shedding Flowmeter Operation
• Troubleshooting Tests
• Level Transmitters
• Capacitance Level Transmitter
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EMS005

ELECTRONIC MAINTENANCE: TRANSDUCERS

Produced in conjunction with ISA — The Instrumentation, Systems, and Automation Society (ISA™) — this
course covers:
► Transducer operation and maintenance
► I/P transducer operation, maintenance, and calibration
► Pneumatics and electronic troubleshooting and maintenance
► Fiber optic circuit operation
► Pressure transmitter calibration.
Course menu:
► Introduction to Transducers
• Transducers Operation
• Three Types of Transducer Maintenance
► I/P Maintenance and Calibration
• I/P Transducer Operation
• Pneumatic Troubleshooting and Maintenance
• Electronic Troubleshooting and Maintenance
• Calibration Procedures
► Other Transducers
• Fiber Optic Circuit Operation
• Pressure Transmitter Calibration

EMS006

ELECTRONIC MAINTENANCE: CONTROLLERS, INDICATORS
& RECORDERS

Produced in conjunction with ISA — The Instrumentation, Systems, and Automation Society (ISA™) — this
course covers:
► Analog controller types and functions
► Controller calibration and troubleshooting
► Indicators and annunciators
► Types and functions of recorders
► Troubleshooting recorders.
Course menu:
► Analog Controllers
• Introduction and Functions in Control Loops
• Types of Controllers
• Types of Control Modes and Components
• Functions of Components
► Controller Calibration and Troubleshooting
• Calibrating Display Indicator
• Calibrating Alarm Indictor
• Calibrating Control Module
• Troubleshooting Controllers
► Indicators and Annunciators
• Features of Indicators
• Control Buttons
► Recorders
• Functions and Types
• Chart Replacement Method
• Inking Systems
• Verification and Troubleshooting
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EMS007

ELECTRONIC MAINTENANCE: TUNING

Produced in conjunction with ISA — The Instrumentation, Systems, and Automation Society (ISA™) — this
course covers:
► Controller tuning and preliminary steps
► Proper controller settings
► PI controller settings
► Decay ratio matrix.
Course menu:
► Tuning Principles
• Controller Tuning
• Preliminary Steps
► Ultimate Method
• An Introduction
• Calculation of Controller Settings
• PI Controller Tuning
► Trial and Error Method
• An Introduction
• Decay Ratio Matrix
• PI Controller Tuning

ELECTRONIC MAINTENANCE: SAMPLING SYSTEMS & GAS
CHROMATOGRAPH VALVES
EMS008

Produced in conjunction with ISA — The Instrumentation, Systems, and Automation Society (ISA™) — this
course covers:
► Operating principles of a single- and multi-stream sampling system
► Interpretation of a chromatograph
► Troubleshooting components
► Disassembly, repair, and reassembly.
Course menu:
► Analyzer Principles
• Process Analysis
► Gas Chromatograph
• Operating Principles and Sections
• Purpose of Chromatogram
► Sample Systems
• Function of Sample System
• Sample Conditioning System Maintenance
• Multi-Stream Sample Section
► Sample Injection and Column Switching Valves
• Sample Injection Valve - Design and Function
• Diaphragm Valve
• Column Switching Valve - Function
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EMS009

ELECTRONIC MAINTENANCE: GAS CHROMATOGRAPH
OVENS & CONTROLLERS

Produced in conjunction with ISA — The Instrumentation, Systems, and Automation Society (ISA™) — this
course covers:
► Troubleshooting and maintenance
► Disassembly, repair, and reassembly of thermal conductivity detectors
► Disassembly, repair, and reassembly of flame ionization detectors
► Calibration of gas chromatograph controllers.
Course menu:
► Ovens
• Inspection, Components, and Replacement
► Thermal Conductivity Detectors
• Operation
• Maintenance and Thermistor Replacement
► Flame Ionization Detectors
• Operation and Maintenance
• Components Replacement Procedure
• Disassembly, Cleaning, and Reassembly
► Gas Chromatograph Controls
• Functions and Calibration

EMS010

ELECTRONIC MAINTENANCE: SPECTROSCOPIC ANALYZERS

Produced in conjunction with ISA — The Instrumentation, Systems, and Automation Society (ISA™) — this
course covers:
► Operating principles and configurations
► Disassembly, repair, and reassembly of ultraviolet, visible, and infrared analyzers
► Cleaning
► Source replacement.
Course menu:
► Introduction to Spectroscopic Analyzers
• Operation
• Types of Analyzers
► Source Inspection and Maintenance
• Safety Precautions
• Troubleshooting
► Optical Path Maintenance
• Filers, Lenses, and Motor Maintenance
• Sample Cell Maintenance
► Routine Maintenance and Calibration
• Sample Conditioning
• Components Inspection
• Calibration
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EMS011

ELECTRONIC MAINTENANCE: ELECTROCHEMICAL ANALYZERS

Produced in conjunction with ISA — The Instrumentation, Systems, and Automation Society (ISA™) — this
course covers:
► Function of pH sensor components
► Function of conductivity sensors
► Maintenance
► Calibration.
Course menu:
► pH Analyzers
• Function
• pH Sensor Components
• Maintenance of pH Probe
• Calibration
► Conductivity Analyzers
• Components
• Cell Maintenance
• Calibration

EMS012

ELECTRONIC MAINTENANCE: INSTRUMENT LOOP
TROUBLESHOOTING

Produced in conjunction with ISA — The Instrumentation, Systems, and Automation Society (ISA™) — this
course covers:
► Designing a troubleshooting plan
► Application of techniques in a temperature and flow control system
► Using a distributed control system.
Course menu:
► Troubleshooting Basics
• Troubleshooting Plan
► Single-Loop Systems
• Troubleshooting Techniques
• Temperature Control System
• Flow Control System
► Distributed Control Systems
• Process Information
• Troubleshooting Techniques
• Flow Control Problem

Process Measurement 8-Part Series
PME001

PROCESS MEASUREMENT: TEMPERATURE 1 – THERMOMETERS &
THERMOCOUPLES

Produced in conjunction with ISA — The Instrumentation, Systems, and Automation Society (ISA™) — this
course introduces students to the concept of temperature and the equipment used to measure temperature.
Topics covered include:
► Temperature scales
► Factors affecting accuracy of measurement
► Types of thermometers
► Thermocouples.
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Course menu:
► Introduction to Temperature Measurement
• Temperature Measurement Devices
• Classifying Measuring Devices
► Factors Affecting Measurement Accuracy
• Stem Loss, Thermal Shunting, Radiation
• Frictional Heating and Surface Mounted Sensors
► Classification of Thermometers
• Mechanical Temperature Devices
• Three Types of Liquid-In-Glass Thermometers
• Filled Thermal System
► Electric Temperature Measuring Device
• Thermocouple Operation
• Thermocouple Design
• Components of the Thermocouple Assembly
• Installation Considerations

PME002

PROCESS MEASUREMENT: TEMPERATURE 2 – RESISTANCE &
RADIATION DEVICES

Produced in conjunction with ISA — The Instrumentation, Systems, and Automation Society (ISA™) — this
course provides details on specific types of measurement equipment.
Topics covered include:
► Resistance temperature detectors
► Thermistors
► Radiation pyrometers.
Course menu:
► Resistance Devices
• Resistance Temperature Devices
• Thermistors
► Radiation Pyrometers
• Principles of Radiation Pyrometers
• Types of Pyrometers

PME003

PROCESS MEASUREMENT: PRESSURE 1 – MANOMETERS & GAGES

Produced in conjunction with ISA — The Instrumentation, Systems, and Automation Society (ISA™) — this
course introduces students to the concept of pressure and the equipment used to measure pressure.
Topics covered include:
► Manometers
► Mechanical pressure transducers.
Course menu:
► Introduction to Pressure
• Force Exerted by Liquids
• Force Exerted by Gases
► Pressure Measurement
• Units of Measurement
• Converting Measurement Units
• Differential Pressure
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► Manometers
• Basic Manometers
• Types of Manometers
► Mechanical Pressure Transducers
• Principles of Mechanical Pressure Transducers
• Types of Pressure Transducers

PME004

PROCESS MEASUREMENT: PRESSURE 2 –
INDICATORS & TRANSMITTERS

Produced in conjunction with ISA — The Instrumentation, Systems, and Automation Society (ISA™) — this
course provides additional emphasis on electrical pressure elements.
Topics covered include:
► Electrical/electronic pressure elements
► Installation considerations.
Course menu:
► Electrical Pressure Elements
• Principles of Electrical Pressure Transducers
• Types of Electrical Pressure Elements
► Electronic Pressure Elements
• Strain Gage
• Crystals
► Installation Considerations
• Instrument Protection
• Design Factors Affecting Accuracy

PME005

PROCESS MEASUREMENT: LEVEL 1 – LEVEL MEASUREMENT
& GAGES

Produced in conjunction with ISA — The Instrumentation, Systems, and Automation Society (ISA™) — this
course introduces students to the concept of level and the equipment used to measure level.
Topics covered include:
► Visual level sensors
► Variable displacement devices.
Course menu:
► Introduction to Level Measurement
• Basic Concepts
• Selecting Measurement Devices
► Visual Level Sensors
• Dipstick and Steel Tape
• Sight Glasses
• Float Actuated Devices
► Variable Displacement Devices
• Principles of Buoyancy
• Devices
► Head Pressure Measurement Sensors
• Hydrostatic Pressure
• Open-Tank Head Pressure Measurement Sensors
• Closed-Tank Head Pressure Measurement Sensors
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PME006

PROCESS MEASUREMENT: LEVEL 2 – LEVEL INDICATORS
& TRANSMITTERS

Produced in conjunction with ISA — The Instrumentation, Systems, and Automation Society (ISA™) — this course
provides additional emphasis on measurement sensors.
Topics covered include:
► Electrical level sensors
► Ultrasonic and sonic sensors.
Course menu:
► Electrical Level Sensors
• Capacitance
• Conductivity
• Resistance
► Ultrasonic Sensors
• Measuring Level with Sound Waves
• Point Measurement
• Continuous Measurement
• Non-Invasive Ultrasonic Sensors
► Other Level Measuring Devices
• Rotating and Vibrating Paddles
• Thermal Sensing Level Measurement
• Nuclear Devices
• Gravimetric Level Measurement

PME007

PROCESS MEASUREMENT: FLOW 1 – FLOW MEASUREMENT

Produced in conjunction with ISA — The Instrumentation, Systems, and Automation Society (ISA™) — this course
teaches students the concepts of flow and measuring flow.
Topics covered include:
► Fluid properties
► Measuring flow.
Course menu:
► Principles Affecting Flow
• Flow Rate
• Density
• Viscosity
► Measuring with Differential Pressure
• The Physical Principles
• Measuring Devices
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PME008

PROCESS MEASUREMENT: FLOW 2 – FLOW SENSORS

Produced in conjunction with ISA — The Instrumentation, Systems, and Automation Society (ISA™) — this
course discusses head-type differential pressure flow meters and magnetic, thermal, and ultrasonic flow
meters.
Topics covered include:
► Mass flow meters
► Positive displacement flow meters
► Axial turbine flow meters
► Rotameters
► Vortex shredders.
Course menu:
► Magnetic Flowmeters
• Measuring Voltage to Find Flow Rate
• Problems, Disadvantages, and Advantages
► Mass Flow Measurement
• Basic Concepts
• Coriolis Force
• Coriolis Flowmeter
► Turbine and Positive Displacement Flowmeters
• Turbine Flowmeters
• Positive Displacement Flowmeters
► Oscillatory Flowmeters
• Vortex Shedding Flowmeters
• Vortex Precession Flowmeters

Smart Digital Instrumentation 4-Part Series
SMART DIGITAL INSTRUMENTATION: UNDERSTANDING HART
PROTOCOL
SMI001

This course introduces students to the technology, circuitry, signaling, command set, and device description
language (DDL) of HART protocol. Students also learn about HART-compatible field devices such as
transmitters, process receivers, and field controllers.
Course objectives include:
► Explain how a digital signal is transmitted over an existing analog signal using HART
► Identify the parts and format of a HART message
► Explain the makeup of Device Descriptive Language used in HART protocol
► Identify HART components and their functions.
Course menu:
► HART Protocol
• HART Technology
• HART Signaling
• HART Command Set
• HART Device Description Language (DDL)
► HART-Compatible Field Devices
• Transmitters
• Valve Positioners
• Field Controllers
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SMI002

SMART DIGITAL INSTRUMENTATION: APPLICATIONS OF SMART
FIELD DEVICES

In this course, students learn the installation requirements of HART-compatible Smart field devices — including
wiring, intrinsic safety, and networking. Central hosting systems and interfaces are also covered. Finally,
examples of industrial applications for HART-compatible Smart systems, such as inventory management,
remote operation, and open architecture, are reviewed.
Course objectives include:
► Explain the installation requirements of HART-compatible Smart field devices
► Understand the function of central hosting systems and interfaces
► Identify industrial applications for HART-compatible Smart systems.
Course menu:
► Installing HART Field Devices
• Wiring
• Intrinsic Safety
• Networking
► Central Host System and Interfaces
• PC Control
• Multiplexers
• Gateways
► Industrial Application Examples
• Inventory Management
• Remote Operation
• Open Architecture

SMI003

SMART DIGITAL INSTRUMENTATION: CONFIGURING, CALIBRATING
& TESTING SMART FIELD DEVICES

This course explains the functions and operating procedures of HART-compatible communicators/calibrators.
The HART communicator provides a communication link to all HART-compatible, microprocessor-based
instruments. The communication link enables the commissioning, configuring, maintaining, calibrating, and
troubleshooting of HART Smart field devices.
Course objectives include:
► Explain the functions and operating procedures of HART-compatible communicators
► Understand the specific tests, configurations, settings, errors, and warning messages to effectively
commission, configure, maintain, calibrate, and troubleshoot HART Smart field devices.
Course menu:
► HART-Compatible Communicator/Calibrators
• Functions and Operating Procedures
• Working Offline
• Working Online
• Viewing and Using Online Menus
► Commissioning
• Transmitter Test
• Loop Test
• Data Documentation
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► Configuration
• Online Configuration
• Offline Configuration
• Data Sheet
► Maintenance and Calibration
• Setting Trims
• Setting Response Time
• Tamperproof Settings
• Restore Factory Settings
► Troubleshooting
• Hardware Diagnostics
• Software Errors and Warning Messages

SMI004

SMART DIGITAL INSTRUMENTATION: FOUNDATION™ FIELDBUS

This course introduces students to the FOUNDATION™ fieldbus communication model — including the
physical layer, the communications stack, and user applications. Resource, function, and transducer blocks
are discussed as well as their applications.
Course objectives include:
► Explain the FOUNDATION™ fieldbus communication model as well as its functions and applications.
Course menu:
► Foundation Fieldbus Definition
• Defining Foundation Fieldbus
► Foundation Fieldbus Theory
• Physical Layer
• Communications Stack and User Application
► Foundation Fieldbus Functions
• Blocks, Resource
► Foundation Fieldbus Applications
• Function Block Applications

Machine Technology Curriculum (39 Training Hours)
Includes:
• Basic Machine Technology 10-Part Series
• Computer Numerical Control 15-Part Series
• Basic Engine Lathe 14-Part Series

Basic Machine Technology 10-Part Series
BASIC MACHINE TECHNOLOGY: SAFETY PROCEDURES &
GUIDELINES
MCT001

This course is an introduction to the importance of safety in the machine shop. Skill is not only measured in the
quantity and quality of production but also in the attitude of the operator towards safety. Although there are
many guidelines that contribute to safety, the most important is thinking about safety.
The
►
►
►
►

course covers:
General safety procedures
Hand tool, band saw, and drill press safety
Lathe, milling, and grinding safety operation
Clean-up and first aid.
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Course menu:
► Shop Safety Inspection
• Machine Shop Environmental
• Think Safety
► Proper Use of Power Tools
• Operating Power Equipment
► General Shop Safety Procedures
• Shop Safety Practices

MCT002

BASIC MACHINE TECHNOLOGY: HAND TOOLS & THEIR USE

This course teaches students about the various hand tools commonly found in a machine shop and how to use
them properly.
The
►
►
►
►
►
►
►
►
►
►

course covers:
C-clamps and machine clamps
Hammers, pliers, cutters, and vice grips
Snips and adjustable wrenches
Open-end, box-end, and combination wrenches
Socket and socket head wrenches
Pipe, spanner, and strap wrenches
Taps and tap wrenches
Threading dies and screwdrivers
Punches, chisels, and screw extractors
Reamers and drills.

Course menu:
► Hand Tools
• Bench Vice, Clamps, and Hammers
• Pliers, Hand Snips, and Twist Drills
• Wrenches and Hand Reamers
• Hand Taps, Treading Dies, and Screwdrivers
• Punches, Cold Chisels, and Screw Extractors

MCT003

BASIC MACHINE TECHNOLOGY: THE USE OF MEASURING TOOLS

Measurements are designated by such terms as diameter, width, and depth; these readings can be taken on the
inside or outside of an object. Since the naked eye is not very useful (or precise) for measurement, there are
other measuring tools available to machinists. This course will show students the importance of measurement
in machine technology as well as various measuring tools and their proper uses.
The
►
►
►
►

course covers:
Parameters
Safety
Linear measures
Basic measuring tools
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►
►
►
►

Steel and augmented steel rules
Vernier and universal Vernier calipers
Micrometer calipers
Dial indicators and digital readouts.

Course menu:
► Linear Measurement and Basic Tools
• Linear Measurement
• Basic Tools

MCT004

BASIC MACHINE TECHNOLOGY: THE VERTICAL MILLING MACHINE –
PARTS & OPERATION

The vertical milling machine is one of the most versatile tools in machining operations. The type of milling
machine normally found in machine shops is a vertical spindle machine with a swiveling head. This tool is good
to use for machining flat surfaces. This course will teach students how each part of the vertical milling machine
is used in the operation of the machine as well as the different types of attachments that can be used with the
milling machine.
The course covers:
► Safety and pre-operation
► Ram and turret
► Adapter head
► Milling attachments and descriptions
► Additional features
► Knee, saddle, and table descriptions
► Table micrometer dials
► Locking
► Mounting a cutting tool
► Spindle speed
► Quill feed operation, direction, and micrometers.
Course menu:
► Vertical Milling Machine
• Safety Items and Pre-Operation
• Components
► Additional Features
• Control Devices, Knee, Saddle, and Table
• Table Micrometer Dials and Locking Devices
• Mounting a Cutting Tool and Spindle Speed
• Quill Feed Operation and Quill Micrometer

MCT005

BASIC MACHINE TECHNOLOGY: VERNIER CALIPER & VERNIER
PROTRACTOR

For precise measurements, a machinist must understand how to use the Vernier scale. This course will teach
students how to read the Vernier scale and how it is used with two common machinists’ measuring tools —
the Vernier caliper and Vernier protractor.
The
►
►
►
►
►
►
►

course covers:
Safety
Caliper description and explanation of use
Main and Vernier scales
Taking a measurement
Measuring diameters
Inside measurement
Protractor description and explanation of use.
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Course menu:
► Vernier Caliper
• Components of the Vernier Caliper
• Reading a Caliper
• Taking Measurements
► Vernier Protractor
• Protractor Description
• Reading a Protractor
MCT006

BASIC MACHINE TECHNOLOGY: THE PEDESTAL GRINDER

The pedestal grinder uses a rotating abrasive wheel for semi-precision sharpening of tools held by hand.
This method is also referred to as off-hand grinding. This course teaches students the proper procedures for
dismounting and mounting a grinding wheel on the pedestal grinder. Additionally, students will learn some of
the safety procedures required for setting up and using the pedestal grinder.
The
►
►
►
►

course covers:
Wheel mounting and dismounting
Left/right comparison
Dressing the wheel
Safety procedures.

Course menu:
► Safety Procedures, Use, and Preparation
• Safety
• Dismounting and Mounting the Wheel
• Using the New Grinding Wheel

MCT007

BASIC MACHINE TECHNOLOGY: SHARPENING DRILL BITS BY HAND
OR THE DRILL PRESS

This course teaches students two methods of grinding twist drills. The first method, hand grinding, is
performed on a pedestal grinder with the machinist doing all the manipulations by hand. The second method,
drill point grinding, is performed the same way but with a drill grinder. Since every machine shop does not
have a precision drill point grinder, students need to know how to perform drilling techniques using both
methods.
The
►
►
►
►
►
►

course covers:
Safety
Drill bit descriptions and sizes
Tip angles
Hand grinding
Drill point grinding machines
Checking accuracy.

Course menu:
► Drill Bits
• Safety, Description, and Sizes
• Drill Point Description
► Drill Point
• Angle and Typical All-Purpose Drill Bit
• Hand Sharpening and Checking Accuracy
• Drill Point Grinding Machines
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MCT008

BASIC MACHINE TECHNOLOGY: DRILL PRESSES – SENSITIVE
& RADIAL ARM

One of the most common tools in any machine shop is the drill press. Drilling is often performed on a sensitive
or a radial drill press; each press has its own specialty. This course will teach students the basic parts and
functions of sensitive and radial arm drill presses as well as the situations for which each should be used.
The
►
►
►
►
►

course covers:
Safety precautions
Basic parts of a sensitive drill press
Sensitive drill press functions
Basic parts of a radial arm drill press
Radial arm drill press functions.

Course menu:
► Safety
General and Specific Safety Concerns
► Sensitive Drill Press
• Basics of the Sensitive Drill Press
• Application of the Sensitive Drill Press
► Radial Arm Drill Press
• Basics of the Radial Arm Drill Press
• Operation of the Radial Arm Drill Press

MCT009

BASIC MACHINE TECHNOLOGY: DRILL PRESS OPERATIONS

A machinist should know how to perform the many operations that are completed on a drill press. This course
is designed to show students these essential operations, including center drilling, straight drilling, and straight
drilling counterboring, countersinking, reaming, and tapping.
The
►
►
►
►
►
►
►
►
►

course covers:
Safety
Holding work
Drilling speed introduction
Spindle speed and feed rate
Positioning and securing a workpiece
Center and straight drilling
Counterboring and sinking
Reaming and tapping
Radial arm drilling.

Course menu:
► Drill Press
• General and Specific Safety Concerns
• Drilling Operation Considerations
► Drilling Operations
• Positioning and Straight Drilling
• Follow-Up Drilling
• Radial Arm Drilling
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MCT010

BASIC MACHINE TECHNOLOGY: VERTICAL BAND SAWS –
PARTS, ACCESSORIES & OPERATIONS

The vertical band machine, often called the vertical band saw, is a versatile tool to a machinist. Using different
bands, he can shape and finish parts by sawing, filing, or polishing. He can also cut internal or external
contours on this machine. This course teaches students the different parts of the band saw, the accessories
that can be used on the machine, and basic operational procedures.
The
►
►
►
►

course covers:
Operation of a vertical band machine
Functions of a vertical band machine
Types of vertical band machines
Cutting internal and external contours.

Course menu:
► Safety
General and Specific Safety Concerns
► Vertical Band Machine Parts
• Basic Parts
• Description
• Guides and Band Speed
• Job Selector Wheel
► Sawing Operations
• Band Preparation and Welding
• Annealing, Grinding, and Band Storage
► Operation
• Machine Setup and Installation of Saw Band
• Cutting, Welding, and Grinding

Computer Numerical Control 15-Part Series
CNC001

CNC: INTRODUCTION TO COMPUTER NUMERICAL CONTROL

Precision machining requires the teamwork of a skilled operator and good equipment. Partnering a skilled
operator with a computer can produce part after part without deviation. This course will teach students the
terms and conditions of the Computer Numerical Control system.
Course objectives include:
► Identify the major components of a CNC milling machine
► Describe motion in terms of the X, Y, and Z axes
► Identify the basic capabilities of the CNC system.
Course menu:
► Computer Numerical Control Machine
• Safety Measures and Machine Description
• Operating Axes
• Manual and Automatic Operation
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CNC002

CNC: PREPARING FOR PROGRAMMING

Computer Numerical Control machines are versatile and capable of repeatedly performing precise operations.
This course details the planning steps required to write a program.
Course objectives include:
► Identify required operations, methods of holding the workpiece, tool selection factors, safety practices,
origin points, and tool length offsets
► Establish an origin point.
Course menu:
► Planning for CNC Programming
• Identifying Operations and Design Print
• Setups and Tool Selection
• Establishing the Origin Point

CNC003

CNC: ABSOLUTE & INCREMENTAL POSITIONING

The basis of CNC systems is the translation of a print to a numerical code, then to a series of machine
operations, resulting in a finished workpiece. The instructions that the programmer writes for the machining
process are derived from the coordinate measurement system.
Course objectives include:
► Identify the X, Y, and Z dimensions of the Cartesian coordinate system
► Describe absolute positioning and incremental positioning
► Program rapid transit movements in both absolute and incremental systems.
Course menu:
► The Cartesian System
• Absolute Positioning System
• Incremental Positioning System

CNC004

CNC: ONE- & TWO-AXIS LINEAR MILLING

Computer Numerical Control machines can be programmed to perform precise milling operations along any
of the three axes — X, Y, and Z. This course introduces programming techniques which will allow milling in
up to two axes simultaneously.
Course objectives include:
► Program milling on the Z axis at a feed rate
► Program milling on the X and Y axes at a feed rate
► Describe climb and conventional milling.
Course menu:
► Milling Operations
• Climb Milling
• Conventional Milling
• Milling a Pocket
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CNC005

CNC: THREE-AXIS LINEAR MILLING & CIRCULAR MILLING

Two of the most useful machining functions on a CNC are moving a tool precisely along three axes
simultaneously and circular or contour path milling. This course will introduce the program codes that make
three axis linear milling and circular milling possible.
Course objectives include:
► For three-axis linear milling, identify sequence numbers, program a tool change, and define a
compound angle
► For circular milling, define clockwise and counterclockwise milling; define the elements necessary for
circular milling; determine the start point, end point, and direction of a circular path; and program a
circular path.
Course menu:
► Milling Operations
• Linear Milling
• Circular Milling

CNC006

CNC: COMPLETED MILLING PROGRAMS

This course demonstrates how a completed milling program should be written to provide the most efficient
means to manufacture a part and keep the program simplistic for easy modification.
Course objectives include:
► Identify standard miscellaneous functions
► Write and test a completed milling program.
Course menu:
► CNC Milling Programs
• Miscellaneous Codes
• Writing and Testing the CNC Program

CNC007

CNC: DRILLING, BORING & SPOT FACING

Computer Numerical Control machines can drill, bore, and spot face by using fixed Z cycles. The fixed Z cycles
program stores repetitive information in the control until it is recalled for use at specific locations on the
workpiece.
Course objectives include:
► Write a drill cycle, spot facing cycle, deep hole cycle, chip breaking deep hole cycle, and boring cycle
statement
► Calculate and write a dwell statement.
Course menu:
► Drilling, Boring, and Spot Facing
• Drill Programming Code G81
• Spot-Facing Programming Code G82
• Deep-Hole Programming Code G83
• Boring Cycles Programming Code G89
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CNC008

CNC: SUBROUTINES

Computer Numerical Control machines can repeat a series of commands or steps in the production of a
part by writing computer program subroutines.
Course objectives include:
► Define and execute a subroutine
► Write a nested subroutine
► Define and execute a subroutine with variables.
Course menu:
► Subroutines
• Creation and Use of Subroutines

CNC009

CNC: LOOPING

Computer Numerical Control machines can recall specific portions of a program for repetitive use of that
program in various functions. This course will introduce students to loop statements and will demonstrate
their use.
Course objectives include:
► Write a loop statement
► Terminate a loop statement
► Identify what information can be contained in a loop statement
► Write a program containing a nested loop.
Course menu:
► Programming Special Cycles
• Performing a Facing Operation
• Milling a Rectangular and Circular Pocket

CNC010

CNC: SPECIAL CYCLES

Computer Numerical Control machines are capable of performing special machining cycles with single
command lines in a program. This course will teach students how special cycles allow programmers to save
time and computer memory.
Course objectives include:
► Program a face milling operation, a rectangular pocket, and a mill boring cycle.
Course menu:
► CNC Special Cycles
• Mirror Image Cycle
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CNC011

CNC: TRANSLATION

This course will teach students how to shift programmed tool movements to a new coordinate that is parallel
to the original coordinate.
Course objectives include:
► Translate a program to a new location
► Translate to the first point of origin.
Course menu:
► Quick Coding
• Drilling and Tapping

CNC012

CNC: POLAR COORDINATE PROGRAMMING

This course introduces the polar coordinate system and demonstrates how it can be used to describe locations
in relation to the center of a circle.
Course objectives include:
► Understand polar coordinates
► Program drilling on a radius
► Program milling using polar coordinates.
Course menu:
► Polar Coordinate Programming
• Drilling Using G70 Code
• Drilling Using G71 Code
• Drilling Using G72 Code

CNC013

CNC: Scaling

This course introduces a programming method to increase or decrease the scale of an existing program by
adding a scaling statement.
Course objectives include:
► Use a pen in the quill as a plotting device
► Write a scaling statement
► Terminate a scaling statement.
Course menu:
► Scaling and Engraving Programming
• Scaling Using G51 Code
• Text Engraving Using G47 Code

CNC014

CNC: MULTI-QUADRANT INTERPOLATION & ROTATION

Computer Numerical Control machines can execute circular interpolation in more than one quadrant and the
rotation of a subprogram to produce the sequence of commands at different angles.
Course objectives include:
► Program multi-quadrant interpolation
► Terminate multi-quadrant interpolation
► Rotate an existing program
► Terminate a rotation.
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Course menu:
► Rotation
• Rotation Cycle Code G68

CNC015

CNC: CUTTER RADIUS COMPENSATION

This course teaches students to use programs which were written for a specific cutter then automatically
compensate for new radii of different cutters.
Course objectives include:
► Enter compensation data into the control
► Write a G41 statement to establish cutter compensation to the left of the part surface
► Write a G42 statement to establish cutter compensation to the right of the part surface
► Write a G40 statement to terminate compensation.
Course menu:
► Cutter Compensation Programs
• Manual Compensation Program
• Cutter Compensation Program

Basic Engine Lathe 14-Part Series
BEL001

BASIC ENGINE LATHE: IDENTIFICATION OF PARTS & CARE OF
THE ENGINE LATHE

This course provides students with basic facts about the engine lathe, its care, and its lubrication.

Course objectives include:
► Understand the safety procedures that are required in every machine shop
► Identify the basic parts of the engine lathe and learn how to call them by the names used in the trade
► Explain the functions of these parts
► Explain the routine care and lubrication a lathe requires.
Course menu:
► Parts of Basic Engine Lathe
• Five Basic Parts
► Operation of Engine Lathe
• Functions of Lathe Parts
• Maintenance

BEL002

BASIC ENGINE LATHE: ENGINE LATHE ACCESSORIES

This course provides students with a basic awareness of the mechanics and functions of commonly used
accessories for the engine lathe.
Course objectives include:
► Understand the safety procedures that are required in every machine shop
► Call the accessories used on the engine lathe by their proper names
► Explain the generally accepted uses of these accessories.
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Course menu:
► Holding Devices
• Four-Jaw and Three-Jaw Chucks
• Split or Rubber-Mounted Collet Chucks and Faceplate
• Drive Plates and Lathe Dogs, and Drill Chucks
• Tool Holders

BEL003

BASIC ENGINE LATHE: CUTTING SPEEDS & FEEDS FOR
LATHE-FERROUS, NON-FERROUS PLASTICS

This course introduces students to the basics of calculating cutting speeds and feeds for machining ferrous,
nonferrous, and plastics materials on the lathe. Calculating speeds and feeds requires the use of mathematics.
Course objectives include:
► Understand the safety procedures that are required in every machine shop as well as those involved with
feeds, speeds, depth of cut, and tool selection on the lathe
► Identify the sources of information for finding formulas, cutting foot speeds, and tool selection for
machining operations on the lathe
► Use appropriate formulas and charts to determine correct speeds and feeds for setting up a lathe to
operate efficiently.
Course menu:
► Calculating Speeds and Feeds
• Cutting Speeds
• Feed Rate, Cutting Depth, and Tool Selection

BEL004

BASIC ENGINE LATHE: GRINDING A RIGHT-HAND ROUGHING TOOL

This course demonstrates the proper method for grinding a right-hand roughing tool using the pedestal
grinder.
Course objectives include:
► Understand the necessary safety procedures for grinding a roughing tool
► Know proper roughing tool nomenclature
► Explain the procedure to follow for grinding a roughing tool.
Course menu:
► Safe Operation
• Safe Operating Procedures
► Preparing the Cutting Tool
• Grinding Relief and Cutting-Edge Angles
• Grinding Radius, Rakes, and Chip Breaker

BEL005

BASIC ENGINE LATHE: GRINDING A ROUND-NOSE FINISHING TOOL

A round nose finishing tool is used for facing large diameters and for straight turning. This course shows
students how to grind a left-hand, round-nose finishing tool on the pedestal grinder.
Course objectives include:
► Understand the safety procedures required in every machine shop
► Know proper cutting tool nomenclature
► Explain the procedure to follow in grinding a left-hand, round-nose finishing tool
► Understand the geometry of a round-nose finishing tool.
88

Maintenance Courseware
Descriptions
Course menu:
► Safe Operation
• Safety and Dressing Procedures
► Round-Nose Finishing Tool Preparation
• Grinding Cutting Edge and Relief Angles
• Grinding Nose and Rake Angles

BEL006

BASIC ENGINE LATHE: MOUNTING & TRUING WORK IN THE
FOUR-JAW INDEPENDENT CHUCK

This course demonstrates the fundamentals of mounting a chuck on an engine lathe and truing a workpiece in
a chuck. These operations are basic to the training of any machinist and must be mastered before students can
successfully move on to the operations that require more complex skills.
Course objectives include:
► Understand the safety procedures required in every machine shop
► Explain the four steps for mounting a four-jaw independent chuck
► Explain the four steps for truing a workpiece by the chalk method
► Explain the five steps for truing a workpiece by the dial test indicator method.
Course menu:
► Mounting and Truing Work in the Chuck
• Steps in Mounting a Four-Jaw Independent Chuck
• Methods of Aligning Workpieces

BEL007

BASIC ENGINE LATHE: THREE METHODS OF FACING WORK
TO LENGTH

This course introduces students to the three methods of facing work to length in a chuck: the hook rule
method, the center punch method, and the compound rest method.
Course objectives include:
► Understand the safety procedures required in every machine shop
► Explain the procedures for facing work to length with the hook rule method
► Explain the procedures for facing work to length with the center punch method
► Explain the procedures for facing work to length with two compound rest methods.
Course menu:
► Lathe Preparation for Facing Operation
• Mounting the Work
• Speed Settings
► Facing Work to Length
• Hook Rule Method
• Center Punch Method
• First Compound Rest Method
• Second Compound Rest Method
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BEL008

BASIC ENGINE LATHE: STRAIGHT TURNING WORK OF TWO
DIAMETERS

This course will show students how to straight turn a workpiece to two concentric diameters in a four-jaw
independent chuck. Students will learn the correct procedures for taking both roughing and finishing cuts.
Finally, students will learn the proper method of finishing one end of work to one diameter, reversing the work
in the chuck, and finishing the other end to another diameter.
Course objectives include:
► Understand the necessary safety procedures for straight turning on the engine lathe
► Describe the procedures for making roughing cuts to two diameters on work held in a four-jaw
independent chuck
► Explain the procedures for making finishing cuts to two diameters on work held in a four-jaw independent
chuck.
Course menu:
► Straight Turning Work
• Making a Rough Cut
• Finishing a Cut

BEL009

BASIC ENGINE LATHE: TURNING BETWEEN CENTERS

Turning between centers is an operation machinists perform frequently. This course demonstrates the
procedures for straight turning a workpiece between centers.
Course objectives include:
► Understand the safety procedures that should be followed when in the shop and when straight turning
work between centers
► Describe the steps needed in setting up work to be straight turned between centers
► Explain the procedure for straight turning a workpiece between centers.
Course menu:
► Turning a Workpiece Between Centers
• Methods of Alignment
• Workpiece Preparation
• Turning Between Centers

BEL010

BASIC ENGINE LATHE: DRILLING, BORING & REAMING WORK HELD
IN A LATHE CHUCK

This course demonstrates how to perform four internal machining operations on the engine lathe: drilling,
boring, counterboring, and reaming.
Course objectives include:
► Understand the safety procedures that are required in every shop and in performing drilling, boring,
counterboring, and reaming operations
► Describe the procedures for drilling in the lathe
► Explain the procedures for boring and counterboring in the lathe
► Explain the procedures for reaming in the lathe.
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Course menu:
► Preparing the Lathe
• Safety Measures
• Internal Machining Operations
► Lathe Operations
• Drilling
• Boring
• Counter Boring
• Reaming

BEL011

BASIC ENGINE LATHE: TURNING A RADIUS

In machine shop terminology, a radius refers to the rounding of a sharp corner to produce a concave shape or
a convex shape. This course will show students five methods of turning a radius on a workpiece.
Course objectives include:
► Understand the safety procedures that should be followed in a machine shop as well as those required for
turning a 		
radius on a workpiece
► Describe the steps in setting up a lathe to turn a radius with the following methods: forming tools, hand
		 manipulation, radius attachment, radius rod, and compound rest.
Course menu:
► Methods of Turning a Radius
• Using Forming Tools
• Hand Manipulations
• Using Radius Attachments
• Compound Rest Method

BEL012

BASIC ENGINE LATHE: TAPER TURNING ON THE LATHE

Taper is a uniform difference in diameter resulting in a wedge or cone shape. This course will show students
three common methods of taper turning on the lathe: the offset tailstock method, the compound rest
method, and the taper attachment method.
Course objectives include:
► Understand the safety procedures for machining tapers on the lathe
► Identify the different types of tapers and their common uses
► Calculate inches of taper per foot and degrees of taper
► Describe the procedures for machining tapers by the offset tailstock, compound rest, and taper
attachment methods.
Course menu:
► Safe Operation and Types of Tapers
• Safe Operating Procedures and Types of Tapers
► Procedures for Machining Tapers
• Offset Tailstock Method
• Compound Rest Method
• Taper Attachment Method
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BEL013

BASIC ENGINE LATHE: FILING & POLISHING ON THE ENGINE LATHE

Filing and polishing are common practices in the machinist’s trade. The workpiece is machined to close
specifications, then filed and/or polished to give the specified diameter and a smooth, desirable surface finish.
This course will show students how to perform filing and polishing operations on the engine lathe.
Course objectives include:
► Understand the necessary safety procedures for grinding a roughing tool
► Know proper roughing tool nomenclature
► Explain the procedure to follow for grinding a roughing tool.
Course menu:
► Filing and Polishing Operations
• Speed Settings
• Filing
• Polishing

BEL014

BASIC ENGINE LATHE: KNURLING ON THE LATHE

Knurling is the impressing of patterns into the surface of cylindrical workpieces. It produces either a diamond
pattern or a straight line pattern. This course will show students the proper set-up and procedures for knurling
on the lathe.
Course objectives include:
► Understand the safety procedures that are required in every machine shop as well as the safety
procedures for 			
knurling on the lathe
► Identify the different types of knurling tools
► Explain the procedures for setting up and knurling a diamond shaped and straight pattern.
Course menu:
► Engine Lathe Safety
• Safety Precautions
► Knurling
• Knurling Tools
• Diamond-Shaped Knurling
• Straight-Line Knurling

Maintenance Troubleshooting Curriculum (5 Training Hours)
Includes:
• Maintenance Troubleshooting 5-Part Series

Maintenance Troubleshooting 5-Part Series
TRB001

MAINTENANCE TROUBLESHOOTING: TROUBLESHOOTING
PROCEDURES

This course teaches students how to identify symptoms associated with mechanical or electrical equipment
problems, determine faulty components based on symptoms, plan a course of action to take in repairing the
problem, repair the problem, and observe post-repair equipment.
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Course objectives include:
► Identify the abnormality or symptom based on normal operation behavior
► Determine the faulty element or component based on symptoms
► Plan a course of action to repair the equipment
► Safely perform repairs on the equipment
► Apply observation techniques to prevent reoccurrence once the problem is repaired.
Course menu:
► Identifying Symptoms
• Observation
• Temperature
• Vibration
• Sound
• Smell
► Determining Faulty Components
• Component Failure Analysis
• Isolating the Fault
► Planning a Course of Action
• Component Access
• Process Interruption
• Maintenance Economics
► Repair and Follow-up Observation
• Replacement Preparation
• Component Replacement
• Operational Observation

TRB002

MAINTENANCE TROUBLESHOOTING: POWER DISTRIBUTION
& LIGHTING SYSTEMS

This course identifies power distribution and the associated equipment from the commercial power source
to the final equipment or device, and typical problems that may occur in this equipment. The second part of
the course introduces students to the design and operation of fluorescent and high intensity discharge (HID)
lighting and methods that may be applied in locating and repairing problems with these lighting systems and
components.
Course objectives include:
► Locate problems in power distribution and lighting systems involving power quality, overcurrent
protective devices, transformers, equipment switches and disconnecting devices, and fluorescent and
high intensity discharge lighting.
Course menu:
► Power Distribution
• Substation
• Power Quality
• Overcurrent Protection Devices
• Transformers
• Equipment Switches and Disconnects
► Lighting Systems
• Fluorescent Lighting
• High Intensity Discharge (HID)
• Lighting Control
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TRB003

MAINTENANCE TROUBLESHOOTING: MOTORS & MOTOR
CONTROLS

This course teaches students to identify motor malfunctions by recognizing problematic symptoms and
applying proven methods in correcting these problems. The course also teaches students how to troubleshoot
two- and three-wire motor control circuits as well as understand the operation and troubleshooting of variable
speed frequency drive systems.
Course objectives include:
► Identify motor and motor control problems
► Test motor windings
► Wire and troubleshoot two- and three-wire motor control circuits
► Troubleshoot variable speed frequency drive systems.
Course menu:
► Motors
• Single-Phase Motors
• Three-Phase Motors
► Motor Controls
• Electro-Magnetic Contactors
• Variable Speed Drive

TRB004

MAINTENANCE TROUBLESHOOTING: PUMPS & COMPRESSORS

This course identifies the various types of pumps and compressors commonly used in industry and teaches the
fundamentals of troubleshooting these pumps and compressors through visible observation of symptoms and
recognizing problems related to fluid flow.
Course objectives include:
► Identify different types of pumps and compressors
► Recognize problematic symptoms associated with mechanical failure or fluid flow
► Apply corrective measures in repairing these pumps and compressors.
Course menu:
► Pumps
• Common Pump Failure
• Types of Pumps
► Compressors
• Dynamic Compressors
• Positive Displacement Compressors

TRB005

MAINTENANCE TROUBLESHOOTING: HYDRAULIC CIRCUITS & HVAC

This course describes hydraulic circuits and components that are used to provide hydraulic energy to linear
and rotary hydraulically-operated actuators. The course is designed to teach students how to identify
problematic symptoms demonstrated in these hydraulic circuits and possible causes for the symptoms. The
second half of the course addresses HVAC equipment, particularly cooling equipment utilizing the refrigeration
cycle, and maintenance and troubleshooting procedures that may be applied in maintaining this equipment.
Course objectives include:
► Identify the primary components in a hydraulic circuit
► Recognize problems with these components
► Identify the primary components in a refrigeration cycle
► Locate problems by applying systematic troubleshooting techniques to distinguish between a component
problem and a refrigerant problem
► Properly use a refrigerant gauge manifold.
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Course menu:
► Hydraulic Circuits
• Hydraulic Pumps
• Hydraulic Actuators
• Directional Control Valves
• Troubleshooting Techniques
► HVAC
• Detecting Problems
• Refrigerant Charging

Mechanical Maintenance Curriculum (73 Training Hours)
Includes:
• HVAC&R 7-Part Series
• Clutches & Brakes 2-Part Series
• Industrial Bearings 3-Part Series
• Industrial Drives 6-Part Series
• Machinery Lubrication 3-Part Series
• Boiler Operation & Control 5-Part Series
• Centrifugal Pumps 5-Part Series
• Valve Basics 4-Part Series
• Hydraulic Power Systems & Troubleshooting 2-Part Series
• Hydraulics 7-Part Series
• Industrial Hydraulics 4-Part Series
• Industrial Seals 3-Part Series
• Pneumatics 8-Part Series
• Steam Traps 3-Part Series
• Pipefitting 11-Part Series

HVAC&R 7-Part Series
AIR001

HVAC&R: AIR HANDLERS – MECHANICAL SYSTEMS

This course describes basic air handler functions and operations, including the functions of the supply and
exhaust sides of the system, fans, dampers, filters, and coils. It outlines preventative maintenance commonly
performed on the major mechanical systems and identifies potential problems.
Course objectives include:
► Perform preventative maintenance on the fan, motor and belts, electrical system, louvers and dampers,
coils, drain pan, and air filters
► Discuss common problems and remedies.
Course menu:
► System Operation
• Air Distribution Types and Maintenance Concerns
► Maintenance Tasks
• Fan and Motor
• Motor Controls
• Louvers, Vanes, Damper, and Filters
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AIR002

HVAC&R: AIR HANDLERS – CALIBRATION

This course focuses on calibration of dampers and safety systems. It discusses the need for system cutoffs to
protect against smoke and fire as well as the need for proper balance of outside and return air levels.
Course objectives include:
► Calibrate the high-static safety switch and the freeze-stat, which protect the air handler from mechanical
damage
► Calibrate the dampers for proper response to control settings
► Calibrate outside and return air levels for maximum comfort and efficiency
► Adjust and test the smoke alarm and humidity control systems.
Course menu:
► Humidity and Smoke Detector Calibration
• Humidifier Operation
• Smoke Sensing Systems
► Damper Calibration
• Other Damper Types and Controls
• Proper Air Mix
► Water Valve, Freeze-Stat, and High Static Safety Switch
• Calibrating Water Valves
• Freeze-Stat Testing and Adjustment
• High Static Protection

CHI001

HVAC&R: CHILLERS – MECHANICAL COMPONENTS

This course describes basic chiller functions and operations. It describes preventative maintenance
commonly performed on the chiller systems. The compressor, condenser, evaporator, vapor compression
cycle, and the purge unit are discussed in detail.
Course objectives include:
• Learn the procedures for shutting down the chiller and equalizing pressures within the unit
• Clean the condenser tubes and check for blockage, examine the purge unit, change oil and refrigerant
filters, and change compressor oil
• Identify common problems, symptoms, and remedies.
Course menu:
► Chiller Components
• General Operation
• Preventative Maintenance
► Chiller Shutdown and Condenser Maintenance
• Chiller Shutdown Procedures
• Condenser Maintenance
► Servicing the Purge Unit and Compressor
• Servicing the Purge Unit
• Servicing the Compressor
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CHI002

HVAC&R: CHILLERS – LEAK CHECK & ELECTRICAL

This course continues preventative maintenance procedures, focusing on electrical systems, motor
maintenance, preparation for the leak check, and restarting the system. It describes the function of the
pneumatic damper control and describes chiller troubleshooting techniques.
Course objectives include:
► Test gages and switches in preparation for the leak check, service the starter panel, test the compressor
motor windings, and service the compressor motor
► Raise the pressure inside the chiller for the final leak check, perform the leak check, and trace and repair
refrigerant leaks.
Course menu:
► Leak Check and Electrical Testing
• Preparation for Leak Check
• Steps in Performing a Leak Check
• Electrical Testing Procedures
► Chiller Motor Maintenance and Final Leak Check
• Motor Maintenance Procedures
• Leak Detection and Repair

COL001

HVAC&R: COOLING TOWERS – MAINTENANCE &
TROUBLESHOOTING

This course describes basic cooling tower functions and operations, including the five elements considered in
efficient cooling tower operation — air flow, water flow, mechanical systems, structural integrity,
and water quality.
Course objectives include:
► Learn how cooling towers operate to remove heat from the air conditioning or refrigeration system
► Schedule preventative maintenance on a daily, weekly, and semi-annual basis, paying attention to each of
the five elements of cooling tower operation
► Identify common problems, symptoms, and remedies.
Course menu:
► Cooling Tower Principles
• Operations
• Evaporation
• Airflow Methods
► Cooling Tower Maintenance
• System and Structural Maintenance
• Scheduled Inspection and Maintenance
• Pumps, Pulleys, and Other Components
► Structure and Water Inspection
• Structural Checks
• Water Treatment
• Fouling and Scale Control
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CON001

HVAC&R: CONDENSERS – MAINTENANCE & TROUBLESHOOTING

This course describes basic condenser functions and operations, including the three most common types of
condensers — air-cooled, water-cooled, and evaporative. It outlines principles of preventative maintenance,
describes preventative maintenance commonly performed on the condensers, and identifies potential
problems associated with them.
Course objectives include:
► Learn how condensers operate to turn vaporized refrigerant into liquid for use in air conditioning and
refrigeration
► Schedule preventative maintenance for critical systems within the condensers, including refrigerant coils,
air and water flow, and mechanical systems such as pumps and fans
► Identify common problems, symptoms, and remedies.
Course menu:
► Condenser Operation and Maintenance
• Functions, Classifications, and Maintenance
► Troubleshooting
• Fan, Motor, and Airflow
► Cooling System Types
• Water-Cooled Systems
• Evaporative Condensers and Refrigerant Flow

HVA001

HVAC&R: COMPLETE SYSTEM TROUBLESHOOTING

This course describes basic heating and air conditioning principles and operations. It illustrates the major
components used in the vapor compression cycle.
Course objectives include:
► Describe how the vapor compression cycle operates and understand decisions that are made based on
the system’s operating environment
► Become familiar with the basic tools used in troubleshooting
► Perform a visual inspection of the system
► Isolate and troubleshoot HVAC system problems.
Course menu:
► Basic Principles
• General Operations
• Heat Pump, Air Handler, and Chiller Operations
► Operating Environments
• Normal Operating Conditions
• Measuring Environmental Conditions
► Troubleshooting Systems
• Isolating Failure
• Pressure Problems and Solutions
• Electrical System Check
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Clutches & Brakes 2-Part Series
CBR001

CLUTCHES & BRAKES: TYPES & APPLICATIONS

This course introduces and explains the different types of clutches and brakes and how they are used as power
transmission components in industry today.
Course objectives include:
► Describe the different types of mechanical clutches and brakes, their components, and operation
► Describe applications and troubleshooting procedures for mechanical clutches and brakes
► Describe pneumatic and hydraulic clutches and brakes, their components, and operation
► Describe pneumatic and hydraulic control systems
► Describe applications and troubleshooting procedures for pneumatic and hydraulic clutches and brakes
► Explain the purpose and operation of electrically controlled clutches and brakes
► Identify an electric control system.
Course menu:
► Mechanical Clutches and Brakes
• Types of Clutches
• Types of Brakes
• Application
► Pneumatic and Hydraulic System
• Pneumatic System
• Hydraulic System
• Application
► Electric Clutches and Brakes
• Types of Clutches
• Types of Brakes
• Application

CBR002

CLUTCHES & BRAKES: TROUBLESHOOTING

Course objectives include:
► Troubleshoot several problems in mechanical clutch and brake systems
► Troubleshoot several problems in pneumatic and hydraulic clutch and brake systems
► Troubleshoot several problems in electric clutch and brake systems.
Course menu:
► Troubleshooting Mechanical Clutches and Brakes
• Procedures to Use
• Clutches - Failures and Repair Procedures
• Brakes - Failures and Repair Procedures
► Troubleshooting Pneumatic and Hydraulic Systems
• Procedures to Use
• Pneumatic Systems - Failures and Repair Procedures
• Hydraulic Systems - Failures and Repair Procedures
► Troubleshooting Electric Clutches and Brakes
• Procedures to Use
• Components - Failures and Repair Procedures
• Clutches/Brakes - Failures and Repair Procedures
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Industrial Bearings 3-Part Series
BRG001

INDUSTRIAL BEARINGS: APPLICATION & TECHNOLOGY

A basic understanding of the application of bearings is critical to proper maintenance, installation, removal,
lubrication, and troubleshooting. This course will instruct students in the application of bearings and their
importance in the function of both simple and complex machines.
Course objectives include:
► Understand the definition of a bearing
► Understand the different types of bearings, including plain, ball, cylindrical, spherical, tapered, and needle
► Understand bearing wear and life expectancy
► Understand protective housings for bearings
► Explain the different types of loads.
Course menu:
► Types of Bearings
• Different Bearing Loads and Types
• Different Types of Rolling-Element Bearings
► Bearing Applications, Operations, and Materials
• Operational Components of Ball and Roller Bearings
• Materials Used for Bearings
► Bearing Wear
• Factors That Affect Bearing Wear
• Replacing a Bearing

BRG002

INDUSTRIAL BEARINGS: MAINTENANCE & INSTALLATION

Proper installation of bearings will increase their efficiency and length of service. Bearing life will also be
maximized with proper storage and handling.
Course objectives include:
► Learn the proper way to install and care for both plain and rolling-element bearings
► Identify the different types of fittings for installation
► Check proper operating clearances
► Understand the importance of proper bearing alignment.
Course menu:
► Storage and Handling
• Storage
• Handling
► Installation
• Fittings
• Rolling-Element Bearings
• Plain Bearings
• Oiler Rings
► Post-Installation
• Radial and Axial Clearances
• Preload, Self-Alignment, and Bearing Removal
► Lubrication and Operational Checks
• Bearing Lubrication and Equipment Checks
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BRG003

INDUSTRIAL BEARINGS: TROUBLESHOOTING

This course stresses the importance of accurate bearing troubleshooting for maximum efficiency and life
expectancy of rotating equipment. Troubleshooting is presented as not only an effective means of maintaining
an efficient work environment but also enhancing on-the-job safety and hours of production.
Course objectives include:
► Understand the various ways to identify potential problems and their sources
► Understand how to maintain a schedule of monitoring on four major areas of identification
► Explain the proper procedures for removing failed bearings
► Determine the reasons for failed bearings.
Course menu:
► Bearing Conditions
• Sources of Problems
• Failed Bearings
► Causes of Bearing Failure
• Metal Fatigue
• Pitting and Fretting Corrosion
• Heat and Rust
• Bearing Life

Industrial Drives 6-Part Series
CDP001

INDUSTRIAL DRIVES: COMPLETE DRIVE PACKAGES

Knowledge of the components and operation of directly coupled drive systems is critical to the success or
failure of industrial machinery. This course goes beyond the basics of drive packages to teach fundamentals,
components, troubleshooting, and more.
Course objectives include:
► Identify the components of a directly coupled drive system
► Understand the characteristics of operation unique to directly coupled drive systems
► Identify the components of jackshaft and auxiliary drive systems
► Explain the unique properties of jackshaft and auxiliary drive systems
► Explain the effects of changing input and output speeds on auxiliary and jackshaft drive systems
► Compute drive system efficiency
► Understand the principles of operation for spring operated, shear pin, and heat-actuated overload devices
► Learn troubleshooting strategies for drive packages.
Course menu:
► Directly-Coupled Drive Systems
• System Components
• System Characteristics
► Jackshaft and Auxiliary Drive Systems
• System Components
• System Characteristics
• Input and Output Speeds
► Drive System Efficiency and Protection
• Determining System Efficiency
• Overload Devices
► Troubleshooting Drive Packages
• Troubleshooting Strategies
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EDS001

INDUSTRIAL DRIVES: ENCLOSED DRIVE SYSTEMS

Drive systems are common to industry and are responsible for moving conveyors, sections of machines,
or complete machines. This course discusses the different types of enclosed gear drives and their major
components in order to build competence and confidence in this essential area. All aspects of enclosed
drive systems are covered, including adjustable speed drives, installation, maintenance, and troubleshooting
procedures.
Course objectives include:
► Understand the principles of operation and terminology used in enclosed drive systems
► Identify the components used in an enclosed gear drive
► Identify different gear types
► Understand applications for enclosed gear drives
► Identify the various types of adjustable speed enclosed drives
► Understand applications of an enclosed chain drive system
► Identify and describe the component parts and operation of an enclosed chain drive
► Install an enclosed drive
► Explain proper maintenance procedures
► Describe proper procedures when troubleshooting an enclosed drive system.
Course menu:
► Enclosed Gear Drives
• Fundamentals of Enclosed Gear Drives
• Gear Drive Components
• Types of Gears
• Applications of Enclosed Gear Drives
► Adjustable Speed Drives
• Types of Adjustable Speed Drives
• Components of Adjustable Speed Drives
► Enclosed Chain Drives
• Applications of Enclosed Chain Drives
• Components of Enclosed Chain Drives
► Installation, Maintenance, and Troubleshooting
• Installation
• Maintenance
• Troubleshooting

GGS001

INDUSTRIAL DRIVES: GEARS & GEAR SYSTEMS

Knowledge of gears and gear systems is critical in today’s mechanized world. This course was designed
specifically for maintenance technicians and engineers whose job requires comprehensive knowledge of gears
and gear-related topics. This course covers gear basics, installations, maintenance, and troubleshooting.
Course objectives include:
► Understand parallel and perpendicular shaft configurations
► Identify and describe the attributes of gears
► Understand gear considerations
► Calculate critical dimensions of gears
► Explain installation procedures specific to spur, helical, bevel, miter, and worm gearing
► Describe the types of wear associated with open gearing systems
► Explain the inspection procedures for spur, helical, bevel, miter, and worm gear sets
► Identify common symptoms and how to determine causes of failure
► Explain solutions for open gear systems
► Understand safety procedures with open gear systems.
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Course menu:
► Gear Types
• Gears for Parallel Shaft Configuration
• Gears with Right-Angle Shaft Configuration
► Gearing Basics
• Gear Tooth Geometry
• Interchange Considerations
• Computing Critical Dimensions
► Installation of Open Gearing
• Spur, Helical, Bevel, and Miter Gear Specifics
• Worm Gearing Specifics
• Common Procedures for the Installation of Open Gearing
► Maintenance and Troubleshooting of Open Gearing
• Common Types of Wear
• Periodic Inspection of Open Gearing
• Troubleshooting Open Gear Systems
• Safety Procedures for Open Gearing

MDR001

INDUSTRIAL DRIVES: BELT DRIVES

One of the industrial drive systems used to transmit mechanical power is the belt drive. This course begins
with the importance of belt drive safety and continues with construction materials used and functions of each
belt type. Sheaves and grooved pulleys are discussed and their integral importance to belt drive systems.
In addition, the course discusses ways to install and adjust new belt drive belts, the importance of general
maintenance, and how to diagnose potential problems.
Course objectives include:
► Identify common industrial belt drive systems
► Identify the different drive systems and discuss drive ratios
► Perform basic installation and maintenance procedures
► Troubleshoot some common belt drive system problems.
Course menu:
► Fundamentals
• Belt Drive Safety
• Belt Materials and Shapes
• V-Belts and V-Belt Construction
• Other Belt Configurations
• Determining Belt Size
► Belt Drive Equipment
• Sheaves/Pulleys
• Speed Ratios
► Belt Drive Replacement and Tensioning
• Installation Procedures
• Checking Belt Tension
► Belt Drive Maintenance and Troubleshooting
• General Maintenance

• Belt Drive Troubleshooting
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MDR002

INDUSTRIAL DRIVES: CHAIN DRIVES

This course presents the fundamentals of chain drive systems, including basic chain drive safety, major types
of chains, chain tension, and chain drive equipment. Additionally, chain removal, installation procedures, and
servicing the system are discussed. The course concludes with a look at maintenance and troubleshooting for
chain drives with special attention paid to lubrication systems.
Course objectives include:
► Perform basic chain drive installation and maintenance procedures
► Troubleshoot some common chain drive system problems.
Course menu:
► Fundamentals
• Chain Drive Safety
• Types of Chains
• Roller Chain and Roller Chain Types
• Other Chain Types
• Chain Tension
• Chain Drive Equipment
► Chain Drive Removal and Installation
• Removal Procedures
• Servicing and Installation Procedures
► Chain Drive Maintenance and Troubleshooting
• Chain Lubrication
• Chain Drive Troubleshooting

SJC001

INDUSTRIAL DRIVES: SHAFT JOINING & COUPLING DEVICES

In order for most power machinery to operate, power transmission from a driving shaft to a driven shaft is
necessary. This course not only discusses the principles and applications of shaft joining and coupling but
teaches important troubleshooting strategies and remedies.
Course objectives include:
► Identify different types of shaft joining and coupling devices
► Understand the operating principles governing shaft joining and coupling devices
► Identify critical application considerations when selecting a connecting device
► Differentiate between rigid, flexible, fluid couplings, and universal joints based upon construction,
purpose, and application
► Understand the safety precautions to follow when performing inspection, maintenance, and repairs
► Install and align mechanical couplings
► Maintain mechanical couplings
► Install, mount, align, test, and maintain a fluid coupling
► Recognize symptoms of and troubleshoot fluid couplings.
Course menu:
► Principles, Types, and Applications
• Operating Principles
• Types and Applications
► Mechanical Couplings
• Installation
• Maintenance
► Fluid Couplings
• Installation
• Maintenance and Troubleshooting
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Machinery Lubrication 3-Part Series
MLU001

MACHINERY LUBRICATION: LUBRICATING OIL – TYPES, PROPERTIES
& HANDLING

This course presents students with the properties and types of oil used for lubricants and explains methods for
applying lubrication. It also presents how to work safely with lubricants and how to store them properly.
Course objectives include:
► Understand the significance of proper lubrication
► Identify the types of oils used, their characteristics, and the various ways to apply lubricants
► Describe the centralized and portable methods for applying lubricants and various fittings that may be
necessary for proper lubrication
► Understand the guidelines for proper lubricant storage, both indoors and outdoors.
Course menu:
► Fundamentals of Lubricating Oil
• Properties of Oil
• Types of Oil
• Application Methods
► Lubrication Equipment
• Portable and Centralized Equipment
• Various Fittings, Vents, and Valves
► Handling and Storing Lubricants
• Handling Techniques
• Inside and Outside Oil Storage Areas

MLU002

MACHINERY LUBRICATION: LUBRICATING OIL – EQUIPMENT
& PROCEDURES

This course demonstrates how to properly dispense machinery oils using typical lubrication equipment and
fittings as well as perform the proper procedures for oiling crankcase, bearing, and gear machinery utilizing
circulating and once-through lubrication systems.
Course objectives include:
► Describe lubricant applications and standards
► Properly dispense machinery oils using lubrication equipment and fittings
► Describe the proper procedures for oiling with various lubrication systems.
Course menu:
► Lubricating Oil Applications
• Basic Types
• Torque, Hydraulic, Crankcase Oils
• Tool and Chiller Oils
• Safety Considerations
► Crankcase and Gear Systems
• Crankcase System Operation
• Crankcase Oil Change Intervals
• Gear System Operation
• Gear Oil Change Intervals
► Bearing, Circulating, Pressure Oil Systems
• Bearing System Operation
• Circulating and Pressure Systems Ops
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MLU003

MACHINERY LUBRICATION: LUBRICATING GREASES – TYPES,
APPLICATIONS & EQUIPMENT

Proper maintenance of grease-lubricated equipment requires specialized knowledge and procedures for the
purchase, handling, storage, transfer, and dispensing of all types of lubricating greases. This course describes
how to properly identify the main characteristics of various industrial greases and their properties.
Course objectives include:
► Describe the key grease properties and functions
► Identify grease types
► Use manual, powered, and automatic lubricators properly
► Understand safe procedures to handle, store, and dispense grease.
Course menu:
► Fundamentals of Lubricating Grease
• Characteristics of Grease
• Properties of Grease
► Types of Lubricating Grease
• Simple Thickeners
• Complex Thickeners
• Non-Soap Greases
► Lubricating Equipment and Methods of Greasing
• Manual and Automatic Lubricating Equipment
• Methods of Greasing
► Handling and Storing Grease
• Handling and Storing Techniques

Boiler Operation & Control 5-Part Series
BOI001

BOILER OPERATION & CONTROL: INTRODUCTION TO BOILERS –
AN OVERVIEW

This course teaches the functions of the components of the steam system, the feedwater system, as well as
the fuel and air systems. Students will also learn how components (such as pipes and tubes delivering the
steam) maximize heat energy and how this information can be used to determine the most efficient and
least costly means of using steam production in a work setting.
Course objectives include:
► Identify the terms associated with steam
► Identify the components of a steam system
► Describe the role and application the steam system plays in the function of a boiler system
► Identify the components of a feedwater system
► Describe the role and application the feedwater system plays in the function of a boiler system
► Identify the components of the fuel and air systems
► Describe the roles and applications the fuel and air systems play in the function of a boiler system
► Analyze conservation of heat energy by various components to maximize efficiency and minimize cost.
Course menu:
► Principles of Steam Production
• Applications of Steam Energy
• Terms Associated with Steam
► Functions of Boiler Systems
• Steam System
• Feedwater System
• Fuel and Air Systems

106

Maintenance Courseware
Descriptions
► Steam Production
• Components Maximizing Steam Production

BOI002

BOILER OPERATION & CONTROL: BOILER DESIGN
& CONSTRUCTION

This course teaches students about the different types of boilers. Students will also gain knowledge about the
functions of the watertube boiler components, to include the steam and water side of the boiler as well as the
fuel and air side.
Course objectives include:
► Identify the characteristics and uses of a firetube boiler
► Describe the function of a firetube boiler
► Recognize the advantages of a Scotch Marine boiler
► Describe the features and applications of a wetback Scotch Marine boiler and a dryback Scotch Marine
boiler
► Identify the characteristics and uses of a watertube boiler
► Describe the features and applications of the steam and waterside components of the watertube boiler
► Describe the features and applications of the fuel layer or fireside of the watertube boiler
► Analyze how the components of a watertube boiler function collectively.
Course menu:
► Basic Types of Boilers
• Firetube and Watertube Boilers
► Functions of Watertube Boiler Components
• Steam and Water Side of the Boiler
• Fuel and Air Side of the Boiler

BOI003

BOILER OPERATION & CONTROL: BOILER FEEDWATER & STEAM

This course teaches students the multiple ways to control boiler water and boiler water chemistry. In addition,
students will be exposed to the three basic approaches to feedwater control.
Course objectives include:
► Explain why feedwater must be treated before it enters a boiler
► Explain how chemical treatment is used to inhibit scale and corrosion in a boiler
► Explain how to minimize impurities in boiler water and why shrink and swell occur
► Identify components and their functions in a single-element feedwater control system, a two-element
control system, and a three-element control system
► Describe how a three-element control cascaded feedwater control system differs from other means of
controlling drum level.
Course menu:
► Corrosion and Scale on Boiler Components
• Effect of Corrosion and Scale
• How to Inhibit Corrosion and Scale
► Boiler’s Response to Steam Demand
• Impact of Shrink and Swell
► Three Basic Approaches to Feedwater Control
• Single-Element Control Systems
• Two-Element Control Systems
• Three-Element Control Systems
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BOI004

BOILER OPERATION & CONTROL: BOILER FUEL & AIR

This course teaches students about the different fuels used in boilers and the equipment that enables the use
of these fuels.
Course objectives include:
► Identify the three general groups of boiler fuels and the byproducts of each
► Identify the physical characteristics of liquid and gaseous fuels and how their heat values are an efficient
means for boiler systems
► Describe the operating characteristics of the systems and equipment used for burning fuels, to include
stoker, bunker, and hoppers
► Describe combustion control, to include the proper rate of combustion, maintaining the proper air-fuel
ratio, and responding to changes in steam demand.
Course menu:
► Three Types of Boiler Fuels
• Types, Characteristics, and Heat Values
► Factors Needed to Control Combustion
• Fuel and Air Systems, and Equipment
► Combustion Control Systems
• Premise of Combustion Control
• Methods of Combustion Control

BOI005

BOILER OPERATION & CONTROL: BOILER OPERATION

This course reviews the proper boiler startup and shutdown procedures as well as the basic operator’s
responsibilities. Students will be exposed to the abnormal and emergency conditions that can arise during
boiler operation.
Course objectives include:
► Identify the basic startup procedures for boiler system operation
► Describe the actions conducted in the pre-start check
► Describe the actions conducted in a system purge
► Describe the actions conducted during lightoff of the burners
► Recognize the consequences of the heatup phase
► Describe the actions conducted during initiating feedwater flow
► Explain the purpose of each of the steps to the shutdown procedure
► Identify the boiler operator’s responsibilities
► Recognize abnormal and emergency conditions that may arise during boiler operation.
Course menu:
► Boiler Startup Procedures
• Prestart Checks
• Purge
• Lightoff of the Burners
• Heatup Phase
• Initiating Feedwater Flow
► Boiler Operator’s Responsibilities
• Tasks Associated with Operating a Boiler
► Boiler Shutdown Procedures
• Purpose of Each Step
► Abnormal and Emergency Conditions
• Major Areas of Concern
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Centrifugal Pumps 5-Part Series
PUM001

CENTRIFUGAL PUMPS: DESIGN & FUNCTION

This course identifies centrifugal pumps in industry today. It distinguishes between centrifugal and positive
displacement pumps and describes the beneficial features and purposes of each. A further explanation of
pump components is provided in order to understand component differences and how they are used in
classifying pumps.
Course objectives include:
► Explain the differences between centrifugal and positive displacement pumps
► Describe the basic design of a centrifugal pump
► Classify centrifugal pumps according to staging, casing split, shaft coupling, suction position, and volute
► Identify and describe the functions of various centrifugal pump components
► Explain compression packing, lantern rings, and external lubrication in regard to a stuffing box
► Explain the purpose and function of mechanical seals.
Course menu:
► Pump Design and Function
• Centrifugal vs. Positive Displacement Pumps
• Centrifugal Pump Construction
• Classification of Centrifugal Pumps
► Centrifugal Pump Components
• Classification of Impellers
• Auxiliary Pump Components
• Pump Casings and Stuffing Boxes
• Mechanical Seals
• Bearings and Bedplates

PUM002

CENTRIFUGAL PUMPS: SYSTEM CHARACTERISTICS & SELECTION

This course provides a more in-depth knowledge of how a pump is chosen for a system based on the system
in which it will be operating. This course presents students with the terminology used in understanding
centrifugal pump performance in a system, including terms associated with head, pressure, suction, discharge,
and Net Positive Suction Head.
Course objectives include:
► Explain the system as it operates under normal parameters
► Describe how fluid flows through a centrifugal pump system
► Define terms associated with a centrifugal pump in a system
► Identify factors that affect the normal parameters surrounding pump performance in a system
► Apply system requirement concepts to the selection of an appropriate pump, including how to interpret
pump performance curves and Affinity Laws.
Course menu:
► System Characteristics
• System Overview
• Pressure and Head
• NPSH
• Pump Head
► Factors Affecting Pump Performance
• Cavitation and Recirculation
• Liquid Properties
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► Selection Criteria
• System Head Curves
• Pump Performance Curves
• Selecting a Pump

PUM003

CENTRIFUGAL PUMPS: OPERATION & MAINTENANCE

This course identifies normal and abnormal start-up and operating conditions of centrifugal pumps as well
as pump monitoring and shutdown procedures. By focusing on precautions, this course attempts to educate
in order to prevent injury and equipment damage. Demonstrating pump and component maintenance helps
students identify potential causes of pump failure.
Course objectives include:
► Explain the basics of operation and maintenance of centrifugal pumps
► Describe the proper start-up procedure for a centrifugal pump
► Identify the system components that require monitoring and adjusting during operation
► Recognize abnormal operating conditions and their probable causes
► Describe proper shutdown procedures.
Course menu:
► Operation
• Staring a Pump
• Start-up Procedures
► Monitoring a Pump
• Parameters to Check
• Securing a Centrifugal Pump
► Maintenance of Centrifugal Pumps
• Periodic Maintenance
• Maintenance of Packing Material
• Mechanical Seals
• Coupling Alignment and Vibration Monitoring

PUM004

CENTRIFUGAL PUMPS: TROUBLESHOOTING & DISASSEMBLY

This course covers the basics of troubleshooting, the disassembly of centrifugal pumps, and the safety
precautions that should be followed. This course will show students how to identify symptoms of failure, which
may indicate problems with various pump components. Students will learn the safe ways to prepare pumps for
inspection through disconnect, removal, and inspection of the various components.
Course objectives include:
► Explain the basics of pump troubleshooting
► Assess pump temperature and possible causes of high motor temperature, overheated packing, and
overheated bearings
► Identify signs of and causes for cavitation, vibration, and air entrainment
► Identify causes of low flow rate and low discharge pressure
► Describe the safety precautions to follow prior to working on a pump system
► Recognize procedures for isolating a pump, depressurizing a system, and draining and inspecting fluids
from a pump
► Describe the safe and correct steps to remove a pump casing, to remove the impeller, and to handle
pump packing, seals, and bearings
► Describe how to check the shaft, seals, packing, and impeller mounting areas
► Identify the location and consequences of pitting, erosion, and scoring in a pump.
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Course menu:
► Troubleshooting
• Areas to Troubleshoot
• Pump Removal
► Pump Disassembly
• Preparation for Disassembly of a Pump
• Removal of Components
• Inspection of Components

PUM005

CENTRIFUGAL PUMPS: REASSEMBLY & INSTALLATION

This course focuses on the reassembly, installation, and start-up of centrifugal pumps. It allows students
to view the progression of a pump reassembly, including the safety precautions. It covers inspection of
components and replacement parts, including mechanical seals and compression packing. Reassembly also
includes checking internal clearances, rigging, mounting, and alignment. Finally, precautions to take during
start-up, monitoring an operating pump, and adjustments to be made after start-up are discussed.
Course objectives include:
► Identify the necessary precautions to take during reassembly, installation, and start-up of a
centrifugal pump
► Describe proper inspection and installation of components
► Recognize the precautions and procedures for rigging a pump in place
► Identify soft foot and start-up valve alignment, post start-up checks, and compression
packing adjustments.
Course menu:
► Preparation for Reassembly
• Pump Preparation
• Bearing Installation
• Pump Shaft Assembly
► Final Steps of Pump Reassembly
• Mechanical Seals
• Compression Packing
• Completing Reassembly
► Pump Installation
• Preparation for Installation
• Mount and Alignment
• Pump Start-Up

Valve Basics 4-Part Series
F80010

VALVE BASICS: SHUTOFF VALVE DESIGNS & APPLICATION
CONSIDERATION

This course discusses the various types of shutoff valves, including plug, conventional butterfly, globe, piston,
pinch, check, ball, high-performance butterfly, gate, and diaphragm valves. Additionally, it covers the unique
aspects and application suitability of each.
Course objectives include:
► Explain the general characteristics, construction options, and application considerations of various
shutoff valves
► Identify the features and limitations of the various valve types
► Evaluate shutoff valve performance.
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Course menu:
► Types of Shutoff Valves
• Shutoff Valve Designs
• Basic Selection Considerations
► Quarter-Turn Valves and Applications
• Plug Valves
• Ball Valves
• Conventional Butterfly Valves
• High-Performance Butterfly Valves
► Multi-Turn Valves and Applications
• Globe Valves
• Piston Valves
• Gate Valves
► Other Shutoff Valves and Applications
• Pinch Valves
• Diaphragm Valves
• Check Valves

F80020

VALVE BASICS: SELECTING SHUTOFF VALVES

This course provides the foundation for a progressive understanding of the functions and limitations of various
types of shutoff valves.
Course objectives include:
► Understand the major considerations for selecting a shutoff valve type
► Identify pressure and temperature requirements
► Identify the unique valve requirements imposed by the nature of the controlled fluid
► Identify the features, limitations, and suitability of different valve styles
► Select an appropriate valve
► Select an appropriate means of operating the valve (handwheel, gear drive, power actuator, etc.).
Course menu:
► Basic Selection Criteria
• Process Considerations
• Valve Considerations
► Applications
• Typical Applications
► Shutoff Valve Accessories
• Manual Operators
• Power Actuator Types
• Controlling Devices

F80030

VALVE BASICS: INSTALLING SHUTOFF VALVES

This course provides basic guidelines for installing various types of shutoff valves.
Course objectives include:
► Explain good piping practices, including proper valve location and orientation in the pipeline
► Understand the importance of pipeline and valve supports
► Prevent line hammering
► Explain installation considerations for specific types of shutoff valves, including plug, ball, butterfly, globe,
gate, and check valves
► Properly install valves with screwed, flanged, and welded-end connections
► Describe actuator mounting and adjustment.
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Course menu:
► Installation Considerations
• Planning the Job
• Valve Considerations
► Valve Installation
• End Connections
• Stopping Leaks
• Actuator Considerations

F80040

VALVE BASICS: MAINTAINING SHUTOFF VALVES

This course gives students a fundamental understanding of the various valve constructions, basic maintenance
techniques, and the sources of many problems. From this foundation, students will be better able to develop
maintenance skills through plant training programs or on-the-job experiences. Valves discussed include ball,
lined butterfly, gate, globe, check, plug, high-performance butterfly, and flexing valves.
Course objectives include:
► Identify components and their functions for various valve types
► Explain routine preventive maintenance procedures for each valve type
► Explain common procedures involved in complete valve repair.
Course menu:
► Basic Maintenance Considerations
• Safety and Documentation
► Maintenance of Quarter-Turn Valves
• Plug Valves
• Ball Valves
► Maintenance of Butterfly Valves
• Lined Butterfly Valves
• High-Performance Butterfly Valves
► Maintenance of Multi-Turn Valves
• Gate Valves
• Globe Valves
► Maintenance of Flexing Valves
• Flexing Valves

•

Hydraulic Power Systems & Troubleshooting 2-Part Series
HPS001

HYDRAULIC POWER SYSTEMS & TROUBLESHOOTING:
IDENTIFICATION & OPERATION

Course objectives include:
► Describe the operation of basic hydraulic circuits
► Explain how load sensing and demand circuits operate
► Describe how intensification and hydrostatic circuits operate
► Discuss the operation of regenerative, prefill, and high-low circuits
► Explain the importance of using a print when working with hydraulic systems
► Describe the procedure for analyzing a complex hydraulic circuit
► Identify pressure, drain, and control lines in a hydraulic system
► Separate the various functions of a hydraulic circuit for closer analysis.
Course menu:
► Basic Hydraulic Circuits - I
• Open, Closed, and Series Circuits
• Load Sensing Circuits
• Demand Systems
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► Basic Hydraulic Circuits - II
• Intensification Circuits
• Hydrostatic Drive Systems
• Regenerative Circuits
• Pre-Fill Circuits
• High-Low Circuits
► Complex Circuits
• Using a Print
• Highlighting a Print
• Separating Different Functions
• Hydraulic System Design

HPS002

HYDRAULIC POWER SYSTEMS & TROUBLESHOOTING:
TROUBLESHOOTING TECHNIQUES

This course covers fundamentals of hydraulic circuits, including analysis of complex circuits. Students are
instructed in troubleshooting principles for hydraulic circuits and introduced to some common technical
procedures used in troubleshooting.
Course objectives include:
► Describe proper troubleshooting techniques
► Describe various kinds of modern hydraulic system test equipment
► Explain how to select proper test points in a circuit
► Describe repair procedures when troubleshooting and repairing a hydraulic system
► Troubleshoot problems that occur in hydraulic power systems, including lack of motion, poor motion, and
		 temperature and system malfunctions.
Course menu:
► Troubleshooting Basics
• Introduction
► Testing Tools and Repair Procedures
• Using Diagnostic Equipment
• Repair Procedures
► Troubleshooting Problems
• Problem One
• Problem Two
• Problem Three
• Problem Four

Hydraulics 7-Part Series
HDL001

HYDRAULICS: HARNESSING HYDRAULIC POWER

Knowledge of fluid characteristics will help students appreciate the power of fluid and understand how fluids
both exert pressure to support loads and flow to move loads.
Course objectives include:
► Identify the conditions that cause fluids to flow and exert pressure
► Explain Pascal’s law
► Describe the relationship between fluid pressure and fluid flow
► Identify factors that affect pressure level, flow rate, and fluid velocity in a hydraulic circuit.
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Course menu:
► Discovering Hydraulic Power
• Pascal’s Discovery
• Basic Hydraulic Concepts
► Hydraulic Fluid Flow
• Pump, Conductor, Actuator
• Flow Rate and Velocity
• Simple Hydraulic Circuit

HDL002

HYDRAULICS: THE HYDRAULIC CIRCUIT

This course teaches students the function and operation of various components and how they work together.
Course objectives include:
► Identify the components of a typical hydraulic circuit
► Describe the function of components found in a basic hydraulic circuit
► Explain the structure and operation of basic hydraulic components
► Identify graphic symbols used to represent basic hydraulic components.
Course menu:
► The Safe Hydraulic Circuit
• Why Systems are Unsafe
• Making a Circuit Safe
► Energy Transferring Components
• Pumps
• Actuators
► Fluid Control Components
• Directional Control Valves
• Flow Control Valves
• Pressure Relief Valves
• Filters
► Hydraulic Symbols
• Diagrams
• Pumps, Motors, Filters, Actuators
• Valves

HDL003

HYDRAULICS: PUMPS & ACTUATORS

This course teaches students the operation and function of pumps and actuators and their relationship within
the hydraulic system.
Course objectives include:
► Describe the basic structure and operation of balanced and unbalanced vane pumps, internal and external
gear pumps, and radial and axial piston pumps
► Identify methods of varying the displacement in vane pumps and radial and axial piston pumps
► Describe the basic structure and operation of various types of motors and rotary actuators
► Describe the basic structure and operation of various types of cylinder devices such as rod gland
bushings and seals, piston seals, air bleed passages, stroke adjusters, stop tubes, and cushions.
Course menu:
► Non-Positive Displacement Pumps
• Centrifugal Pumps
115

Maintenance Courseware
Descriptions
► Rotary Positive Displacement Pumps
• Vane Pumps
• External and Internal Gear Pumps
► Reciprocating Positive Displacement Pumps
• Radial Piston Pumps
• Axial Piston Pumps
► Delivery Rates
• Constant and Variable Displacement Pumps
• Pressure Compensated Vane Pumps
• Pressure Compensated Axial Piston Pumps
► Actuators
• Fluid Motors
• Rotary Actuators
• Linear Motion Actuators
• Seals and Cylinder Components

HDL004

HYDRAULICS: CONTROL VALVES

A single malfunctioning valve can make an entire system break down. This course teaches students how
various valves function and affect system operation.
Course objectives include:
► Describe the basic structure and operation of normally closed and normally open pressure control valves
► Describe the uses for relieve, unloading, sequence, counterbalance, brake, pressure-reducing valves, and
flow control valves
► Explain how pressure compensation enables a flow control valve to maintain a desired flow rate
regardless of pressure fluctuations
► Describe the function and basic operation of one-way, two-way, three-way, and four-way directional
control valves
► Identify methods of spool actuation for directional control valves.
Course menu:
► Pressure Control Valves
• Normally Open and Normally Closed Valves
• Directly Operated and Compound Valves
• Internal and External Operations
• Pressure Control Valves in a System
► Flow Control Valves
• Principles of Flow Control Valves
• Pressure Compensated Flow Control Valves
► Directional Control Valves
• One-Way and Two-Way
• Three- and Four-Way Valves
• Methods of Spool Positioning
► Control Valve Malfunction
• Modes of Failure
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HDL005

HYDRAULICS: HYDRAULIC FLUID

No matter how well a hydraulic system is designed, it will eventually malfunction if fluid is not maintained
properly. This course details the components that store, conduct, and maintain hydraulic fluid.
Course objectives include:
► Identify the characteristics that enable hydraulic fluid to perform required functions within a hydraulic
system
► Describe the function, structure, and basic operation of reservoirs and accumulators, various types of
conductors and fittings, hydraulic seals, and hydraulic filters
► Describe the structure and basic operation of various types of hydraulic heat exchangers.
Course menu:
► Hydraulic Fluid
• Fluid Properties
► Storing Hydraulic Fluid
• Reservoirs
• Accumulators
• Intensifiers
► Conducting Fluid
• Pipes and Tubes
• Hoses
• Conductor Specifications
► Seals
• Seals and Rings
• Seals and Compressions Packings
► Fluid Conditioning
• Wear Particles and Contaminants
• Filter Characteristics
• Filter Condition Indicators
• Cooling Fluid

HDL006

HYDRAULICS: HYDRAULIC SYSTEMS SAFETY & MAINTENANCE

Hydraulic systems, like other energy transfer systems, have inherent safety hazards. However, if workers are
aware of these dangers and understand how to lessen hazards, accidents can be prevented. In addition to
safety, this course focuses on maintenance and troubleshooting. Proper maintenance is one of the most
important and yet most overlooked requirements of a hydraulic system.
Course objectives include:
► Identify common hazards associated with the workplace
► Describe proper procedures for working with various hydraulic components
► List the safety rules that must be followed when operating or maintaining a hydraulic system
► Describe the factors that determine the intervals at which proactive maintenance tasks should be
performed
► Describe the inspections and tests that should be part of a preventative maintenance program.
Course menu:
► System Safety
• Pumps and Relief Valves
• Conductors and Fluid Leaks
• Fluid Condition
• Guards, Safety Circuits, and Emergency Stops
• Control Valves
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► Maintenance Practices
• Maintenance Systems
• Preventative Maintenance
• Predictive Maintenance
• Routine Tasks
► Fluid Maintenance
• Temperature and Appearance
• Eliminating Potential Contaminants
• Maintaining Clean Fluid
► Pump Maintenance
• Preventing Breakdowns
• Cavitation
• Other Pump Problems
► Hydraulic Component Maintenance
• Actuators
• Pressure, Flow, Directional Control Valve

HDL007

HYDRAULICS: HYDRAULIC SYSTEM TROUBLESHOOTING

Troubleshooting a hydraulic system requires a logical, ordered approach to selecting and performing tasks.
Understanding the troubleshooting process will provide students with the clearest diagnostic information,
allowing them to make the most informed decisions in locating and correcting malfunctions.
Course objectives include:
► Identify the factors that must be considered when evaluating the operation of a hydraulic system
► Describe the tasks that should be part of a systematic troubleshooting process
► Identify symptoms of several hydraulic components
► Identify possible causes of some common hydraulic component and system failures.
Course menu:
► Troubleshooting Procedures
• Overview
• System Evaluation
• Indentifying Symptoms
• Finding the Problem
► Inspecting the System
• Initial System Lookover
• Fluid Condition
• Component Checks
• Finding the Root Cause
► Troubleshooting Scenario
• Identifying the Malfunction
• Correcting the Malfunction
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Industrial Hydraulics 4-Part Series
IDH001

INDUSTRIAL HYDRAULICS: BASIC PRINCIPLES & APPLICATION

This course familiarizes students with the principles and components of industrial hydraulic systems.
Course objectives include:
► Understand the basic principles and components of hydraulic power systems
► Explain proper storage, handling, and maintenance procedures.
Course menu:
► Principles of Hydraulics
• Hydraulic Power and Pressure
• How Hydraulic Power Works
• Pressure Gages
► Hydraulic Power System
• Basic Components and Accessories
• Symbols
• Hydraulic Circuits
► Hydraulic Fluids
• Properties of Hydraulic Fluid
• Common Hydraulic Fluids
• Storage, Handling, and Maintenance

IDH002

INDUSTRIAL HYDRAULICS: TYPES & CONCEPTS

Course objectives include:
► Identify and explain hydraulic piping, fitting, and connections
► Understand hydraulic pumps
► Identify and explain hydraulic system and pump mechanisms
► Understand pressure control valves.
Course menu:
► Hydraulic Piping, Fittings, and Connections
• Piping Materials
• Piping Specifications
• Fittings and Connections
► Hydraulic Pumps
• Hydraulic Pumps - Introduction
• Gear Pumps
• Vane Pumps
• Piston Pumps
• Pump Servicing
► Hydraulic System and Pump Mechanisms
• Power Source
• Fluid Reservoirs
• Filters and Strainers
• Heat Exchangers
► Pressure Control Valves
• Relief Valves
• Holding Valves
• Sequence Valves
• Pressure-Reducing Valves
• Pressure Switches
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IDH003

INDUSTRIAL HYDRAULICS: FUNCTION & OPERATING PRINCIPLES

Course objectives include:
► Identify the types and functions of directional control valves and accumulators
► Identify the types of hydraulic cylinders
► Understand operating principles and applications of hydraulic motors
► Identify types, operating principles, and common uses of rotary actuators
► Explain maintenance and troubleshooting practices that apply to the entire hydraulic system.
Course menu:
► Control Valves and Accumulators
• Flow Control Valves
• Directional Control Valves
• Accumulators
► Actuators
• Introduction
• Hydraulic Cylinders
• Hydraulic Motors
• Rotary Actuators

IDH004

INDUSTRIAL HYDRAULICS: MAINTENANCE & TROUBLESHOOTING

Course objectives include:
► Perform reservoir, heat exchanger, and pump maintenance
► Understand maintenance safety
► Explain troubleshooting procedures for hydraulic systems.
Course menu:
► Maintenance and Safety of Hydraulic Systems
• Maintenance Practices
• Changing Hydraulic Fluid
• Reservoir Maintenance
• Heat Exchanger Maintenance
• Pump Maintenance
• Maintenance Safety
► Troubleshooting Hydraulic Systems
• Where to Start?
• Loss of System Pressure
• Actuator Malfunction
• Pump Malfunction
• Overheating
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Industrial Seals 3-Part Series
MPS001

INDUSTRIAL SEALS: TYPES, MATERIALS & PROPERTIES

This course presents the basics about various types of gaskets, packing, and seals as well as the materials
used to form them. Specific seals and applications covered include machinery seals, mechanical face seals, and
compression packings.
Course objectives include:
► Describe the main features of mechanical face and cartridge seals
► Describe the various compression packages used in rotating and reciprocating machinery
► Identify packing and gasket materials by style, composition, and application
► Identify the various styles and arrangements of mechanical face seals
► Ensure compatibility between common seal rings, packing and gasket materials, and process fluids.
Course menu:
► Types of Machinery Seals
• Static Seals
• Other Types of Seals
► Mechanical Face Seals
• Operation of Mechanical Face Seals
• Seal Arrangements
• Seal Types
► Compression Packing
• Operation
• Types of Compression Packing
• Materials Used to Make Packing

MPS002

INDUSTRIAL SEALS: GASKETS & PACKINGS – INSPECTION &
INSTALLATION

This course is an introduction to the principles of industrial gaskets and packings and the various procedures
for removing, inspecting, troubleshooting, and installing these seals in industrial machinery.
Course objectives include:
► Remove, cut, prepare, and install pipe joint gaskets
► Remove, prepare, and install machine compartment and cover gaskets
► Remove, inspect, and troubleshoot industrial packings
► Cut, prepare, and install packings on valves and pumps utilizing industrial materials
► Remove, inspect, and install lip-type compression packings.
Course menu:
► Removal, Inspection, Installation of Gaskets
• Joint Gaskets
• Machine Gaskets
► Removal, Inspection, Installation of Packings
• Packings Removal
• Installing Packings
► Removal, Inspection, Installation of Lip Packings
• Inspecting Lip-Type Packings
• U-Ring, Cup, and Flange Packings
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MPS003

INDUSTRIAL SEALS: MECHANICAL FACE SEALS –
TROUBLESHOOTING & INSTALLATION

This course is an introduction to the principles of mechanical face seals and the various procedures for
removing, inspecting, troubleshooting, and installing mechanical seals in industrial machinery.
Course objectives include:
► Identify the different types, configurations, and uses of mechanical face seals
► Remove and inspect mechanical face seals
► Troubleshoot the most common failure modes of mechanical face seals
► Prepare, assemble, and install typical mechanical face seals.
Course menu:
► Mechanical Face Seals Types and Life Expectancy
• Contacting and Non-Contacting Seals
• Indications of Short Seal Life
► Removal and Troubleshooting
• Removal and Inspection
• Troubleshooting Primary Seal Problems
• Troubleshooting Secondary Seal Problems
► Preparation and Installation of Face Seals
• Seal Installation
• Seal Inspection

Pneumatics 8-Part Series
PNM001

PNEUMATICS: THE POWER OF COMPRESSED AIR

Power transmission systems are found in equipment ranging from simple devices to complex industrial
machines. This course introduces pneumatics — the transfer, control, and use of energy contained in
compressed and flowing air. It provides a basic description of the characteristics of matter and describes the
relationship between pneumatic properties. In addition, it describes the factors that affect air flow and velocity
as well as the effects that temperature, water vapor, air saturation, and condensation have on a
pneumatic system.
The
►
►
►
►
►
►
►
►
►

course covers:
The characteristics of matter
Molecular level
Air
Properties of pneumatics
Specific volume, pressure, and temperature
Air flow
Factors affecting air flow
Air saturation
Condensation.

Course menu:
► Characteristics of Matter
• Molecular Level
• Air
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► Properties of Pneumatics
• Specific Volume, Pressure, Temperature
• Air Flow
• Factors Affecting Air Flow
• Air Saturation
• Condensation

PNM002

PNEUMATICS: THE PNEUMATIC CIRCUIT

A pneumatic circuit is a combination of components that work together to produce, control, and transmit
energy. This course introduces several of these energy transferring and air control components and the
symbols used to represent them.
The
►
►
►
►
►
►
►
►
►
►
►
►

course covers:
Energy transferring components
Compressors
Valves
Actuators
Air control components
Directional control valves
Flow control valves
Regulators
Tanks and filters
Pneumatic symbols
Communicating with pictures
Pumps, filters, and lubricators.

Course menu:
► Energy Transferring Components
• Compressor
• Actuators
► Air Control Components
• Directional Control Valves
• Flow Control Valves
• Regulators
• Tanks and Filters
► Pneumatic Symbols
• Communicating with Pictures
• Pumps, Filters, Lubricators
• Valves
• Actuators

PNM003

PNEUMATICS: PROCESSING AIR

This course introduces components that process air by compressing, storing, treating, and distributing air to
the actuator. Although sometimes overlooked, these components have a major impact on system operation.
The
►
►
►
►
►
►
►
►
►

course covers:
Compressors
Single-stage
Multi-stage and dynamic
Pressure and flow rate capacities
Sustaining compression
Air storage
Tank accessories
Air sustaining components
Branch and loop systems.

123

Maintenance Courseware
Descriptions
Course menu:
► Compressors
• Single Stage
• Multistage and Dynamic
• Pressure and Flow Rate Capacities
► Sustaining Compression
• Air Storage
• Tank Accessories
► Air Distribution Components
• Branch and Loop Systems
• Water Removal
• Filters
• Lubricators
• Releasing Air

PNM004

PNEUMATICS: USING COMPRESSED AIR

No matter what type of system is used to transfer power, the result is either linear or rotary mechanical motion.
Although linkages can produce complex motion patterns, the origin of the motion is always one of these two
types. This course focuses on the pneumatic components that produce motion.
The
►
►
►
►
►
►
►
►
►
►

course covers:
Linear actuators
Cylinders
Theory of operation
Cylinder accessories
Seals
Nonlinear actuators
Rotary actuators
Air motors
Torque
Nozzles and orifices.

Course menu:
► Linear Actuators
• Cylinders
• Theory of Operation
• Cylinder Accessories
• Seals
► Non-Linear Actuators
• Rotary Actuators
• Air Motors
• Torque
• Nozzles and Orifices
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PNM005

PNEUMATICS: PNEUMATIC CONTROL VALVES

To be effective, actuators must move loads in the proper sequence, at the correct time, and at the desired
speed. In pneumatic systems, this type of control is accomplished through the use of valves that control the
direction of air flow, regulate actuator speed, and respond to changes in air pressure. This course focuses on
pneumatic control valves.
The
►
►
►
►
►
►
►
►
►

course covers:
Directional control valves
One- and two-way valves
Three- and four-way valves
Methods of actuation
Flow control valves
Exhaust valves and air fuses
Simple and specialized regulators
Valve performance
Selecting valves.

Course menu:
► Directional Control Valves
• One- and Two-Way
• Three-Way Valve
• Four-Way Valve
• Methods of Actuation
► Flow Control Valves
• Simple Flow Control Valve
• Exhaust Valves and Air Fuses
► Regulators
• Simple Regulator
• Specialized Regulators
► Valve Performance
• Selecting Valves

PNM006

PNEUMATICS: WORKING SAFELY WITH PNEUMATIC SYSTEMS

This course describes the safety hazards associated with pneumatic systems. It also covers the safety rules
that should be followed when working with individual pneumatic components.
The
►
►
►
►
►
►
►
►
►

course covers:
Pneumatic system safety
Common hazards and remedies
Working with air tools
Oil and water
Safe installation and operation
Compressors, tanks, and actuators
Control valves
Air treatment devices
General safety procedures.

Course menu:
► Pneumatic System Safety
• Common Hazards and Remedies
• Working with Air Tools
• Oil and Water

125

Maintenance Courseware
Descriptions
► Safe Installation and Operation
• Compressor, Tank, Actuators
• Control Valves
• Air Treatment Devices
• General Safety Procedures

PNM007

PNEUMATICS: PNEUMATIC SYSTEM MAINTENANCE

This course explains the importance of a pro-active maintenance program for pneumatic systems. It describes
the major categories of tasks that should be part of a preventative maintenance program and identifies some
specific tasks that should be performed during routine maintenance.
The
►
►
►
►
►
►
►
►
►
►
►
►

course covers:
Pro-active maintenance
Types of maintenance systems
Inspection
Valves and conductors
Checking alignment
System cleanliness
Servicing
Preparing for servicing
Air treatment components
Final maintenance tasks
Testing
Reconditioning and scheduling.

Course menu:
► Maintenance Systems
• Types of Maintenance Systems
• Proactive Maintenance
► Inspection
• Valves and Conductors
• Checking Alignment
• System Cleanliness
► Servicing
• Preparing for Servicing
• Air Treatment Components
► Final Maintenance Tasks
• Testing
• Reconditioning and Scheduling

PNM008

PNEUMATICS: TROUBLESHOOTING PNEUMATIC SYSTEMS

This course explores the concept of troubleshooting and covers one systematic approach to identifying
problems and determining their causes. The course also examines the various root causes of bearing failure,
including over-lubrication, contamination, and misalignment.
The
►
►
►
►
►
►

course covers:
The four indicators for determining bearing condition
Temperature
Noise and vibration
Seals
Lubrication
Removing and inspecting failed bearings
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►
►
►
►
►
►
►
►
►

Causes of premature failure
Pitting and spalling
Electrostatic pitting
True brinelling
Fretting corrosion
Heat damage
Frictional bearing wear
Rust or corrosion
Equipment adjustment.

Course menu:
► System Evaluation
• Troubleshooting or Repairing
• Preparing for System Evaluation
► Isolating the Malfunction
• Putting Tasks in Order
• Visual Inspection and Testing
► Determining the Cause of the Malfunction
• Common Causes

Steam Traps 3-Part Series
MSM001

STEAM TRAPS: TYPES, PRINCIPLES & FUNCTIONS

This course is designed to provide a basic knowledge of steam and its production and condensate recovery
with steam traps. It discusses components of steam trapping that operate under thermostatic, thermodynamic,
and mechanical principles and includes orifices as a way of preventing excessive steam loss.
Course objectives include:
► Identify steam states, including steam quality
► Describe the effects of condensate and entrained water in a steam system
► List the primary functions of a steam trap
► Explain orifices in a steam trapping system
► Explain the operating principles of thermostatic, mechanical, and thermodynamic steam traps.
Course menu:
► Principles of Steam Energy Systems
• Heat Production and Transfer
• Steam States and System Function
► Thermostatic and Mechanical Steam Traps
• Thermostatic Steam Traps
• Mechanical Steam Traps
► Thermodynamic Steam Traps
• Orifice and Disc Steam Traps
• Variable-Piston and Lever Steam Traps
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MSM002

STEAM TRAPS: SIZING, INSTALLATION & MONITORING

This course discusses steam system basics as well as the factors and conditions of a system that affect trap
size. It presents general piping configurations and ways of eliminating adverse conditions, including water
hammer. Finally, methods for monitoring trap operations are covered.
Course objectives include:
► Define live, dry, quality, wet, and flash steam
► Identify the factors used to determine steam trap size
► Describe causes of water hammer and how to eliminate it
► Identify five methods of monitoring steam trap operation and the advantages and disadvantages of each
► Describe steam trap safety precautions.
Course menu:
► Steam Trap Sizing Fundamentals
• System Basics
• Selecting the Correct Size Steam Trap
► Installing Steam Traps
• Installation Basics
► Steam Trap Monitoring and Inspection
• Visual Inspection
• Temperature and Pressure Readings
• Analyzing Operating Sounds
• Ultrasonic Testing
• Electronic Sensor Measurement

MSM003

STEAM TRAPS: DIAGNOSTICS & TROUBLESHOOTING

In this course, analyzing systems and understanding adverse conditions provide a starting point for
diagnostics. Troubleshooting is fully explained for orifice trapping systems and the different types of
thermodynamic, thermostatic, and mechanical steam traps.
Course objectives include:
► Identify steam trap areas that are responsible for significant energy loss in steam systems
► Identify how losses occur and how to avoid loss
► Describe what components and areas of the steam system are vulnerable to corrosion, erosion,
and water hammer
► Recognize and describe the function of a steam trap testing station
► Recognize components to check when diagnosing failed steam traps within a steam system
► Recognize the causes of and best methods for determining malfunctions in orifice trapping,
thermodynamic, thermostatic, and mechanical steam trapping.
Course menu:
► Diagnosing General Steam Trap Problems
• Diagnostic Basics
• Corrosion, Erosion, and Water Hammer
• Cold and Hot Trap Problems
► Troubleshooting Specific Steam Traps
• Thermodynamic Traps
• Thermostatic Traps
• Mechanical Traps
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Pipefitting 11-Part Series
PFT001

PIPEFITTING: INTRODUCTION TO PIPEFITTING

This course gives students an overview of the knowledge and skills required of a pipefitter as well as safety in
the trade.
Course menu:
► Introduction to Pipefitting
• Quick Definition of Basic Pipefitting
• Overall Safety in the Pipefitting Trade
• Detailed Summary of 10 Modules

PFT002

PIPEFITTING: PIPING SYSTEMS AND STANDARDS

This course covers the three most common piping systems in use today as well as relevant industrial standards.
Course objectives include:
► Exercise proper safety precautions when working with piping systems
► Evaluate the factors that control a piping system’s material, size, and necessary strength
► Apply the standard pipe measuring protocol developed by The American National Standards Institute
(ANSI)
► Compare the most common plastic piping systems and their behaviors
► Assess the advantages of fiberglass piping systems.
Course menu:
► Piping Systems
• Safety Precautions
• History of Pipes
• ANSI Standards
• Plastic and Fiberglass Pipes

PFT003

PIPEFITTING: PIPE FITTINGS AND JOINTS

This course covers piping system joints, their fittings, and fitting installation.
Course objectives include:
► Exercise proper safety precautions when installing fittings
► Rate the differences between elbow, tee, wye, cross, coupling, and reducer fittings
► Apply correct fitting naming conventions
► Assess the advantages of thread-o-lets, weld-o-lets, and sock-o-lets
► Create threaded, flanged, welded, soldered, and compression joints
► Determine the advantages and disadvantages of each joint type.
Course menu:
► Pipe Fittings and Joints
• Safety Precautions
• Common Pipe Fittings
• Types of Piping Joints
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PFT004

PIPEFITTING: MEASURING PIPE AND DRAWINGS

In this course, students will learn to measure pipe according to industry standards. Basic piping system
drawings are also illustrated and explained.
Course objectives include:
► Exercise proper pipefitting safety procedures
► Apply the standard abbreviations for recording pipe measurements
► Calculate fitting take-off
► Apply plan view drawings, elevation view drawings, and detail drawings.
Course menu:
► Measuring Pipe and Drawings
• Safety Precautions
• Definitions and Methods
• Piping Drawings

PFT005

PIPEFITTING: OFFSETS

This course teaches students to plan and construct piping offsets.
Course objectives include:
► Exercise proper pipefitting safety procedures
► Gauge how fittings increase friction in a piping run
► Calculate the travel length of a simple offset and a rolling offset using formulas and shortcuts.
Course menu:
► Piping Offsets
• Safety Precautions
• Simple Offsets
• Rolling Offsets

PFT006

PIPEFITTING: MANUAL & ELECTRIC THREADED PIPE

In this course, students will learn to thread pipe manually and with an electric pipe-threading machine.
Course objectives include:
► Exercise pipe-threading safety procedures
► Operate pipe-threading tools, including a pipe cutter, reamer, die handle, die head, oiler, tripod chain vise,
and pipe stand
► Thread pipe manually
► Thread pipe using an electric pipe-threading machine.
Course menu:
► Manual and Electric Threaded Pipe
• Safety Precautions
• Manual Threading
• Electric Threading
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PFT007

PIPEFITTING: FLANGED PIPE

This course covers the use and creation of various flanges and gaskets.
Course objectives include:
► Exercise proper pipefitting safety procedures
► Apply flat- and raised-face flanges
► Compare the types of welded steel flanges
► Classify welded steel flanges by their pressure ratings
► Install a threaded flange
► Select a gasket material
► Create a gasket
► Install a gasket
► Compare the three most common fasteners used to secure flange joints
► Compare the types of pipe hangers and supports.
Course menu:
► Flanged Piping
• Safety Precautions
• Types of Flanges
• Gaskets and Threaded Flanges
• Flange Fasteners, Pipe Support and Hangers

PFT008

PIPEFITTING: PLASTIC PIPE

This course covers PVC, CPVC, PP, and fiberglass-reinforced piping.
Course objectives include:
► Exercise proper pipefitting safety procedures
► Compare the types of plastic piping and assess the advantages and disadvantages of each
► Install, maintain, and troubleshoot plastic and fiberglass-reinforced piping.
Course menu:
► Plastic Piping
• Safety Precautions
• Applications
• Thermoplastics
• Thermosetting Plastics
• Installation

PFT009

PIPEFITTING: ACCESSORIES AND SPECIALTY EQUIPMENT

In this course, students will learn about the selection, installation, and maintenance of various piping materials.
Course objectives include:
► Exercise proper pipefitting safety procedures
► Apply expansion, flexible, and rotating joints
► Apply hangers, supports, steam traps, strainers, and filters.
Course menu:
► Piping Materials
• Safety Precautions
• Hangers and Supports
• Strainer Types and Applications
• Expansion and Flexible Joints
• Steam Traps
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PFT010

PIPEFITTING: TUBING

This course introduces students to tubing, its uses, and the different tools, materials, and fittings it requires.
Course objectives include:
► Exercise proper pipefitting safety procedures
► Measure tubing
► Apply rigid and flexible tubing
► Maintain and troubleshoot tubing systems.

PFT011

PIPEFITTING: HOSES

This course teaches students about the different hoses used in piping systems.
Course objectives include:
► Exercise proper pipe fitting safety procedures
► Select a hose based on fluid medium and temperature as well as system operating pressure
► Assemble, install, test, and inspect hose fittings.

Operator Training Curriculum (9 Training Hours)
Includes:
• Operator Inspection 9-Part Series

Operator Inspection 9-Part Series
INS001

OPERATOR INSPECTION: PNEUMATIC SYSTEM INSPECTION

This course teaches students the basic inspection procedures for pneumatic systems and their components. It
is designed to introduce the basics of pneumatic pressure, including the properties of air, the basic operation
and components of the pneumatic system, and establishing general inspection points for
pneumatic components.
Course objectives include:
► Understand the basic characteristics of air, including pressure, flow, and volume
► Explain how external conditions can affect air
► Identify the operating principles of pneumatic systems, including Pascal’s Law
► Identify the components and function of the air compression system
► Understand the general safety procedures for operating a pneumatic system
► Differentiate between suction pressure and discharge pressure
► Describe the three-step process for establishing the general inspection components and inspection points
of the pneumatic system.
Course menu:
► Pneumatic Pressure
• Basic Knowledge of Air
• Characteristics of Air
► Pneumatic System
• Basics of a Pneumatic System
• Components in a Pneumatic System
• General Safety Procedures
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► General Pneumatic Inspection
• Establishment of General Inspection Components
• Safety Lockout Valve
• Filter
• Regulator and Lubricator
• Pipes and Joints
• Directional and Flow Control Valves
• The Actuator

INS002

OPERATOR INSPECTION: VACUUM SYSTEM INSPECTION

This course teaches students the basic inspection procedures for vacuum systems and their components. It is
designed to introduce the basic concept and operation of a vacuum system, to include defining the function
and operation of a negative air pressure system and how regulating and maintaining those pressures are
important to a sub-system.
Course objectives include:
► Understand the general safety precautions to take when working with a vacuum system
► Identify the general inspection components of a vacuum system
► Describe the purpose and function, general inspection points, and procedures for inspecting: surge tanks,
filters, gages, vacuum regulators, pipes and pipes’ joints, flow and directional control valves, suction cups,
suctionplates, and plastic tubing.
Course menu:
► Safety and General Inspection Components
• Vacuum Systems
• General Safety Precautions
• General Inspection Components
► Surge Tank, Filter, Regulators, and Gauges
• Surge Tank, Filter, and Vacuum Gauge
• Vacuum Regulators and Pressure Gauge
► Pipes, Joints, and Control Valves
• Pipes and Pipe Joints
• Flow and Directional Control Valves
► Suction Cups and Other Components
• Suction Cups and Other Components

INS003

OPERATOR INSPECTION: AIR COMPRESSION SYSTEM INSPECTION

This course teaches students the basic inspection procedures for air compression systems and their
components.

Course objectives include:
► Understand the general safety precautions to take when working with an air compression system
► Identify the general inspection components of an air compression system
► Describe the purpose and function, general inspection points, and procedures for inspecting: air
compressors, pressure and temperature gages, pipes and pipes’ joints, after-coolers, coalescing filters,
compressed air dryers, dew point analyzers, and air receivers.
Course menu:
► Air Compressor
• Inspection of Suction Filter
• Overall Compressor Inspection
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► Compressed Air After-Cooler
• Inspection Points
• Water Cooled Compressed Air After-Cooler
► Coalescing Filter
• Coalescing Filter
► Compressed Air Dryer and Air Receiver
• Compressed Air Dryer
• Compressed Air Receiver

INS004

OPERATOR INSPECTION: FASTENERS & EQUIPMENT STRUCTURE
INSPECTION

Course objectives include:
► Identify the various types of bolts and fasteners
► Describe the inspection procedures for bolts and fasteners
► Describe basic equipment structure
► Identify the general inspection procedures for equipment structure.
Course menu:
► Basic Knowledge of Fasteners
• Fastener Types and Their Uses
► General Knowledge of Fastener Types
• Bolts
• Nuts
• Screws
► General Inspection of Bolting Parts
• Washers
• Pins
• Keys
• Rivets
• Retaining Rings
• Principle of Clamping Force
• Tool Safety
► General Inspection of Screw Parts
• Departments, and Components and Sites
• Undersized Bolts in Holes
• Rust on Bolts, Nuts, and Screws
• Damage, Wearing of Nuts, Bolts, and Screws
• Presence of Washers
• Condition of Locking Parts
• Condition of Screw Threads and Length
• Loose and Defective Screws
► General Inspection of Equipment Structure
• Basic Knowledge of Equipment Structure
• Inspection Subjects of Equipment Structure
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INS005

OPERATOR INSPECTION: ELECTRICAL EQUIPMENT CONTROL
SYSTEM INSPECTION

Course objectives include:
► Understand electricity and control system basics
► Identify inspection procedures for equipment main switches, control panels, and external wiring
► Identify general inspection procedures for junction boxes, electrical motors, and detectors.
Course menu:
► Basic Knowledge of Electricity
• Understanding Electricity
• Basic Knowledge of Electrical Circuits
• Basic Knowledge of Electrical Awareness and Safety
• Basic Knowledge of Electrical Supply Systems
• Basic Knowledge of Control Systems
► General Inspection - Part I
• Establishment of General Inspection Sites
• Substation
• Power Distribution Panel
• Motor Control Center
• Equipment Disconnect Switch
► General Inspection - Part II
• Control Panel and Operational Panel
• Electrical Wire Way
• Electrical Motor
• Sensor
• Electrical Actuator

INS006

OPERATOR INSPECTION: MOTOR DRIVE SYSTEM INSPECTION

Course objectives include:
► Identify and describe the types and function of drive units
► Describe the inspection of three-phase AC induction motors
► Describe the inspection of step motors
► Describe the inspection of bearings, shafts, and couplings.
Course menu:
► General Inspection of Drive Systems
• Basic Knowledge of Drives
• General Inspection of Three-Phase Induction Motors
• General Inspection of Step Motors
► General Inspection of Shafts and Bearings
• General Inspection of Shafts
• General Inspection of Bearings
► General Inspection of Keys and Couplings
• Basic Knowledge of Keys
• General Inspection of Keys
• Basic Knowledge of Shaft Couplings
• General Inspection of Shaft Couplings
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INS007

OPERATOR INSPECTION: BELT DRIVE, CHAIN DRIVE
& GEAR BOX INSPECTION

Course objectives include:
► Identify and describe the types and functions of belts and gears
► Describe the inspection procedures of belt and chain transmission parts and units
► Explain methods for inspecting gears.
Course menu:
► General Inspection of Belts and Chains
• General Inspection of Belt Transmissions
• General Inspection of Chain Transmissions
► General Inspection of Gears and Gear Boxes
• Basic Knowledge of Gears
• General Inspection of Gears
• General Inspection of Transmissions

INS008

OPERATOR INSPECTION: CLUTCHES & BRAKE INSPECTION

Course objectives include:
► Identify and describe the types and functions of clutches and brakes
► Identify and describe the types and functions of cams and guide surfaces
► Describe the inspection procedures of clutches and brakes
► Describe the inspection procedures of cams and guide surfaces.
Course menu:
► Clutches and Brakes
• General Inspection of Clutches
• General Inspection of Brakes
► Cams
• Basic Knowledge of Cams
• General Inspection of Cams
► Guide Surfaces
• Basic Knowledge of Guide Surfaces
• General Inspection of Guide Surfaces

INS009

OPERATOR INSPECTION: LUBRICATION SYSTEM INSPECTION

Course objectives include:
► Identify the types of lubrication oils
► Inspect grease packs, pumps, distribution valves, pipes, joints, and bearings
► Inspect suction filters, pump units, and pressure and check valves
► Inspect lubrication parts.
Course menu:
► Basic Knowledge of Lubrication
• What is Lubrication?
• Types and Roles of Lubricating Oils
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► Oil Lubrication System Inspection
• Types of Lubrication Methods
• Lubrication Oil
• Recirculating System Oil Tank
• Recirculating System Suction Filter
• Pump Unit
• Pressure Control and Check Valves
• Distribution Valve and Lubricated Components
► Grease Lubrication System Inspection
• Basic Knowledge of Grease Lubrication
• Grease
• Grease Gun
• Pump Unit
• Distribution Valve
• Pipe and Joint Sections and Lubrication Points

Predictive Maintenance Curriculum (17 Training Hours)
Includes:
• Machinery Oil Analysis 3-Part Series
• Thermography 3-Part Series
• Ultrasonics 3-Part Series
• Advanced Vibration: AC Induction Motors 2-Part Series
• Vibration Analysis 6-Part Series

Machinery Oil Analysis 3-Part Series
OIL001

MACHINERY OIL ANALYSIS: FUNDAMENTALS & METHODS

This course introduces the oil analysis student to the fundamentals of machinery lubrication. The relationships
between component motion, lubrication methods, lubricant properties, and additives are presented to build an
understanding of how machinery is lubricated. The various lubricant failure modes and indicating symptoms
are introduced to help students understand how lubricant degradation and contamination affect machine
reliability. The presentation culminates in a discussion on oil quality and reliability management through the
use of oil performance and condition monitoring.
Course objectives include:
► Understand the principles of machinery lubrication
► Identify the main functions and properties of a lubricating oil
► List the critical oil-related machinery failure modes
► Understand the objectives and concepts of machinery oil analysis
► Use oil analysis in a condition-based maintenance program.
Course menu:
► Lubrication Fundamentals
• Functions of Oil
• Thin Film Lubrication
• Viscosity
• Lubricant Additives
• Methods of Lubricant Application
► Critical Oil Failure Modes
• Contamination
• Oil Degradation
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► Analysis Objectives and Concepts
• Sample Taking Principles
• Test Data Interpretation Concepts

OIL002

MACHINERY OIL ANALYSIS: STRATEGIES, OPTIONS & TESTING

This course is designed to familiarize students with the strategies, objectives, and techniques of an oil analysis
program. In particular, the concept of sampling and testing at a sufficient frequency to reliably monitor the
early symptoms of the critical oil failure modes is introduced. The lesson explains the relationship between the
common failure modes and the oil tests which are utilized to generate condition indicators. The presentation
concludes with the requirements necessary to develop a reliable machinery oil analysis program.
Course objectives include:
► Understand the characteristics and capabilities of the various oil test methods and where to use them
► Explain the relationships between equipment and lubricant failure modes
► List respective indicating symptoms and appropriate oil tests
► Describe the correct procedure for establishing the sample interval and taking an oil sample
► Understand the requirements for implementing a condition-based oil monitoring program.
Course menu:
► Failure Modes, Effects, and Criticality Analysis
• Testing Strategies
• Oil Contamination
• Oil Degradation/Oxidation
► Equipment Sampling Procedures
• Establishing Optimum Sample Interval
• Taking a Good Oil Sample
► Start-up and Testing
• Oil Condition Monitoring Tests
• Oil Performance Monitoring Tests
• Establishing an Oil Analysis Program

OIL003

MACHINERY OIL ANALYSIS: ESTABLISHING AN EFFECTIVE
PROGRAM

This course is designed to teach students how oil analysis is utilized in a variety of machinery applications.
More specifically, it presents the use of a statistically based data trending procedure to detect oil condition
indicators — the precursors of machine failure. The lesson includes instruction on selecting machines for oil
monitoring, establishing a proper sample interval, selecting appropriate tests for each machine class, taking
samples correctly from pressure and splash type lubrication systems, establishing alarm limits for performance
and condition data, and interpreting test data in conjunction with other operational data.
Course objectives include:
► Understand a step-by-step procedure for using machinery oil analysis to provide an early indication of
problems within mechanical systems
► Explain the proper selection of machines and tests
► Describe proper sampling techniques
► Explain the procedures for reducing and interpreting oil performance and trend data
► Identify the various problems and solutions associated with maintenance of data integrity
► Understand the concepts utilized for data management and automation in the context of condition-based
and reliability-centered maintenance.
Course menu:
► Selecting Machines
• Performance and Condition Monitoring
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• Oil Sampling
► Data Interpretation Procedure
• Establishing Alarm Limits
• Alarms, Fault Library, Recommendations
► Maintaining Program Integrity
• Data Management
• Oil Analysis Quality

Thermography 3-Part Series
THM001

THERMOGRAPHY: BASIC OPERATION

This course introduces students to the principles of heat. Conduction, convection, and radiation are presented
to build an understanding of how heat is transferred. Emittance, reflectance, and transmittance are introduced
to help students understand the different types of infrared radiation. Also discussed is how each infrared
property affects the readings taken by the thermal imager.
Course objectives include:
► Understand what infrared energy is, how it behaves, and how it can be used in a predictive maintenance
program
► Identify the different types of heat transfer
► Understand the principles of thermography
► Identify the equipment used to record thermographic images
► Explain the basic considerations for taking thermographic measurements.
Course menu:
► Principles of Heat Transfer
• Electromagnetic Radiation
• Conduction, Convection, Radiation
► Surface Properties
• Radiosity
• Emissivity, Reflectivity, Transmissivity
• Thermographic Measurements
► Instruments and Measurements
• Pyrometer and Thermal Imager
• Surface and Medium Considerations
• Hardware and Software Selection

THM002

THERMOGRAPHY: OPERATING PROCEDURES & IMPLEMENTATION

This course discusses the steps necessary to develop an in-house predictive maintenance program with the
use of thermal imaging equipment. Thermal behavior is introduced as well as interpreting thermal images
with respect to the material’s properties. The course also explains how to choose the proper thermography
equipment.
Course objectives include:
► Identify the characteristics and capabilities of thermal imagers
► List the basic steps for conducting a condition-based infrared monitoring program
► Describe the correct procedures for working with infrared imaging equipment
► Explain the thermal behavior of target materials
► Understand the questions to ask when choosing thermographic equipment.
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Course menu:
► Infrared Sensing Equipment
• Qualitative and Quantitative Instruments
• Apparent Temperature Changes
• Real Temperature Changes
► Predictive Maintenance Program
• Deciding What to Inspect
• Establishing and Planning Inspection Routes
• Data Review and Equipment Check
• Performing the Inspection
► Choosing Thermography Equipment
• Range and Sensitivity Considerations
• Portability and Storage Considerations

THM003

THERMOGRAPHY: PRACTICAL APPLICATIONS

This course discusses the use of thermography to detect problems within general mechanical and electrical
systems using a thermal signature. More specifically, it presents the use of thermography in detecting
mechanical failure in motors, generators, and other machinery consisting of rotating parts. The thermal imager
is used to demonstrate how to maximize energy efficiency and detect structural damage such as roof leaks.
Course objectives include:
► Understand how thermography is utilized in a variety of applications
► List the various causes of electrical problems that can be identified with thermography
► Describe the uses of thermography in condition-based monitoring of machinery, furnaces, and boiler
systems
► Explain how thermography enables technicians to locate and evaluate problems related to energy
efficiency and building structure.
Course menu:
► Electrical Applications
• Common Electrical Problems
• Evaluating Findings
► Mechanical Applications
• Machinery
• Piping Systems
• Insulation and Refractory Materials
► Energy Efficiency Applications
• Steps for Conducting an Energy Audit
• Inspecting Roofs for Moisture
• Considerations for Rooftop Inspections

Ultrasonics 3-Part Series
USA001

ULTRASONICS: BASIC PRINCIPLES

This course introduces the basic principles of ultrasonic detection. It describes what sound is, how sound is
used to diagnose problems, and how it is applied to machinery maintenance. Various types of maintenance
programs are discussed as well as the value of using ultrasound to detect problems early. Ultrasound device
components and their functions are explained as well as various record keeping practices.
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The
►
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►
►
►
►
►
►
►
►
►

course covers:
Sound waves
Frequency and amplitude
Decibels
Converting ultrasound to audible signals
Diagnostic, preventive, and predictive maintenance
Historical and comparative analyses
Airborne ultrasound
Pickup device
Meter and selector
Meter, frequency, volume, and sensitivity adjustments
Record keeping.

Course menu:
► Sound
• How Sound is Created
• Using Sound to Diagnose Problems
► Predictive Maintenance
• Detecting Problems Early
• Predictive Maintenance Methods
• The Benefits of Ultrasound in Predictive Maintenance
► Using Ultrasound in Predictive Maintenance
• Ultrasonic Detection Devices
• Record keeping

USA002

ULTRASONICS: LEAK DETECTION

System leaks affect productivity, product quality, and may even cause expensive environmental damage.
Ultrasonic technology can detect potential leaking problems before they become costly. This course
familiarizes students with the basic principles of ultrasonic leak detection. It describes how to locate leaks
using ultrasound, basic testing procedures, the use of tone generators, and specific testing situations involving
hard-to-find leaks, low pressure leaks, steam traps, and valves.
The
►
►
►
►
►
►
►
►
►
►
►
►
►
►
►

course covers:
Ultrasonic detector components
Hand-held units
Meters
Sensitivity and frequency adjustments
Interchangeable test modules
Contact and scanning modes
Heterodyning
Finding leaks
Pressure, vacuum, gas, and low pressure leaks
Testing procedures
Threshold and turbulence
Liquid leak amplifier (LLA)
Continuous and intermittent drain steam traps
Valves
White noise vs. hissing sound.

Course menu:
► Locating Leaks Using Ultrasound
• Principles of Leak Detection
• Basic Testing Procedures
• Using Tone Generators
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► Special Testing Situations
• Special Conditions
• Low-Pressure Leaks
• Steam Traps
• Valves

USA003

ULTRASONICS: MECHANICAL & ELECTRICAL INSPECTION

Mechanical and electrical inspections are essential for safe and efficient plant operation. The earlier a problem
can be detected, the better the chances of fixing it at the lowest possible cost. This course teaches students
the proper procedures for mechanical and electrical inspection. It describes how mechanical and electrical
problems generate ultrasound and how to identify different types of failures and potential failures.
The
►
►
►
►
►
►
►
►
►

course covers:
Bearing inspection and detecting bearing failure
Recognizing metal fatigue
Brinelling
Under- or over-lubrication
Comparative and historical testing
Testing procedures
Detector setup
Broken gear teeth, faulty valves, pump malfunctions, and component wear
Electrical testing.

Course menu:
► Bearing Inspection
• Bearing Problems
• Using Ultrasound
► Testing Bearings
• Types of Tests
• Testing Procedures
• Results
• Other Mechanical Inspections
► Electrical Inspections
• Electrical Problems
• Testing Procedures

Advanced Vibration: AC Induction Motors 2-Part Series
VAC001

ADVANCED VIBRATION: AC INDUCTION MOTORS, PART I

Three-phase AC induction motors play an integral part in the mechanical systems of virtually every industry.
This course focuses on the variations of AC current due to electromagnetic problems.
Course objectives include:
► Identify AC induction motor components and their functions
► Identify the fundamental defect frequencies
► Set up the data collector or analyzer to sufficiently capture correct vibration data
► Understand how electromagnetic problems cause unequal magnetic forces due to variations in the
current flow in either the stator or the rotor
► Explain how electromagnetic problems from a broken wire or connector can be seen in a vibration
spectrum.
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Course menu:
► Induction Motor Operating Principles
• How Induction Motors Work
• Spectral Peak Frequencies
► Condition Monitoring System Setup
• Identifying Frequency Measurement Points
• Measurement Point Setup
► Causes and Indications of Defects
• Unequal Magnetic Forces
• Identifying Defects
• Broken/Loose Wires
• Rotor Current Variations
• Loose Rotor Bars

VAC002

ADVANCED VIBRATION: AC INDUCTION MOTORS, PART II

This course discusses the variations in the air gap between the stator and the rotor due to mechanical
influences.
Course objectives include:
► Explain the effect of an uneven air gap due to static eccentricity
► Explain the effect of an uneven air gap due to dynamic eccentricity
► Explain the effect of torque pulses on an induction motor.
Course menu:
► Uneven Air Gap Due to Static Eccentricity
• Causes of Static Eccentricity
• Identifying Static Eccentricity Problems
► Uneven Air Gap Due to Dynamic Eccentricity
• Causes of Dynamic Eccentricity
• Identifying Dynamic Eccentricity Problems
► Thermal Expansion
• Thermal Bowing Causes and Indications
► Torque Pulses
• Torque Variation Effects and Indications

Vibration Analysis 6-Part Series
VIBRATION ANALYSIS: PREDICTIVE MAINTENANCE & MACHINE
VIBRATION
VBR001

A good predictive maintenance program is designed to be proactive, ensuring the safe and continuous
operation of machinery in the industrial environment. This course introduces students to reactive and proactive
predictive maintenance and the important relationship of condition monitoring to machine vibration.
Course objectives include:
► Understand reactive and proactive maintenance
► Understand the principles of predictive maintenance
► Understand the effectiveness of vibration analysis
► Understand the principles of condition monitoring
► Explain the steps of condition monitoring.
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Course menu:
► The Principles of Predictive Maintenance
• The Growth of Maintenance Programs
• Condition Monitoring
► Principles of Condition Monitoring
• How Condition Monitoring Works
• The Steps of Condition Monitoring

VBR002

VIBRATION ANALYSIS: MACHINE VIBRATION, BASIC THEORY

This course introduces the theory of machine vibration. It explains how forces cause machines to vibrate and
includes a visual explanation of critical terms such as frequency, resonance and time/frequency domains,
amplitude, displacement, velocity, and acceleration.
Course objectives include:
► Understand the relationship between frequency and vibration
► Understand natural frequency and resonance
► Identify a time wave form
► Understand time and frequency domains
► Understand vibration amplitude
► Explain the relationship between displacement, velocity, and acceleration
► Understand phase measurements and angles
► Define commonly used vibration analysis terms.
Course menu:
► Basic Theory Part I
• Basic Concepts of Vibration
• Vibration Frequency
• Measuring and Displaying Vibration
► Basic Theory Part II
• Vibration and Amplitude
• Units of Amplitude
• Using Amplitude to Determine Machine Condition

VBR003

VIBRATION ANALYSIS: PREPARING FOR DATA COLLECTION

This course explains the equipment and procedures used in the preliminary process of data collection. The
presentation includes knowing when to take measurements, which transducer to select, and which
analyzer is appropriate.
Course objectives include:
► Discuss the relationship of displacement, velocity, and acceleration to machine RPMs
► Choose the proper transducer for each application
► Identify the categories and types of transducers
► Select the proper mounting location for a transducer
► Select a data collector or analyzer.
Course menu:
► Transducer Basics
• Selecting the Proper Unit of Measure
• Characteristics of Transducers
► Commonly Used Transducers
• Accelerometers and Velocity Pickups
• Displacement Probes
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► Selecting and Mounting Transducers
• Selecting Transducers
• Mounting Transducers
► Selecting Data Collectors
• Standard Data Collectors
• Advanced Data Collectors

VBR004

VIBRATION ANALYSIS: THE DATA PROCESSING SYSTEM

This course teaches students how to set up a collector or analyzer as well as understand their internal
functions and relationship to computer software analysis.
Course objectives include:
► Understand FFT analyzer set up and operation
► Describe frequency domain and synchronous time averaging
► Describe exponential and peak hold averaging
► Differentiate between frequency expansion and zoom
► Explain dynamic range
► Explain triggering.
Course menu:
► Frequency Resolution and Range
• Frequency Resolution
• Frequency Range
► Averaging
• Frequency Domain
• Time Synchronous
► Triggering and Windows
• Triggering
• Windows
► Dynamic Range and Frequency Definition
• Dynamic Range
• Frequency Definition

VBR005

VIBRATION ANALYSIS: DATA COLLECTION

This course depicts the actual process of data collection, including machine identification points, uploading,
downloading, and reporting.
Course objectives include:
► Understand proper machine identification
► Understand proper measurement point identification, conventions, and locations
► Explain how machines are put into a tour or route
► Explain how to download and upload a route
► Describe how to collect data
► Identify what reports and plots can be generated.
Course menu:
► The Data Collection Strategy
• Measurement Identification
• Labeling and Grouping Measurements
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► Using Routes
• Loading Routes
• Collecting Data
• Uploading Routes
► Reports and Plots
• Reports
• Plots

VBR006

VIBRATION ANALYSIS: DATA ANALYSIS

This course is designed to give students the ability to analyze vibration spectra and identify common vibration
problems and their causes. In this course, mechanical situations are shown and discussed such as looseness,
unbalance, and misalignment. The relationships are compared to vibration graphs with further explanation of
patterns that associate with common problems. This is considered an initial practical application.
Course objectives include:
► Explain the relationships found in data analysis
► Identify and understand synchronous, harmonic, and modulation relationships
► Describe problems resulting from imbalance, misalignment, and looseness
► Describe problems related to the gearbox, to motor and vane passing, and to bearings.
Course menu:
► Relationships Found in Data Analysis
• Synchronous and Harmonic Relationships
• Modulation Relationships
► Problems from Unbalance, Misalignment, and Looseness
• Mass Unbalance and Misalignment
• Looseness
► Problems Related to the Gearbox
• Gearbox/Gear Mesh Frequencies
► Problems Related to Motors and Vane Passing
• Motors
• Vane Passing
► Problems Related to Bearings
• Bearing/Bearing Failure

Process Operations Curriculum (13 Training Hours)
Includes:
• Applied Physics 4-Part Series
• Applied Chemistry 3-Part Series
• Operators & Their Responsibilities 6-Part Series

Applied Physics 4-Part Series
OPT001

APPLIED PHYSICS: QUANTIFYING PHYSICAL CHARACTERISTICS

In processing plants, routine jobs such as recording temperatures, checking flow rates, and monitoring
pressure require the use of mathematics. Most of this math is not complicated. It is, however, important to
recall and understand these fundamentals to better understand the “how” and “why” of everyday tasks in the
plant. This course is designed to review basic math and how it applies to the work of a plant operator.
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Course objectives include:
► Review fundamental math principles
► Convert between various units of measurement scales while reinforcing fundamental math, measurement
precision, significant figures and scientific notation
► Recognize units of measure to determine properties of heat, energy, and power.
Course menu:
► Math Fundamentals
• Equations
• Functions
► Units of Measurement
• Imperial Units
• Metric Units
• Converting Units
► Quantifying Units of Measurements
• Length and Distance
• Volume
• Mass and Weight
• Temperature
► Applying Units of Measurement
• Velocity
• Pressure
• Flow
• Heat
• Energy
• Power

OPT002

APPLIED PHYSICS: PROPERTIES OF FLUIDS

This course introduces and explains the many physical properties and characteristics of fluids, both liquids and
gases. Unlike molecules in a solid with a defined shape, molecules in a fluid state can easily move from position
to position assuming the shape of its container. Fluids transfer energy, mix with other fluids and have many
unique properties.
Course objectives include:
► Describe the physical nature of fluids
► Identify the physical properties of liquids and gases such as density, gravity, viscosity, surface tension,
solubility and miscibility
► Explain the basic principles of fluid flow and the basic concepts of fluid dynamics
► Apply fluid physical properties to hydrostatic head, buoyancy, phase separation, laminar and turbulent
flow effects.
Course menu:
► Properties of Fluids and Gases
• Liquids and Gases
• Common Parameters
• Effects of Heat
• Effects of Pressure
• Liquid Phases
► Fluid Flow
• Liquid Flow Factors
• Measuring Flow
► Fluid Dynamics
• Hammering
• Pulsation Dampeners
• Educators
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OPT003

APPLIED PHYSICS: PHYSICAL FORCE

Many forms of physical force are utilized in processing plants. This course introduces the principles of force,
pressure, motion, acceleration, centrifugal force, center of mass, voltage and temperature as they apply
to process equipment, plant structures and simple machines. The examples illustrate the application and
conversion of energy forces to perform work in plant processes.
Course objectives include:
► Explain the four fundamental forces and the principles of physical force
► Describe the laws of motion and the different types of motion
► Explain how forces relate to heat, temperature, pressure, voltage and amperage
► Apply the principles of force to simple machines and the conversion and control of energy forces to
perform work in plant processes.
Course menu:
► Principles of Force
• What is Force?
► Laws of Motion
• Descriptions of Motion
• Motion and Simple Machines
► Physical Forces
• Motion
• Pressure
• Temperature
► Electrical Force
• Electricity

OPT004

APPLIED PHYSICS: TEMPERATURE AND HEAT

This course introduces thermodynamic effects of temperature and heat and the relationship between them.
Course objectives include:
► Explain the difference between temperature and heat
► Describe the principles of heat energy
► Explain the fundamental laws of thermodynamics
► Explain how temperature and heat affect solids, liquids and gases
► Relate the principles of heat transfer to industrial processes.
Course menu:
► Heat Energy
• Temperature
• Heat
• Heat Transfer
• Rate of Heat Transfer
► Heat Effects on Liquids and Gases
• Behavior of Gases
• Behavior of Liquids
► Process Applications
• Thermal Insulation
• Heat Exchange Equipment
• Fired Heaters
• Refrigeration
• Distillation
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Applied Chemistry 3-Part Series
OPT005

APPLIED CHEMISTRY: GENERAL CHEMISTRY

Understanding general concepts of chemistry can help operators learn about plant processes and the types
of physical changes and chemical reactions that occur. This course introduces the fundamentals of matter,
atomic structure, the basic principles of molecules and the physical properties of atoms and molecules that
differentiate them from one another. The course also presents simple chemical formulas, equations and
measurements used to quantify the amount of an element or molecular species present in a mixture.
Course objectives include:
► Define general chemistry terms
► Identify different types of elements
► Distinguish between chemical and physical properties
► Quantify the concentration of components in mixtures
► Identify symbols used in chemical formulas and equations.
Course menu:
► Chemistry Basics
• What is Chemistry?
• The Elements
• Phases of Matter
► Molecules and Mixtures
• Atomic Bonding
• Chemical Formulas
• Chemical Equations

OPT006

APPLIED CHEMISTRY: INORGANIC CHEMISTRY OF WATER

This course presents the properties of water, water solutions and the effects of the many contaminants
present in water that affect industrial facilities. The concepts of polarity, ions, conductivity, acids, bases and
pH are introduced. The course also includes examples of how chemistry is used in the process industries for
treating water supplies that enter the process facility, in aiding the heating and cooling of processes and how
wastewater is treated as it leaves the plant.
Course objectives include:
► Define terms associated with water chemistry
► Describe the common phases and heat energy of water
► Describe effects of temperature and pressure on water
► Provide examples of how water chemistry is used in industrial processes.
Course menu:
► Liquid and Solutions
• The Liquid State
• Solutions
• Acids and Bases
► Water Treatment
• Physical Treatment
• Chemical Treatment
• Biological Treatment
► Water Chemistry in Industrial Processes
• Water Sources
• Steam
• Cooling Water
• Wastewater
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OPT007

APPLIED CHEMISTRY: ORGANIC CHEMISTRY

All process plants use or manufacture some form of organic or hydrocarbon compound. This course introduces
the chemistry of hydrocarbon compounds and their derivatives from methane and other chemicals, to the
diverse hydrocarbons in the fuel that powers our cars, to the carbohydrates and sugars in the food that we eat
and the synthesized materials in the clothes that we wear.
Course objectives include:
► Identify the chemical structures of organic compounds
► Identify important physical properties and phenomena that are used to measure and manufacture organic
		 compounds, like vapor pressure, boiling and melting point, mass conservation, density and partial
pressure
► Recognize some of the processes used for the production and purification of organic compounds.
Course menu:
► Hydrocarbons
• General Structure
• Saturates
• Unsaturates
• Cyclic
► Functional Groups
• Concepts
• Examples
► Physical Properties
• Pure Components
• Vaporization
• Reactions
► Process Applications
• Separation of Components
• Reactors

Operators & Their Responsibilities 6-Part Series
OPT008

OPERATORS & THEIR RESPONSIBILITIES: NORMAL OPERATIONS

In operating plants, the process normally runs at steady state conditions referred to as normal operations.
This course discusses the operator roles and responsibilities during normal operations, which include making
routine rounds, communicating with other plant personnel, catching samples and making process adjustments
to assure a safe plant for personnel, the community and the environment.
Course objectives include:
► Define normal operating conditions
► Explain the operator’s roles and responsibilities
► Identify the routine tasks performed by operators
► Explain the importance of following policies and procedures
► Describe how process adjustments can affect normal operations.
Course menu:
► Normal Unit Operations
• Operator Roles and Responsibilities
• Operating at Steady State
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► Making Unit Flow Changes
• Increasing Unit Flow
• Decreasing Unit Flow

OPT009

OPERATORS & THEIR RESPONSIBILITIES: STARTUP OPERATIONS

Considerations for initial commissioning and normal restart of a plant after maintenance are presented. The
course introduces the hazards, risks, precautions and sequencing of various systems and equipment to be
started. Steps to startup utilities, air free equipment, introduce process fluids and achieve normal operations
after a turnaround are also included.
Course objectives include:
► Describe intermittently used equipment care, potential hazards and safety precautions
► Discuss generic startup steps and sequencing the startup of equipment and support systems
► Explain achieving normal operating conditions and product quality after startup.
Course menu:
► Support Systems
• Standby Equipment
• Utility Systems
• Prepare for Process Feed
► Start-Up Operations
• Initial Commissioning
• Recommissioning
► Achieve Normal Operations
• Flow, Temperature and Pressure
• On Specification Production

OPT010

OPERATORS & THEIR RESPONSIBILITIES: ABNORMAL OPERATIONS

Upset process conditions and emergency situations with typical preparations and planning used by operators
to mitigate the situations are presented in this course. Common causes resulting from a loss of utilities, a
primary process input and process containment are reviewed in planning what-if scenarios and emergency
drills. It also covers instrument systems and process interlocks used to mitigate abnormal situations and
protect personnel, equipment and the environment.
Course objectives include:
► Identify abnormal operations and its effect on unit equipment and piping
► Understand how abnormal and emergency conditions can impact safety and environmental conditions
► Discuss the roles and responsibilities of the operator during abnormal and emergency conditions
► Explain how troubleshooting can help return operating conditions to normal
► Understand the investigation process and reporting required following an incident.
Course menu:
► Abnormal Unit Operations
• Operator Roles and Responsibilities
• Equipment Malfunctions
• Operator Duties
• Troubleshooting
► Emergency Situations
• Operator Roles and Responsibilities
• Representative Emergency Situations
• Incident Investigations
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OPT011

OPERATORS & THEIR RESPONSIBILITIES: SHUTDOWN OPERATIONS

The typical steps for planned, orderly or routine shutdowns of equipment for maintenance and plant
turnarounds with the hazards, risks, precautions, and sequencing of various systems and equipment to be
shutdown are presented in this course. Isolation, hydrocarbon freeing and preparation of the equipment for
maintenance are also included.
Course objectives include:
► Describe the operator roles and responsibilities to shutdown plant operations
► Discuss sequencing of system and equipment shutdowns
► Explain how process variables and product quality are affected while shutting down
► Discuss preparing unit equipment and systems for maintenance.
Course menu:
► Process Shutdown Operations
• Operator Roles and Responsibilities
► Shutting Down Equipment
• General Maintenance
• Prepare for Maintenance
► Unit Shutdown
• Flow, Temperature and Pressure
• Prepare for Maintenance

OPT012

OPERATORS & THEIR RESPONSIBILITIES: HAND TOOLS

This course describes the proper use and care of common hand tools used for routine maintenance –
equipment lubrication, grease gun, screw drivers, hammers, wrenches, vises, clamps, socket sets, pliers,
hacksaws, files, wedges and tubing, and small pipe tools.
Course objectives include:
► Explain how to use hand tools found in an operator’s toolbox
► Recognize the types of tools and which jobs the tool is used for
► Understand the potential risks and hazards of improper tool use
► How to inspect a tool to be sure it is in proper condition and fitness for the tool’s intended use
► Learn the best practices for each tool, which is critical for safety and personnel protection.
Course menu:
► The Operator’s Tool Box
• Hand Tool Use and Care
► Tools for Lubricating
• Lubrication Tools
• Grease Guns
► Common Hand Tools
• Hammers and Wedges
• Chisels, Punches and Files
• Screwdrivers
• Wrenches, Sockets and Ratchets
• Clamps and Vises
• Measuring
► Tools for Cutting and Bending
• Knives and Saws
• Pliers and Wire Cutters
• Pipe and Tubing Tools
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OPT013

OPERATORS & THEIR RESPONSIBILITIES: EQUIPMENT CARE

Operators must accept custody of their equipment to properly care for it as if it were their own personal
property. This course supplements material in the Mechanical Maintenance, Operator Inspection and Predictive
Maintenance Series. In addition, this introductory course describes equipment care activities related to: heat
exchangers, fired heaters, pressurized vessels and piping, tanks, drains and dikes, boilers/waste heat steam
generators and steam turbines.
Course objectives include:
► Describe the benefits of equipment reliability programs
► Describe the operator’s role in ensuring equipment reliability
► Provide examples of equipment conditions that are routinely monitored
► Describe equipment care tasks that the operator is typically responsible.
Course menu:
► Caring for Equipment
• Equipment Reliability
• Routine Equipment Care
► Process Equipment
• Pressurized Vessels
• Piping and Valves
• Tanks, Drains and Dikes
► Heat Exchange Equipment
• Heat Exchangers
• Fired Heaters
• Boilers and Waste Heat Steam Generators
• Cooling Towers and Fin Fans

Sustainability Curriculum (16 Training Hours)
Includes:
• dss+ Energy Efficiency 16-Part Series

dss+ Energy Efficiency 16-Part Series
NRG001

dss+ ENERGY EFFICIENCY: ENERGY SMART

This course helps promote general energy awareness in all organizations and includes specific tips to help
deliver quick energy savings.
Features dss+ owner-operator content.
Course objectives include:
► Define energy management
► Understand the business case for energy management
► Create an energy management plan
► Identify ways to improve energy efficiency
► Describe the best practices of energy efficient organizations.
Course menu:
► Energy Management
• Five Areas Impacted by Energy Management
► Energy Management Plan
• Creating a Plan
► Improving and Managing Energy Efficiency
• Employee Contributions and Best Practices
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NRG002

dss+ ENERGY EFFICIENCY: ENERGY MANAGEMENT
BEST PRACTICES

This course discusses the problems that limit energy performance in a facility or plant site. It explains the
organizational, leadership, and analytical considerations that are important to establish an effective energy
management program. Finally, it covers how energy helps determine the competitiveness of products in the
marketplace.
Features dss+ owner-operator content.
Course objectives include:
► Establish effective energy management program leadership
► Evaluate existing equipment using energy performance ratios
► Calculate an hourly operations cost
► Identify and eliminate the defects that limit energy efficiency
► Understand the importance of linking performance improvements to business benefits.
Course menu:
► Establishing a Site Energy Team and Training Program
► Understanding Energy Efficiency and Taking Action
• Measuring Energy Use
• Understanding Energy Efficiency
• Judging Performance and Taking Action
► Knowing the Costs and Eliminating Defects

NRG003

dss+ ENERGY EFFICIENCY: ENERGY SYSTEM
INSTRUMENTATION AND CONTROLS

The instrumentation and control of power equipment has changed dramatically through the years, leaving
many plants with a mixture of both old and new technology. This course covers the broad range of energy
system instrumentation and control strategies, systems, and technology in use today.
Features dss+ owner-operator content.
Course objectives include:
► Exercise proper safety precautions when working with instrumentation and control systems
► Identify the elements of a typical process control system
► Compare common control strategies and their applications
► Compare different control systems and their operating characteristics
► Measure temperature, pressure, flow, and level with common field instruments
► Apply specific best practices for energy efficiency to instrument systems.
Course menu:
► Safety Considerations
► Process Control Concepts
• Control Strategies
• Control Systems
► Measurement Instruments
• Temperature Measurement Instruments
• Pressure Measurement Instruments
• Flow Measurement Instruments
• Level Measurement Instruments
► Best Practices
• Energy Control System Best Practices
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NRG004

dss+ ENERGY EFFICIENCY: THEORY OF STEAM GENERATION

This course covers the theory of steam generation and how facilities can efficiently produce and use steam.
Features dss+ owner-operator content.
Course objectives include:
► Exercise proper safety precautions when generating steam
► Understand the effects of temperature and pressure on the process of steam generation
► Convert heat into useful work
► Use and interpret Mollier diagrams
► Apply specific best practices for energy efficient steam generation and use.
Course menu:
► Safety Considerations
► Heat Content of Steam
• Effect of Temperature and Pressure
► Converting Heat and the Mollier Diagram
• Converting Heat to Work
• The Mollier Diagram
► Best Practices
• Steam Generation Best Practices

NRG005

dss+ ENERGY EFFICIENCY: FUELS AND THE COMBUSTION
PROCESS

It is essential that facilities establish energy management procedures that are unique to the fuels, equipment,
and systems used. This course covers fuel types and characteristics, the combustion process and its
equipment, and the control systems typically used on industrial combustion devices.
Features dss+ owner-operator content.
Course objectives include:
► Exercise proper safety precautions when working with fuels and the combustion process
► Compare the characteristics of coal, oil, and natural gas
► Understand the combustion process
► Control the fuel air ratio of the combustion process using different control systems
► Apply specific best practices for energy efficiency to fuels and combustion.
Course menu:
► Safety Considerations
► Fuel Characteristics
• Coal
• Oil
• Natural Gas
► Combustion Process
• Theoretical and Actual Combustion, All Fuels
• Oil and Gas Burners
► Combustion Controls
• On/Off Control Systems
• Positioning Control, No Feedback, Gas or Oil
• Positioning Control, Oxygen Feedback
• Metering Control
• Metering Control with Oxygen Feedback
• Flue Gas Analysis
► Best Practices
• Fuels and Combustion Best Practices
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NRG006

dss+ ENERGY EFFICIENCY: BOILERS AND AUXILIARIES

This course covers steam boilers and common boiler auxiliary equipment, including superheaters, economizers,
air heaters, and feedwater systems. It explains fundamental design and operating parameters and provides
guidance for safe, reliable, and efficient operation.
Features dss+ owner-operator content.
Course objectives include:
► Exercise proper safety precautions when working with steam boilers and boiler auxiliary equipment
► Operate various boilers and superheaters
► Use economizers
► Identify and compare the two types of air heaters and various draft-producing equipment
► Identify and compare the systems and equipment used to control, pump, and heat feedwater
► Apply specific best practices for energy efficiency to boilers and auxiliaries.
Course menu:
► Safety Considerations
► Boilers, Superheaters, and Economizers
• Boilers
• Superheaters
• Economizers
► Air Heaters and Draft Equipment
• Air Heaters
• Draft Equipment
► Feedwater Control Systems, Pumping, and Heating
• Feedwater Control Systems
• Feedwater Pumping
• Feedwater Heating
• Other Considerations
► Best Practices
• Boilers and Auxiliaries Best Practices

NRG007

dss+ ENERGY EFFICIENCY: EMISSION CONTROL AND
ASH HANDLING

This course introduces the categories of emissions and discusses the methods used to control and/or collect
the most prevalent and most commonly regulated primary pollutants and by-products emitted by the
combustion process in industrial-fired boilers and process equipment.
Features dss+ owner-operator content.
Course objectives include:
► Exercise proper safety precautions when operating emission control systems
► Classify the three basic categories of emissions
► Remove ash from the furnace using pneumatic or hydraulic systems
► Remove fly ash from the stack gases in boilers using mechanical collectors, electrostatic precipitators,
and baghouses
► Understand the three general approaches used to control sulfur dioxide emissions
► Control the emission of nitrogen oxides produced in the combustion process
► Apply specific best practices to manage the energy consumption of emission control systems.
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Course menu:
► Safety Considerations
► Furnace Ash Removal
• Pneumatic Ash Handling Systems
• Hydraulic Ash Handling Systems
► Fly Ash Removal
• Mechanical Collectors
• Electrostatic Precipitators (ESP)
• Baghouses
► Sulfur Dioxide (SOx) Control
• Lime/Limestone Scrubbers
• Dry Scrubbers
► Nitrogen Oxide (NOx) Control
► Best Practices
• Emission Control and Ash Handling

NRG008

dss+ ENERGY EFFICIENCY: STEAM DISTRIBUTION

This course covers various industrial steam distribution lines, their auxiliary components, and their efficient use.
Features dss+ owner-operator content.
Course objectives include:
► Exercise proper safety precautions when working with steam distribution systems
► Compare the different steam distribution lines used in industry
► Compare and use various steam traps, pressure regulation valves, and pipeline desuperheaters
► Apply specific best practices for energy efficiency to steam distribution systems.
Course menu:
► Safety Considerations
► Distribution Lines and Sources of Steam Distribution
• Distribution Lines
• Sources of Steam Distribution
► Steam Traps and Drip Legs
• Thermodynamic Disc Trap
• Inverted Bucket Trap
• Thermostatic Traps
• Drip Legs or Drip Pockets
► Pressure-Reducing and Desuperheating Stations
• Self-Contained or Piloted Pressure Regulators
• Desuperheaters
► Best Practices
• Steam Distribution Best Practices
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NRG009

dss+ ENERGY EFFICIENCY: STEAM TURBINES AND CONDENSERS

This course covers steam turbines and condensers, their auxiliaries, and their efficient use.
Features dss+ owner-operator content.

Course objectives include:
► Exercise proper safety precautions when working with steam turbines and condensers
► Classify steam turbines
► Control a turbine’s speed
► Maintain a turbine’s oil system
► Extract steam from a turbine
► Use condensers and their auxiliaries
► Evaluate turbine performance
► Apply specific best practices for energy efficiency to steam turbines and condensers.
Course menu:
► Safety Considerations
► Classification of Turbines
• Theory of Steam Turbines
• Classification of Steam Turbines by Exhaust Pressure
• A Typical Steam Turbine Driven Generator
► Speed Control, Lubrication, and Extraction
• Speed Control
• Lubrication
• Steam Extraction
► Condenser and Auxiliaries
► Turbine Performance and Mechanical Drive Turbines
• Turbine Performance
• Mechanical Drive Turbines
► Best Practices
• Steam Turbines and Condensers Best Practices

NRG010

dss+ ENERGY EFFICIENCY: ELECTRICITY GENERATION
AND DISTRIBUTION

This course covers electrical principles and the efficient operation of various devices and systems that produce,
distribute, and use electricity.
Features dss+ owner-operator content.
Course objectives include:
► Exercise proper safety precautions when working with and around electrical equipment
► Apply the principles of electricity
► Identify the devices that produce electricity and understand their basic operation
► Identify the equipment required for the distribution of electricity
► Identify motors, motor controls, generators, and lamps as devices that use electricity and understand
their basic operation
► Apply specific best practices related to electrical energy conservation.
Course menu:
► Safety Considerations
► Principles of Electricity
• Electric Circuit Basics
• Current and Magnetism
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► Generators
• Electrical Generators
• Generator Prime Movers and Excitation
► Distribution of Electricity
• Electrical Conductors
• Switchgear and Transformers
• Instruments, Meters, and Relays
► Devices that Use Electricity
• Motors
• Motor Control Equipment
• Operation of Motors and Generators
• Lamps
► Best Practices
• Electricity Generation and Distribution Best Practices

NRG011

dss+ ENERGY EFFICIENCY: PUMPING SYSTEMS

This course covers pumping systems, their components, and their efficient use.
Features dss+ owner-operator content.

Course objectives include:
► Exercise proper safety precautions when working with and around pumping systems
► Apply the principles of pump operation
► Use various pumps in power and HVAC applications
► Use common pumping system components
► Consider key factors prior to designing a pumping system
► Apply specific best practices for energy efficiency to pumping systems.
Course menu:
► Safety Considerations
► Principles of Operation
• Pressure and Head
• Net Positive Suction Head and Principles of Operation
► Types of Pumps
• Standard End-Suction Pumps
• Multi-Stage, Double Suction, and In-Line Designs
• Seal-Less, Canned Motor, and Magnetic Drive Pumps
• Self-Priming Pumps
• River Water Pumping
► Pumping System Components and Operation
• Pumping System Components
• System Operating Considerations
► Best Practices
• Pumping Systems Best Practices
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NRG012

dss+ ENERGY EFFICIENCY: COOLING TOWERS

This course covers the efficient operation of various cooling towers and spray ponds.
Features dss+ owner-operator content.
Course objectives include:
► Exercise proper safety precautions when working with and around cooling towers
► Classify cooling towers by water distribution system and means used to move air through the tower
► Understand the principles of cooling tower performance and operation
► Operate and maintain spray ponds
► Compare spray ponds and cooling towers
► Apply specific best practices for energy efficiency to cooling towers.
Course menu:
► Safety Considerations
► Types of Cooling Towers
• Classifications and Types of Cooling Towers
► Cooling Towers and Spray Ponds
• Spray Ponds
► Cooling Tower Performance and Operation
► Best Practices
• Cooling Tower Best Practices

NRG013

dss+ ENERGY EFFICIENCY: WATER TREATMENT

This course covers water supply basics, the impurities present in water, and the efficient use of water treatment
systems.
Features dss+ owner-operator content.
Course objectives include:
► Exercise proper safety precautions when treating water
► Classify water by its source
► Relate the quality of surface water to specific characteristics of the watershed area
► List the groups of impurities present in water supplies
► Understand the clarification, chlorination, and filtration processes
► Apply specific best practices for energy efficiency to water supply and treatment systems.
Course menu:
► Safety Considerations
► Water Quality Basics
• Sources of Water
• Characteristics of Water
• Filter Plant Processes
► Clarification
• Clarification
• Chemical Treatment for Clarification
► Best Practices
• Water Treatment Best Practices for Energy Efficiency
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NRG014

dss+ ENERGY EFFICIENCY: COMPRESSED AIR

This course covers compressed air systems, their components, and their efficient use.
Features dss+ owner-operator content.
Course objectives include:
► Exercise proper safety precautions when working with and around compressed air systems
► Identify the key components of reciprocating, screw, and centrifugal compressors and their controls
► Identify the key components of an air distribution system
► Apply specific best practices for energy efficiency to compressed air systems.
Course menu:
► Safety Considerations
► Reciprocating and Screw Compressors
• Reciprocating Compressors
• Rotary Screw Compressors
► Centrifugal Compressors and Compressed Air Distribution
• Centrifugal Compressors
• Centrifugal Compressor Controls
• Compressed Air Distribution
► Best Practices
• Compressed Air Best Practices

NRG015

dss+ ENERGY EFFICIENCY: REFRIGERATION

This course covers the components and principles of refrigeration systems and their efficient use.
Features dss+ owner-operator content.
Course objectives include:
► Exercise proper safety precautions when working with and around refrigeration systems
► Identify the parts that all mechanical refrigeration systems have in common
► Assess the relationship between pressure, temperature, evaporation, and condensation in a
refrigeration system
► Compare common refrigerants
► Apply the principles of operation of positive displacement and centrifugal refrigeration systems
► Apply specific best practices for energy efficiency to refrigeration systems.
Course menu:
► Safety Considerations
• Safety
► The Refrigeration Cycle and Its Components
• The Refrigerant Cycle
• Compressors
• Expansion Valves
• Evaporators
• Condensers
► Refrigerants and Cycle Performance
• Refrigerants
• Capacity and Performance Considerations
► Positive Displacement Compressors
• A Simple Reciprocating System
• Reciprocating, Screw and Scroll Compressors
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► Cooling Circuits and Lubrication
• Liquid Coolers and Air-Cooling Coils
• Lubrication
► Centrifugal Chillers - Compressors & Other Components
• A Simple Centrifugal System
• Centrifugal Compressors
• Coolers and Condensers
• Expansion Valves
• Intercoolers (Economizers)
• Compressor Surging
• Capacity Control
► Best Practices
• Refrigeration Best Practices

NRG016

dss+ ENERGY EFFICIENCY: HVAC AND INDOOR AIR QUALITY

This course covers common HVAC systems as well as their controls, components, and efficient use.
Features dss+ owner-operator content.
Course objectives include:
► Exercise proper safety precautions when working with and around HVAC systems
► Compare common HVAC systems and their controls
► Identify and use the major components of HVAC systems
► Apply specific energy management best practices related to HVAC systems.
Course menu:
► Safety Considerations
• Safety and Indoor Air Quality
► Applications of Air Conditioning
• Comfort Air Conditioning and Industrial Applications
► Equipment
• Cleaning the Air
• Ventilation Equipment
• Heating Equipment
► Air-Conditioning Methods
• Cooling Methods
► Air-Conditioning Systems
• Packaged Air Conditioners
• Central Systems for Air Conditioning
• Heat Pumps
► Automatic Controls
• Automatic Controls
► Best Practices
• HVAC Energy Management Best Practices
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MPR001

MAINTENANCE PRINCIPLES

In this program we will identify the importance of maintenance to the systems you work with and how
maintenance can affect product quality, reliability, efficiency, and safety.
Introduction
► Overview and Objectives
Course menu:
► Defects
• Definition
• Common Sources of Defects
► Maintenance
• Common Maintenance Types
• Failure Modes and Effects Analysis (FMEA)
• Record Keeping
• Safety
► Maintenance Roles
• Benefits of Communicating Clearly
• Improving Communication

AMM001

INTRODUCTION TO AMMONIA REFRIGERATION

This course covers basic information related to ammonia refrigeration systems, including the refrigeration
cycle, basic refrigeration system components, and types of ammonia refrigeration systems.
Course objectives include:
► Describe the history and use of ammonia as a refrigerant
► Describe the characteristics of ammonia
► Identify the components of an ammonia refrigeration system
► Describe types of ammonia refrigeration systems
► Identify safety features used in ammonia refrigeration systems
► Describe maintenance requirements and procedures for ammonia refrigeration systems
► Describe safety precautions for handling and working with ammonia
Introduction
► Overview and Objectives
Course menu:
► About Ammonia
• History
• Composition
► Ammonia Systems
• Components
• Operation
• Safety Features
► Maintenance
• Maintenance Requirements
• Preventive Maintenance Tasks
► Safety
• Regulations
• Precautions
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